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* Conformément à l’article 27 de la loi Informatique et Libertés du 6 janvier 1978, vous disposez d’un droit d’accès et de rectification aux informations vous concernant. Les informations ci-dessus, étant traitées informatiquement, 
sont indispensables à la gestion de votre demande d’abonnement. Vous pouvez vous opposer à leur cession ultérieure en nous le précisant par écrit.
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4,40€
le numéro !
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Howtodo Publishing - Abonnement
282 rue des Pyrénées 75020 Paris

Sur Internet :
Par PayPal (paiement sécurisé 
par cartes VISA ou MASTERCARD) 
directement sur notre site www.vvmac.com

Par e-mail :
Pour toute demande d’information,
contactez-nous sur :
abo@vvmac.com

Hors France métropolitaine
Consultez nos offres tarifaires 
et commandez directement en quelques minutes 
sur notre site www.vvmac.com

L’abonnement donne droit à un tarif avantageux 
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DOUBLE PROMO 02/03_Mise en page 1  10/01/11  17:38  Page21



VVMac, c’est chaque mois 
plus de 90 pages 

d’articles pratiques et originaux !

2 formules 11 ou 22 numéros

BULLETIN D’ABONNEMENT À VVMAC VVMac HS-3

À remplir LE PLUS LISIBLEMENT POSSIBLE et à retourner à l’adresse suivante :

Howtodo Publishing -Vous et Votre Mac - 282, rue des Pyrénées - 75020 Paris

Je règle aujourd’hui par :

r Chèque bancaire ou postal à l’ordre de Howtodo Publishing

Date : ……/……/……
Signature 

r M. r Mme
r Mlle

Prénom :

Nom :                                       

Adresse :

C.P. :                       Ville :

E-mail :

E-mail obligatoire pour recevoir une confirmation 
d’abonnement et, si nécessaire, une facture.

r Je m’abonne pour 11 numéros au prix de 48 €

r Je m’abonne pour 22 numéros au prix de 92 €
(Tarifs valable uniquement pour la France métropolitaine)

* Conformément à l’article 27 de la loi Informatique et Libertés du 6 janvier 1978, vous disposez d’un droit d’accès et de rectification aux informations vous concernant. Les informations ci-dessus, étant traitées informatiquement, 
sont indispensables à la gestion de votre demande d’abonnement. Vous pouvez vous opposer à leur cession ultérieure en nous le précisant par écrit.

u s à VVMac !
DOUBLE PROMO 02/03_Mise en page 1  10/01/11  18:45  Page3



WWW.VVMAC.COM
Sur le site compagnon de VVMac, consultez 
les sommaires, interrogez les index en ligne pour 
retrouver un article publié, téléchargez 
des fichiers nécessaires à la réalisation d’ateliers
ainsi que les formulaires d’abonnement 
et de commande des CD ou DVD de VVMac en PDF.
Vous pouvez aussi vous abonner par carte 
bancaire via PayPal et visiter notre forum.

CONTACTS
Par email à l’adresse: redaction@vvmac.com
Par courrier postal à l’adresse:
HowToDo Publishing
Vous et Votre Mac
282, rue des Pyrénées 75020 Paris

L’équipe de Vous et Votre Mac n’assure aucun 
support technique ou service de conseil
d’achat. Nous ne répondons ni directement 
au téléphone, ni de façon personnalisée 
aux lettres et emails reçus.

Directeur de la publication :
Alain Lalisse
Rédaction :
email : redac@vvmac.com
Rédacteur en chef : Bernard 
Le Du • Rédacteur en chef 
adjoint : Alain Lalisse
Ont collaboré à ce numéro :
Marc Fanelli-Isla, Mathieu 
Lavant, David A. Mary, 
Henri-Dominique Rapin. 
Illustrations et photos, tous
droits réservés.

Publicité :
DIGICIA MEDIA 
Angélique Mermet
Tél. : 0140337956
angelique@vvmac.com

Vente au numéro :
Contact réservé aux 
dépositaires de presse : 
DIGICIA Media / Média dif
Olivier Le Potvin
Mob. : 01 40 33 82 46
Fax. : 01 40 33 71 13
email : olepotvin@digicia.com
Prix du numéro France 
métropolitaine : 5,50€
(dont TVA à 2,10%)

Abonnement :
Vous et Votre Mac
HowToDo Publishing
282 rue des Pyrénées 
75020 Paris
abo@vvmac.com
Abonnement France 
Métropolitaine 11 numéros 48€
DOM: 60,50€. Offres 
d’abonnement pages 2 et 3.

Distribution kiosque France :
MLP

Imprimeur : BOCCIA
Via Tiberio Claudio Felice, 7
84131 Salerno. Italie.
Imprimé en Union européenne
Printed in European Union

Gestion de la fabrication:
Media4All

Commission paritaire : 
0312K86157
Dépôt légal à parution
ISSN : 1771-7108

Vous et Votre Mac est 
une publication de la société
HowToDo Publishing SAS 
au capital de 37000 euros
Siège social : 282, rue des 
Pyrénées 75020 Paris, France
Tél. : 09 50333738
RCS Paris B 479017857
SIRET 479017857 00026
Président : Alain Lalisse
Principaux actionnaires : 
Alain Lalisse, Bernard Le Du,
DIGICIA Media SAS

Toute reproduction, représentation,
traduction ou adaptation, qu’elle soit
intégrale ou partielle, quels qu’en
soient les procédés, supports 
ou médias, est strictement illicite
et interdite sans consentement de la
société howtodo publishing SAS, sauf,
conformément aux alinéas 2 et 3 
de l’article 41 de la Loi du 11 mars 1957,
les copies ou reproductions 
strictement réservées à l’usage privé
du copiste et non destinées 
à une utilisation collective, ou 
les analyses et courtes citations dans
un but d’exemple et d’illustration 
© HowToDo Publishing 2005-2010.
Crédit photo et copyright, tous droits
réservés. Les prix mentionnés dans
les pages de ce magazine sont TTC,
sauf mention HT. Ils sont donnés à 
titre purement indicatif, susceptibles 
de changements à tout moment 
et ne sont là que pour fournir 
une indication approximative 
des prix pratiqués sur le marché. 
Les adresses postales ou Internet 
de courriel ou de sites sont 
susceptibles d’arrêt ou 
de changement à tout moment ; 
le magazine ne saurait en être tenu
responsable. Elles ne sont données
qu’à titre d’information.

Vous et Votre Mac
www.vvmac.com

� PHOTO NUMÉRIQUE
006 IPHOTO 
Optimiser la gestion de vos photos à laide des mots-clés.

008 APERTURE 
Comment bien migrer ses photothèques de iPhoto à Aperture. Développer le RAW.

010 POSTERINO
Créer des cartes postales et des posters

012 PHOTOSTYLER
Un logiciel de retouche photo facile à maîtriser. Réaliser un portrait high key.

014 AVIARY RAVEN
En ligne et gratuit, à découvrir! De la bitmap au dessin vectoriel.

016 HDRTIST 
Comprendre la grande gamme dynamique. Le tone mapping facile.

018 PHOTO ACUTE
Tirer le meilleur de son photoscope. Maîtriser la profondeur de champ.

020 AVIARY RAVEN
Photomontage bling-bling.

022 QUARTZ COMPOSER
Insuffler de la vie dans une photo. Une composition au gré des flots.

024 PHOTOSHOP ELEMENTS
La coloration sélective.

026 DXO OPTICS PRO
Sublimer ses photos. Des ajustements optiques à la carte.

028 PIXELMATOR
Secrets de la retouche portrait. Des calques très esthétiques.

030 PHOTOSHOP ELEMENTS 9
Les nouvelles fonctions de PSE 9 en images.

� VIDÉO
034 IMOVIE
Retour sur les fonctions clés. Éditer des séquences avec précision.

036 IMOVIE 
La gestion de la vidéothèque. Bien travailler avec les mots-clés.

038 IMOVIE
Doper le logiciel d’édition vidéo d’Apple avec des outils complémentaires. Compatibilité HD.

040 IMOVIE
Le cache patate, une fonction discrète. Un générique genre Experts Miami.

042 IMOVIE
Un générique à la Star Wars.

044 IMOVIE ET QUARTZ COMPOSER 
Changer l’apparence des titrages d’iMovie. Un effet à laMinority Report.

046 KANDALU LITE��
L’optimisation vidéo selon JPDM. Encoder le H.264 autrement!

048 IMOVIE 
Réaliser des titrages façon 24 Heures Chrono.

050 MKVTOOLNIX 
Et si vous passiez toutes vos vidéos en MKV ? Un chapitrage en toute simplicité.

052 HANDBRAKE
Encodage vidéo facile et surtout rapide.

054 AUTOMATOR
La Haute Définition à la portée de tous! Concevoir son propre encodeur vidéo.

056 PREMIERE ELEMENTS 9
Du dérushage à l’organisation de la vidéothèque.
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Hors-série
VVMac n°3

L
a vocation de Vous et Votre Mac est avant
tout « pratique ». Alors que l’actualité est
désormais largement prise en charge par
les sites Web spécialisés qui donnent,
parfois en temps réel tels des « agences

de presse », le compte rendu des faits et gestes de
Steve Jobs, la tendance du cours de l’action et
répercutent le moindre communiqué de presse qui
leur parvient, le pratique reste encore un des axes
de développement des magazines imprimés (sur
du vrai papier). Non qu’il n’existe point de sites of-
frant des tutoriels, ils sont même très, très
nombreux, mais parce que l’utilisation de ces
derniers n’est toujours pas très aisée. Il faut déjà les
trouver sur la toile et souvent de toute manière les
imprimer – en noir et blanc pour ne pas assécher
les cartouches d’encre si onéreuses. Car, même
avec le secours d’un second grand moniteur,
suivre un pratique 
affiché à l’écran tout en le réalisant sur un second
n’est des plus confortable. Ça ne l’est pas plus en
se servant d’un iPad, puisqu’il va falloir sans cesse
jouer des doigts pour se déplacer dans le texte et
zoomer/dézoomer sur telle ou telle explication. Je
m’y suis moi-même essayé, et j’ai vite abandonné
cette utilisation-là. La presse papier reste donc ce
qu’on a fait de plus simple à utiliser jusqu’à
maintenant.
Mais il y a tout de même un problème, sauf à
démanteler vos magazines, vous ne pouvez pas
constituer de dossiers thématiques (création, Web,
bureautique, maintenance système…) ou par type
d’articles (tous les tests, tous les papiers iPad,
toutes les solutions…). C’est pourquoi, nous vous
proposons cette fois-ci dans ce hors-série, une
sélection de nos meilleurs Pratiques express,
regroupés dans un même magazine, selon quatre
thématiques: Photo, Vidéo, Web et Musique/Son.
Une sélection d’articles déjà parus, mais remis à
jour lorsque cela nous semblait nécessaire.
n Bernard Le Du (bledu@vvmac.com)

005

À propos de…

         

� WEB & INTERNET
058 DROPBOX 
Des fichiers toujours disponibles sur Mac, iPhone et iPad!

060 BANNERZEST
Du peps dans les bannières. Intégration avec iMovie et MobileMe. 

062 NICECAST 
Tout ce qu’il faut pour démarrer votre radio sur Internet. De la musique pour votre blog.

066 IPHOTO 
Photocasting: des photos sur abonnement. Héberger un photocast soi-même.

068 GOLDFISH 
un générateur de sites polyvalent. Réaliser un élégant portfolio.

070 FREEWAY EXPRESS 
La PAO adaptée au Web. Une visionneuse Flash compatible iOS.

072 FLUX
Création de pages Web. Premiers pas en HTML et CSS.

074 POSTEROUS 
Réaliser un blog mobile. Sauvegarder votre blog en XML.

076 ARTISTEER 
Pour jouer avec les templates de Wordpress. Un blog grunge avec transparence.

078 FEEDER 
Un logiciel sympa pour publier des podcasts. Faites votre entrée dans l’iTunes Store.

080 PULPMOTION 
Publier un magazine virtuel.

082 CAMTASIA MAC 
Pour réaliser des podcasts « professionnels » et didacticiels vidéos.

� MUSIQUE & SON
084 SOUNDBOARD 
Un peu de magie sonore. Des effets sonores amusants pour vos vidéos.

086 MAGIC GARAGEBAND 
Découvrez les riches du logiciel d’Apple. Composer à la manière de Chris Isaak

088 GARAGEBAND & FISSION
Le chapitrage audio en questions. Découpage automatique d’un MP3.

090 GARAGEBAND
Se servir de GarageBand comme d’un dictaphone.

092 AVIARY MUSIC CREATOR
Remixer Lady Gaga en un clin d’œil!

094 DJAY 
Devenir un pro des platines virtuelles. Le MixTape à la portée de tous.

096 GARAGEBAND 
Monter votre laboratoire de langue. Élaboration d’un document multimédia.

�
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� Une photothèque bien entretenue est gage d’efficacité. Retrouver la photo de Marie à la plage 
ou d’un repas avec l’oncle Charles n’est plus qu’une simple formalité ! � 

C
omme je l’avais souligné
dans un face à face avec
Picasa (VVMac N°44),
iPhoto’09  attribuait de
façon autoritaire un rac-

courci clavier sans que l’utilisateur
ne puisse s’en défaire par la suite.
Apple a depuis rectifié le tir. Procé-
dez à la mise à jour du logiciel en
version 8.0.2 ou oassez à la version
suivante, vous y gagnerez en stabi-
lité et en confort.

CRÉEZ LES MOTS-CLÉS À L’AVANCE
Tout se joue dans la palette flot-
tante Fenêtre > Afficher les mots-
clés. Ces derniers sont rangés en
deux groupes: ceux dotés d’un rac-
courci clavier sont positionnés dans
le haut de la fenêtre; les autres mots-
clés sont placés plus bas.
Pour créer à l’avance de nouveaux
mots-clés, cliquez sur le bouton Mo-
difier les mots-clés. Dans le dialogue
qui s’affiche à l’écran, appuyez sur
le bouton + . Dans la liste, un
nouveau champ de saisie apparaît

dans lequel vous tapez le nou-
veau mot-clé. Vous validez les mo-
difications avec la tou che [Entrée]
du clavier. Comme vous le consta-
tez, un raccourci clavier est au-
tomatiquement assigné. Si vous
n’en voulez pas, ou si vous souhai-

tez en changer, cliquez tout d’abord
sur le bouton Raccourci , puis
effacez le con tenu du champ de
texte dans le premier cas. Ou bien,
contentez-vous de changer le ca-
ractère utilisé pour le raccourci.
La suppression d’un mot-clé s’ef-
fectue en cliquant sur le bouton –
(moins). Une fois toutes ces modi-
fications opérées, cliquez sur le bou-
ton OK (en bas à droite de la pa-
lette).

L’ÉTIQUETAGE
L’attribution des mots-clés est d’une
simplicité toute biblique… Sélec-
tionnez dans la photothèque un ou
plusieurs clichés, et dans la palette
flottante, sélectionnez les mots-clés
que vous souhaitez attribuer .
Si vous demandez Présentation >
Mots-clés, les mots-clés déjà affec-
tés s’affichent en dessous de chaque
photo.

À LA VOLÉE
Quand vous survolez les photos de
la souris, le message Ajouter des
mots-clésapparaît. Cliquez au-des-
sous de chaque photo pour révéler
un champ de saisie. Entrez un mot-
clé déjà mémorisé ou un tout nou-
veau mot-clé qui sera alors ajouté
à la liste existante.

UNE RECHERCHE TRÈS CIBLÉE
Pour rechercher à l’aide des mots-
clés que vous avez entrés, cliquez
sur l’icône de recherche (marquée
d’une loupe dans le champ situé en
bas de l’interface). Dans le menu lo-
cal, demandezMot-clépuis, dans
le phylactère noir , sélectionnez

un ou plusieurs des mots-clés dis-
ponibles. Une fois la recherche ter-
minée, pour afficher de nouveau
toutes les photos de la bibliothè -
que, cliquez sur le petit bouton de
réinitialisationplacé dans le champ
de recherche (le bouton rond avec
une croix) . n D.A.Mary
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Faisons le point sur
les mots-clés…

Vous et Votre Mac • Hors-série n°3 • Février 2011

Pour aller plus loin…
Ceux qui utilisent iPhoto dans un contexte pro (des entreprises de commu-
nication aux agences de casting) peuvent recourir à un outil de classement
plus souple et plus précis car le catalogueur standard montre ses limites
lorsque vous gérez plusieurs photothèques : les mots-clés ne sont pas 
partagés! Heureusement, Keyword Manager 1.5.1 arrive à la rescousse
(www.bullstorm.se). Installée, l’extension prend place dans la barre 
des menus d’iPhoto sous l’intitulé Mots-clés. Si d’aventure rien 
n’apparaissait, rendez-vous sur le site www.culater.net/software/SIMBL/SIMBL.php
et téléchargez SIMBL-0.8.2.tbz (Universal Binaries) qu’il faudra installer. 
Au prochain démarrage d’iPhoto, un message d’avertissement vous 
indiquera que Keyword Manager est désormais actif. Pour désinstaller 
le plug-in, mettez à la Corbeille le paquet KeywordManagerPlugin.bundle
(/Bibliothèque/Application Support/SIMBL/Plugins). La page ci-contre 
vous explique comment utiliser Keyword Manager.

PHOTO006
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�Tapez dans le champ idoine les mots-clés 
de votre choix (qu’ils soient déjà répertoriés

ou bien nouveaux).

Et si vous utilisiez Keyword Manager?
Sous des dehors assez simples, ce gestionnaire suédois a plus d’un tour dans son sac. 
Des tâches triviales aux plus complexes, il s’accommode de toutes les situations.

Vous et Votre Mac • Hors-série n°3 • Février 2011

�Pour exclure des clichés correspondant 
à un mot-clé en particulier, appuyez sur 

la touche [Alt] au moment de la sélection.

�A contrario, en pressant la touche [Ctrl] 
pendant la sélection des mots-clés, toutes 

les photos répondant au moins à l’un 
des critères choisis seront dévoilées.

�Les mots-clés peuvent être organisés en 
catégories (Activités, Défilés de mode…). 

Pour ce faire, déroulez le menu local en forme de
roue et demandez Nouvelle catégorie.

	Ils peuvent aussi s’imbriquer, autorisant 
un classement plus fin de la photothèque.

Une photo d’Alain Resnais renverra automatique-
ment aux mots-clés « Réalisateurs » et « Cannes ».

�Cliquez sur les cercles en regard des
mots-clés pour cibler votre recherche. Par

défaut, seules les photos répondant à tous les cri-
tères seront affichées.

   
 

         

�Demandez Mots-clés > Préférences et 
cochez toutes les cases. La bibliothèque 

des mots-clés sera partagée par toutes les 
photothèques.

�Pour attribuer des mots-clés à la volée, 
faites Mots-clés > Afficher attribution 

rapide et choisissez des clichés dans iPhoto.

007

�Pour partir à la recherche de clichés, 
faites Mots-clés > Afficher gestionnaire

de mots-clés. Une palette flottante apparaît.
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D
ans sa robe grise et son interface
épurée, Aperture donne des gages
de sérieux sans se révéler particuliè-
rement austère. Autant dire
qu’après avoir goûté à ce catalo-

gueur professionnel, vous n’aurez sans doute
plus envie de vous frotter à un iPhoto, certes
très chamarré, mais parfois poussif.

IMPORTEZ VOTRE PHOTOTHÈQUE
Aperture sait s’approprier la totalité de votre bi-
bliothèque iPhoto en quelques clics. Au démarrage
d’Aperture, vous lancez l’import depuis la fenêtre
d’accueil . C’est aussi possible depuis le menu
Fichier > Importer > Une photothèque d’iPhoto.
Dans la fenêtre de requête qui surgit à l’écran, la
bibliothèque iPhoto choisie est celle utilisée par
défaut . Si d’aventure vous en utilisez plusieurs
à la fois, il faudra recommencer toute la procédure
pour chacune, en indiquant à cha que fois dans
la fenêtre de requête l’emplacement des photo-
thèques supplémentaires… Ensuite, cliquez sur

le bouton Importer situé dans le coin inférieur
droit de la fenêtre. Si Aperture rencontre des fi-
chiers qu’il ne sait pas prendre en charge – des
séquences vidéo, par exemple –, il vous en avertira.
De même, les projets de livres, cartes souvenirs
et autres diaporamas ne sont pas importés. Aper-
ture gérant de manière un peu plus fine les res-
sources de la photothèque, il n’est pas étonnant
de voir cette dernière fondre de quelques précieux
gigaoctets par rapport à iPhoto.

Enfin, une petite astuce est à connaître pour qui
souhaite travailler avec les deux applications à la
fois. Au moment de l’importation de la bibliothèque
iPhoto dans Aperture, optez dans le menu local
Stocker les fichiers pour l’article Dans leur
emplacement actuel. Les clichés originaux ne se-
ront pas dupliqués dans la photothèque d’Aper-
ture; ce dernier se contentera de créer de simples

références. C’est également une bonne idée pour
ne pas encombrer inutilement votre disque dur.

PREMIÈRE PRISE EN MAIN
Les fonctions principales de l’application Aperture
sont accessibles par le biais de trois onglets
en haut de l’Inspecteur. Projets vous aide à or-
ganiser votre photothèque sous la forme d’albums,

de livres, de galeries Internet (MobileMe ou site
personnel), et même de planches contact (Table
lumineuse). L’onglet Métadonnéespermet pour
sa part la lecture des informations EXIF  (don-
nées relatives à la prise de vue: sensibilité, date
de déclenchement, ouverture, longueur focale,
vitesse d’obturation, modèle d’objectif…) ainsi
que la modification des données IPTC (classement,
mots-clés…).
Enfin, Ajustements regroupe tous les outils né-
cessaires au «développement» des fichiers Raw,
et est dévolu naturellement à la retouche pho-
tographique.

CONTRÔLE DE L’AFFICHAGE
Dans iPhoto, le contenu de la photothèque est
présenté sous la forme de vignettes dont la taille
peut être ajustée à l’aide d’une réglette à dénicher
dans le coin inférieur droit de l’interface. Le prin-
cipe demeure relativement similaire dans Aper-
ture, à ceci près que vous pouvez opter pour
deux autres modes de présentation en recourant
au bouton idoine situé à droite de la barre d’outils

. Le mode Visualiseur uniquementne montre
que la photographie sélectionnée en taille d’écran
maximale. Quant au mode Navigateur & visua-
liseur, il ajoute en sus une barre de défilement

horizontale en bas de l’interface, affichant les
miniatures des autres clichés contenus dans la
photothèque. 
Notez qu’à l’instar d’iPhoto, vous disposez d’un
mode Plein écran : de quoi ne pas être trop dé-
paysé! nD.A.Mary
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Et si vous abandonniez iPhoto
pour Aperture?

1

3

2

6

4

5

�La migration d’iPhoto à Aperture pourrait être vécue comme 
un moment difficile, mais il n’en est rien. Pour une vue d’ensemble 
de ce qui vous attend, suivez le guide! �

PHOTO008
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Développer le Raw, ce n’est pas sorcier!
Si Aperture s’accommode de n’importe quel type de fichier graphique, il va sans dire 
que les formats Raw sont tout de même sa spécialité !

         Vous et Votre Mac • Hors-série n°3 • Février 2011

�Pour donner un peu plus de peps à l’ensemble,
allez dans la section Améliorer. Forcez le

contraste microlocal et général (Définition/
Contraste), et dans une moindre mesure la satura-
tion et l’éclat.

�Une photographie de paysage sous un ciel 
nuageux est souvent le candidat idéal 

pour une image noir et blanc de qualité. Pour 
ce faire, demandez Mélangeur monochrome
dans le menu local situé en haut de colonne.

	Choisissezle préréglage Monochrome, ou
mieux Monochrome avec filtre orange

afin de donner un peu plus d’éclat aux différents 
bâtiments présents sur la photographie.

�En observant l’histogramme, vous constaterez 
que la photo a été exposée un peu trop sur la

droite.  Pour corriger cela, rendez-vous dans la section 
Exposition.

�En actionnant la réglette de récupération 
des hautes lumières, la courbe de l’histo-

gramme se modifie en conséquence. D’un point 
de vue esthétique, le ciel (sur ma photo exemple)
laisse apparaître la forme des nuages.

�Pour distinguer les zones surexposées, 
appuyez sur la touche [Cmd] tout en jouant de

la réglette Récup. Quand la zone principale 
est totalement noire, c’est que les imperfections
sont assurément corrigées.

�De la même manière, pour conserver du détail
dans les zones sombres, ajustez le point de

noir tout en maintenant la touche [Cmd] du clavier :
l’écran de travail doit redevenir blanc.

�Une fois la photo choisie dans la photothèque,
sélectionnez l’onglet Ajustements et faites un

premier réglage des niveaux de luminance.

�Pour donner un peu plus de « chaleur » 
au cliché, dans la section Balance des blancs,

déplacez quelque peu la réglette de Température
sur la droite.
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U
ne fois Posterino téléchargé depuis
la page de son éditeur (19€, http://
zykloid.com/posterino), dès l’ouverture
vous tombez sur la traditionnelle
fenêtre d’accueil. Plusieurs séries

de modèles vous sont proposées : des
cartes postales, des cadres photo, des posters
sous forme de mosaïque d’images. L’application
vous laisse aussi la possibilité de confectionner
vos propres gabarits. Avant de plonger dans
les arcanes du logiciel, il faut avoir en tête une
chose importante : quelle que soit la finalité
d’impression (cartes ou posters), tous les mo-
dèles peuvent être mis à contribution – au prix
de quelques adaptations du document de tra -
vail et des photos associées.

CARTE POSTALE «MINUTE»
Si Posterino 1.6.2 n’est guère dirigiste dans sa
mise en œuvre, vous aimerez sans doute dans
un premier temps vous satisfaire des réglages
de base. Voici comment procéder…
Pour cette première réalisation, vous allez
choisir le modèle Cartes postales > Twisted
Post. Appuyez sur le boutonChoisirpour valider
cette première étape. Dans la colonne latérale
Collection d’images , déroulez le menu local
pour choisir l’une des bibliothèques de photos
accessibles depuis le programme (iPhoto ou
Aperture). Notez que le glisser-déposer d’images
du Finder vers la fenêtre de Posterino est pos-
sible. Si vous n’avez pas d’idée sur les photos
à glisser dans le modèle de carte postale, l’ap-

plication peut s’en charger à votre place: de-
mandez Image > Remplir au hasard et votre
carte est prête en un clin d’œil.
Vous pouvez renouveler ce tirage au sort à
loisir en appuyant sur le bouton Ordre aléatoire

dans la barre d’outils. Il ne vous reste plus
qu’à envoyer la carte par courrier électronique.
Appuyez alors sur le bouton Envoyer de la
barre d’outils. Dans la fenêtre surgissante, de-
mandez Envoyer par email.

UN TRAVAIL PLUS PRÉCIS
Comme vous l’aurez remarqué en utilisant les
modèles prêts à l’emploi de Posterino, les
cadres qui accueillent vos clichés ont déjà leur
propre orientation (paysage ou portrait). Aussi,
lorsque vous utilisez la fonction de remplissage
aléatoire d’images, ces dernières peuvent ap-
paraître mal cadrées. Heureusement, il existe
plusieurs moyens de personnaliser le gabarit
de départ.
En double-cliquant sur le cadre photo de votre
choix, vous verrez apparaître des poignées
orange dévolues au redimensionnement de
l’image . En déplaçant la photographie à
l’aide de la souris, il vous sera possible d’ajuster
sa position dans le cadre. Pour effectuer une
rotation de l’image, cliquez sur le bouton vert
situé dans la partie centrale du cliché .
Si vous souhaitez réorganiser les cadres photo,
il vous faudra au préalable déverrouiller leur
position dans la carte postale. Pour ce faire, 

cliquez sur le bouton Débloquer les cadrespré-
sent dans la barre d’outils de Posterino. Enfin,
pour ajouter un nouveau cadre photo, une
zone de texte, ou même un timbre factice, ap-
puyez tout simplement sur l’icône Nouvel objet,
toujours dans la barre d’outils.

BONNE IMPRESSION
Depuis juillet 2009, le service d’impression de
cartes postales n’est plus accessible depuis
l’interface de l’application (bouton Envoyer >
Envoyer comme carte postale). Qu’à cela ne
tienne! Plusieurs solutions alternatives s’offrent
en effet à vous.
Il faut savoir que le service proposé par La
Poste suisse (Swiss PostCard) n’est pas en
berne… Il reste accessible depuis le site web
(www.swisspostcard.ch/index.php?id=297&L=10).
Un assistant vous aide à composer en ligne

votre carte postale en deux formats A6 ou A5.
Vous pouvez même utiliser vos propres photos
en guise de timbre-poste. Le coût est d’environ
1,60€par carte envoyée.
Une alternative consiste à confier vos travaux
à iPhoto ou à un autre service d’impression en
ligne. Alors, la création du fichier graphique
par Posterino s’effectue depuis le bouton
Exportde la barre d’outils. nD.A.Mary
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� Élaborer des cartes postales ou des posters avec soin et élégance, 
c’est ce que propose ce sympathique partagiciel. �
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Cartes postales et posters avec 
Posterino
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Compositions à imprimer sur place

�Commencez par choisir n’importe quel modèle 
dans la fenêtre d’accueil de Posterino, puis 

demandez Poster > Format. Dans la fenêtre surgissante,
entrez les dimensions finales de votre image.

�Pour obtenir la meilleure qualité d’impression 
possible, optez pour un 20x30 cm en 200 dpi 

si vous avez un appareil 4 mégapixels, ou 50x75 cm pour
un appareil de 14 mégapixels.

�Glissez l’image dans le cadre. Double-cliquez dessus
pour affiner le cadrage le cas échéant. Si le modèle

possède un ou plusieurs cadres de texte, double-cliquez
dessus pour personnaliser leurs contenus.

�Cliquez sur le bouton Afficher les détails dans 
le coin inférieur droit de l’interface. Si vous souhai-

tez afficher un liseré de couleur, dans la colonne de droite
cochez la case Dessiner le cadre. Pour modifier 
la couleur d’arrière-plan, cliquez sur le bouton Page.

�Glissez l’image dans l’interface de PosteRazor. 
Appuyez sur le bouton Suivant. Dans la partie

droite de l’écran, sélectionnez le format d’impression
maximal de votre imprimante. Cliquez à nouveau sur 
Suivant.

�Choisissez la largeur (en centimètres) de la zone 
de recouvrement pour permettre l’assemblage 

des différentes feuilles A4 qui formeront le poster. 
Cliquez deux fois sur Suivant.

	Appuyez sur le bouton situé sous Enregistrer 
le poster. Ouvrez dans Aperçu le document PDF 

généré par le logiciel et imprimez chaque page, 
puis assemblez-les soigneusement avec de la colle ou 
du ruban adhésif.

�Passons à l’impression professionnelle… Si votre 
format est un 20x30, iPhoto pourra s’en charger. 

Dès lors, appuyez sur le bouton Export > Ouvrir dans
iPhoto. Pour tout format supérieur, faites Enregistrer sur
le disque en JPG qualité haute.

�Pour un format supérieur, des laboratoires en ligne
(Photoweb ou autres…) peuvent s’occuper du tirage.

Si vous souhaitez absolument réaliser vous-même 
l’opération avec votre imprimante, le gratuiciel PosteRazor
fera l’affaire (posterazor.sourceforge.net).

Confectionner un poster n’est guère difficile avec Posterino. Reste la question du tirage… Plutôt 
qu’un laboratoire en ligne, pourquoi ne pas utiliser votre imprimante personnelle?
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C
e logiciel a été un peu hâtivement ré-
duit à la lomographie. Le Lomo LC-
A était un appareil compact argen-
tique russe commercialisé en 1984
et devenu objet culte depuis le début

de la décennie. La lomographie est le symbole
de la photographie libérée de toutes les con -
traintes esthétiques. PhotoStyler 2.5.2, facile
à utiliser, mais puissant, ne saurait être réduit
à cette vision! Démonstration…
Au lancement de PhotoStyler (30$ – http://pho
tostyler.corner-a.com), veillez à ce que les trois
petits boutons en bas de la fenêtre principale
soient illuminés pour que l’interface pré -
sente toutes les fonctions.
PhotoStyler peut être utilisé de deux manières.
En mode automatique, vous glissez un fichier
photo (PSD, PNG ou JPeg) dans la surface de
travail et cliquez sur un préréglage dans la co-
lonne latérale gauche . Sans effort, j’obtiens
ainsi une image sépia avec du grain. Sinon,
vous pouvez choisir vos effets dans la colonne
latérale droite , que vous cumulez dans un
espace réservé en bas d’écran .

AFFINEZ ET MÉMORISEZ LES RÉGLAGES
L’intensité de chaque effet est ajustée dans le
panneau de réglages . Vous pouvez désac-
tiver momentanément un effet en appuyant

sur l’icône en forme d’œil , vous débarrasser
d’un filtre en tirant son icône hors de l’interface

, et mémoriser un ensemble de réglages
via File > Save Chain as Preset Template.

UNE CARTE POSTALE EN UN CLIN D’ŒIL
Glissez une photo de paysage sur PhotoStyler.
Déposez au bas de l’interface les effets (à sé-
lectionner dans la colonne de droite) dans
l’ordre suivant : AutoLevels, AutoContrast,
Color controls, Unsharp mask, Colored frame
etCaption . Les deux premiers ajustent les
niveaux, la luminosité et le contraste de l’image
de façon automatique ; de quoi obtenir une
image «neutre». Double-cliquez sur Color
controlspour modifier l’exposition, le gamma,
le contraste, la luminosité ainsi que la saturation
comme bon vous semble (dans mon exemple,
les valeurs suivantes 0,14 / 1,14 / 1,1 / 0,03 / 1,38).
Unsharp mask sert au réglage de la netteté.
L’accentuation des contours étant particuliè-
rement marquée sur les cartes postales du
commerce, le paramètre Intensity sera réglé
sur 0,82 avec un Radius de 3,31. Suivant les di-
mensions de votre photographie, il faudra sans
doute procéder à quelques ajustements.
Pour créer la bordure blanche, double-cliquez
sur Colored frame. Saisissez des valeurs iden-
tiques dans les champs Sideet Bottom. Frame
fill colorouvre la palette Colors, dans laquelle

vous choisissez le blanc (Snow). Pour insérer
une signature ou un texte dans le coin infé -
rieur droit de la carte postale, double-cliquez
sur Caption. Dans la palette flottante, réglez
le menu local Inscription anchorsur Right bot-
tom. Surlignez et changez le texte par défaut,
affinez son placement à l’aide des deux champs
Offset. Les valeurs que j’utilise ici sont respec-
tivement de –80 et 50 .

L’exportation finale s’effectue naturellement
avec la commande File > Render Output Image.
Ci-contre, un autre exercice met en valeur les
fonctions de PhotoStyler…nD.A.Mary
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Retouche photo facile avec
PhotoStyler
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� PhotoStyler a de vraies 
aptitudes pour la retouche photo.
Un astucieux et accessible 
complément d’iPhoto. �
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Réalisez un portrait high key

�Pour obtenir ce type de portrait souligné par 
un liseré anthracite et une bordure blanche, 

utilisez si vous le pouvez une photographie prise avec 
un arrière-plan neutre, voire en contre-jour.

�Depuis la colonne latérale droite, glissez en contre-
bas de l’interface les filtres dans l’ordre suivant :

Color controls, Levels, Color of 30’s, Monochrome,
Bloom, Frame et Colored frame.

�Dans Color controls, augmentez légèrement 
l’exposition (Exposure) et le Contraste. Réduisez 

quelque peu le Gamma et la Saturation. L’image devient
plus délicate…

�Côté Levels, placez le menu local Mode sur Light 
balance. Déplacez le curseur des basses lumières

(celui de gauche) à 1 % et celui des hautes lumières autour
de 90 %. Ajustez les tons intermédiaires (Gray) de façon 
à obtenir un cliché « surexposé ».

�Frame servira à créer un discret liseré anthracite.
Ajustez la dimension du cadre en fonction de votre 

photographie (pour ma part, les valeurs Side border
et Bottom border sont à 30). Appliquez ensuite 
le raccourci [Cmd L] au clavier.

�Dans la palette Texture library, choisissez 
le document graphique nommé Scratches_2.jpg, que

vous glissez dans le cadre situé au bas de la palette
Frame parameters.

	Enfin, avec Colored Frame, tracez une bordure
blanche (Side et Bottom à 60). Cliquez sur le cadre

en face de Frame fill color, puis sélectionnez 
dans la palette Colors le crayon de couleur Snow.

�Dans l’utilisation de Color of 30’s, l’important 
est de légèrement suraccentuer les rouges. L’image

devrait présenter des noirs plus profonds et les ombres 
du visage devraient également s’estomper.

�Dans la palette Monochrome, cochez Sepia et 
ajustez l’intensité de l’effet entre 0,10 et 0,25 

maximum. Bloom permet d’obtenir une ambiance vapo-
reuse : n’hésitez pas à ajouter du flou (paramètre Blur 
radius). Réglez l’opacité sur 0,22.

La technique dite high key permet d’obtenir un cliché très lumineux, avec une ambiance vaporeuse.
Grâce à PhotoStyler, partez sur les traces du photographe Duncan Thorn.

         Vous et Votre Mac • Hors-série n°3 • Février 2011
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P
our cette réalisation, vous aurez besoin
d’un portrait, sur un arrière-plan neutre
de préférence, et d’une dimen sion
maximale de 2000 pixels de hauteur
(ou de largeur si la photo a été prise

en mode paysage). Nous allons nous servir
d’Aviary, une suite gratuite et puissante que je
vous ai déjà amplement présentée dans le nu-
méro 55 de Vous et Votre Mac.

ÉTAPE PRÉPARATOIRE
Ouvrez tout d’abord votre navigateur Web à
l’adresse www.aviary.com. Si vous ne possédez
pas encore de compte utilisateur, créez-en un
en cliquant tout simplement sur le boutonSign
upen haut à droite de la page. Les utilisateurs
déjà enregistrés cliqueront, eux, sur Log�In. En
haut de la page, déroulez le menu Create, puis
demandez Effects�Editor� . C’est dans ce mo-
dule Peacock que nous allons élaborer les cinq
images nécessaires.
Importez maintenant la photographie (File�>
Import�Resource). En haut de la fenêtre qui

surgit, à l’onglet Upload, cliquez sur le bouton
Choisir�le�fichier. Sélectionnez ensuite la photo
et validez votre choix en cliquant sur Choisiren
bas à droite. Enfin, cliquez sur Upload�File (en
haut à droite de la page Web) pour téléver ser
le fichier vers le site d’Aviary.
Sur le côté gauche de l’interface, cliquez sur
l’onglet Resources, puis glissez-déposez au
centre de l’écran la vignette représentant la
photographie. Elle apparaît dès lors sous la
forme d’un module intitulé Resource. Cliquez

sur le module Canvas, puis rendez-vous dans la
colonne latérale droite, onglet Properties. In-
diquez dans les champs Width(largeur) et Height
(hauteur) les dimensions en pixels de la photo
originale (ici, 1363x1600 pixels).

CINQ IMAGES À LA UNE
Dans l’onglet Effects (à gauche), ajoutez à la
composition nodale en cours les modules Pos-
terize, Color�Manipulationet Threshold. Reliez-
les entre eux dans�l’ordre�suivant :�Resource,
Posterize,�Color�Manipulation,�Threshold�et
Canvas . Cliquez sur le bouton Posterize puis,
à l’onglet Properties, dans le champ inti tulé
Levels, tapez le chiffre 5.
Ajustez si nécessaire le contraste et la satura -
tion de votre image via le module Color�Mani-
pulation> Propertieset ses réglettes Contrast
et Brightness.
Dans le module Threshold, onglet Properties,
ajustez la réglette Thresholdde manière à n’ob-
tenir dans le module Canvasqu’une silhouette
noire . Dans mon exemple, la valeur Threshold
est fixée à 255 .
Dans le menu Filed’Aviary, demandez Export
Canvas�As�Bitmapet optez pour le format PNG.
Cliquez sur Export�Image, puis sur le bouton
Download. L’image va alors s’enregistrer sur

votre disque dur. Dans le dia-
logue, nommez le fichier por-
trait-1.pnget enregistrez-le
sur votre Bureau.
Recommencez les deux pré-
cédentes étapes à quatre re-
prises. À chaque fois, vous
modifierez�à�la�baisse�la�va-
leur�du�module�Threshold.
Ceci permettra d’obtenir au-
tant de variantes du portrait
d’origine. À titre purement
indicatif, les�valeurs�que�j’uti-
lise�sont�successivement�de
215,�202,�180�et�132 . Vous
pouvez les modifier si besoin
est. Chaque nouvelle image
obtenue est exportée sur
votre Bureau sous les noms
respectifs portrait-2.png,
portrait-3.png, portrait-4.png
et portrait-5.png.
La première partie de notre
réalisation étant achevée,
nous pouvons passer à la
suite expliquée en images
dans la page ci-contre. Mais

avant cela, je vous conseille d’enregistrer votre
travail (File�>�Save), puis de fermer la fenêtre
Effects�Editor. De retour sur la page d’accueil
d’Aviary, déroulez le menu Createet demandez
à entrer dans le module Vector�Editor. 
nD.A.Mary
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Yes you can avec Aviary
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� L’artiste Shepard Fairey réalisa 
en 2008 le portrait de Barack
Obama pour Time Magazine. Son
style graphique a depuis fait école.
Je vous propose de l’imiter. �
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Du bitmap au dessin vectoriel avec Raven

�À l’ouverture de Raven, indiquez la taille 
de votre document de travail en fonction 

de la photo d’origine. Cliquez sur le bouton Create. 
Demandez ensuite Fichier > Import File.

�En haut de la fenêtre, cliquez sur Choisir le fichier.
Sélectionnez portrait-1.png, cliquez sur Choisir, puis

sur Upload File. Recommencez avec les quatre autres 
fichiers, de portrait-2.png à portrait-5.png.

�Dans la palette Layers, cachez tous les calques. 
Cliquez sur la case en regard de Bitmap 2. Deman-

dez Object > Object to path > onglet Black and White.
Confirmez avec OK. La vectorisation est effectuée.

� Dans la palette Layers, deux dossiers imbriqués
Trace Bitmap/TracePath_1 apparaissent.

Cliquez sur la case en regard du dossier TracePath_1 afin
de sélectionner tous les éléments qu’il contient.

� Vectorisez les calques Bitmap 3 à Bitmap 6. 
Voici la teinte à attribuer (Fill and Stroke) pour

chaque nouveau couple de dossiers Trace Bitmap/
TracePath_1 : d’abord vert pâle (# bfcbbd), puis vert foncé
(# 86a7af).

� Attribuez ensuite la teinte rouge (# c7262e). 
Enfin, pour le dernier couple de dossiers, laissez 

la couleur noire par défaut. Pour finir, il convient 
de créer l’arrière-plan…

	 En bas de Layers, cochez la case en regard 
du dossier Layer 1. Prenez l’outil Carré et cliquez

sur la feuille de travail. Cliquez sur OK dans la palette
Create shape. Redimensionnez le cadre qui apparaît. 
Enfin, faites Fill and Stroke > Fill > Color > # a8070f.

� Avec l’outil Transform Tools, agrandissez 
si nécessaire le dessin pour qu’il couvre la totalité 

de votre feuille de travail.

� Dans la palette Fill and Stroke située au-dessous,
onglet Fill, double-cliquez sur la case Color. Dans 

le champ #, tapez la valeur hexadécimale fae9b5. Cliquez
sur OK. La silhouette noire se colore en orange pâle.

Dans ce volet pratique, nous allons nous dédier à l’assemblage et à la colorisation des cinq images 
précédemment réalisées.
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L
’imagerie à grande gamme dynamique
révèle force de détails dans toutes les
zones de l’image. Techniquement, au
lieu d’utiliser un codage de 24 bits par
pixel (soit 8 bits par canal rouge, vert

et bleu), et donc de n’avoir qu’un écart faible
de lumière entre le pixel le plus lumineux et le
plus faible, l’image HDR va stocker un nombre
flottant de bits par pixel pouvant aller jusqu’à
96 – ce qui ne peut pas être affiché sur l’écran
d’un ordinateur. Aussi, pour «révéler» la com-
position obtenue, on utilise un artifice nommé
Tone Mapping. Sur Mac, les logiciels de photo
HDR ne manquent pas, mais HDRtist (www.oha
naware.com/hdrtist) est à la fois gratuit et
d’une grande simplicité d’emploi.

LA PHOTO EN TRÈS HAUTE RÉSOLUTION
Pour obtenir un cliché à l’ambiance onirique

(prise depuis la plage de Ploumanach en
Bretagne), j’ai fusionné plusieurs photographies
prises quasi simultanément, à ceci près que
les paramètres d’exposition ont été modifiés
à chaque fois. Le HDR peut s’employer sur des
scènes en contre-jour pour «déboucher» ar-
tificiellement des zones sous-exposées de
l’image. Mais si vous aimez cet effet spécial,
rien ne vous empêche d’en user et abuser en

toutes circonstances : pour la photographie
de portrait, la macro-photographie… Le pho-
tographe de publicité Thomas Muselet en a
d’ailleurs fait sa signature artistique…L’infor-
matique n’est ici qu’un moyen; la réussite d’un
traitement numérique ou d’un effet spécial

n’est que l’aboutissement d’un travail réalisé en
amont, dès la prise de vue! Voici donc les conseils
à appliquer, quel que soit votre appareil.

Stabilisez votre cadrage. Le logiciel HDRtist réclame
plusieurs expositions d’une même scène avec un ca -
drage identique. Placez votre appareil photo sur un
trépied ou bien sur une surface parfaitement stable.
Si vous utilisez un reflex doté d’une optique stabilisée,
désactivez la stabilisation.

Utilisez la fonction bracketing d’exposition auto-
matique. Lorsqu’elle existe, cette fonction vous autorise
à prendre des vues successives à différents niveaux
d’exposition (variant de –1 IL à +1 IL sur les compacts et
bridges, et jusqu’à +/– 3 IL sur un reflex).
Dès lors, vous allez obtenir trois photos : une première
en exposition standard, une seconde sous-exposée et
une dernière surexposée. Ces trois images serviront
à réaliser la photographie HDR.

Activez la prise de vue en rafale. Une fois le cadrage,
la mise au point et le calcul d’exposition effectués, une
seule pression sur le déclencheur suffira à obtenir les
clichés nécessaires (si le mode rafale n’existe pas, dé-
clenchez par trois fois manuellement).

PAS DE PANIQUE!
Si vous n’avez pas de fonction bracketing d’ex-
position, placer votre appareil photo sur trépied
est alors un impératif. Désactivez la stabilisation
si elle existe. Appuyez sur le bouton de correc-
tion d’exposition, puis ajustez la valeur à –1,
voire –2. Faites la mise au point et prenez la
photo. Recommencez une fois avec une cor-
rection d’exposition à 0, et enfin une troisième
fois à +1 ou +2. Si vous avez peur du flou de
bougé (notamment sur reflex), utilisez la fonc-
tion retardateur 2 sec.

UN PAYSAGE NET
Le problème se pose moins sur un compact,
un bridge ou un micro 4/3 avec la mise au point
par détection de contraste. La pratique du
reflex est, elle, plus contraignante. Si vos photos
sont molles (avec un arrière-plan légèrement
flou), respectez deux conditions…
Tout d’abord, effectuez la mise au point dans
le premier tiers de l’image (si nécessaire, n’em-
ployez qu’un seul collimateur). Enfin, utilisez
le mode priorité à l’ouverture (Av) et fermez
votre diaphragme (de f/11 jusqu’à f/22 selon le
reflex utilisé). n D.A.Mary
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Grande gamme dynamique
avec HDRtist
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�Phénomène relativement récent, la photographie HDR (High Range 
Dynamic) est un procédé de traitement numérique qui permet 
d’obtenir d’une image la plus grande plage d’information dynamique possible. �
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Le Tone Mapping facile

�À la prise de vue, travaillez en JPeg, éventuellement
en Raw (s’il s’agit d’un Raw reconnu par le système). 

Installez HDRtist et lancez-le. Déposez vos trois photos
dans son interface.

�L’image HDR s’affiche quasi instantanément. 
Si vous observez un léger flou dû à un décalage 

entre les différentes prises de vue, cliquez sur le bouton 
Align Photos.

�Le calcul d’alignement étant achevé, passons 
au dosage de l’effet : utilisez la réglette Strength

située en contrebas de l’interface.

�Exportez l’image HDR en cliquant sur le bouton 
Save HDR. Dans le dialogue, renommez le fichier

comme bon vous semble, puis appuyez sur le bouton
Save. Passons à la retouche finale…

�Pour optimiser les couleurs, cliquez sur Améliorer
(dans la barre d’outils), puis sur Ajuster pour faire 

surgir la palette. La récupération des détails dans les
zones claires de l’image (le ciel, par exemple) s’opère via
la réglette Tons clairs.

�Procédez de la même façon avec la réglette 
Tons foncés pour ajuster la luminosité des zones 

les plus sombres de l’image. Pour donner un peu plus
de « piqué » à l’image, recourez aux réglettes Définition
et Netteté.

	Enfin, affinez le contraste en basculant légèrement
sur la droite le curseur central des Niveaux. 

Modifiez la Température des couleurs comme bon vous
semble. Enfin, cliquez sur OK dans la barre d’outils pour
valider la retouche. Votre photo est prête !

�Importez la photographie obtenue dans iPhoto ’09.
Dans la barre d’outils, cliquez sur le bouton Édition.

Sélectionnez l’outil Rogner si l’image présente 
une ou plusieurs bordures sombres dues à l’alignement
des clichés dans HDRtist. Sinon, passez à l’étape 7.

�Dans la palette flottante, cochez la case
Contrainte, puis procédez à un recadrage de

l’image à l’aide des poignées. Cliquez sur le bouton
Appliquer de la palette flottante pour valider 
les modifications.

De l’assemblage des clichés dans HDRtist à la retouche complémentaire dans iPhoto ’09, 
neuf étapes nous séparent du résultat final.
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C
et utilitaire présente cinq
fonctions principales: la
réduction du bruit, la cor-
rection optique (distor-
sion et aberrations chro-

matiques), la suppression d’objets
ou de personnes en mouvement,
l’augmentation de la profondeur
de champ ainsi que la maîtrise de
la plage dynamique de l’image. À
l’instar d’autres solutions (PTLens
ou DxO Optics Pro), les cor rections
optiques s’appuient sur une base
de données technique associant
boîtiers et objectifs.
Aussi, selon le photoscope en votre
possession, il vous faudra choisir la
bonne version de PhotoAcute Stu-
dio. L’édition Portable (15,07€) est
destinée à améliorer les clichés pris
avec votre iPhone, HTC et autre
BlackBerry. Les versions Standard
(38,86€) et Pro (94,38€) s’adres-
sent respectivement aux utilisateurs
de caméras compact/bridge et re-
flex. PhotoAcute impose quel ques
contraintes à la prise de vue: pour
tirer parti des fonctions de réduction
du bruit, de suppression d’objet en
mouvement ou d’augmentation
de la profondeur de champ, il vous
faudra prendre plusieurs clichés
successifs d’une même scène avec
un trépied. Ces précautions d’usage
observées, le logiciel ne requiert
ensuite que peu d’intervention de
votre part, comme nous allons le
voir à travers les deux exemples
qui suivent.

SUS AU BRUIT NUMÉRIQUE!
Tout utilisateur d’APN est concerné
par le bruit numérique , l’inten-
sité de ce dernier variant en fonction
de la qualité des composants élec-
troniques, de la taille des photosites

à la surface du capteur ainsi que
des réglages effectués.
Dans le cas d’un déclenchement à
main levée, en intérieur et sans flash
(lors de la visite d’un musée, par
exemple), une sensibilité de 800
ISO ou plus est obligatoire pour évi-
ter tout flou de bougé. Las, à hauts
«zizos», peu de compacts ou de
bridges sont capables de délivrer
une image de qualité. Aussi, pour
atténuer ces imperfections, voici
la recette à suivre…
Réglez votre appareil en mode de
déclenchement en rafale, puis pho-
tographiez une même scène trois
à quatre fois. Pour les possesseurs
d’un iPhone, vous pouvez recourir
aux applications QuadCamera
(1,59€) ou MoloPix Free (gratuit).
Les photographies déchargées dans
iPhoto, choisissez celles appartenant
à une même scène, puis exportez-
les sur le Bureau (Fichier > Exporter
> Exportation de fichiers en taille
100% et en qualité Maximum). Lan-
cez PhotoAcute Studio, cliquez sur
Cancel dans la fenêtre d’accueil,
puis glissez les fichiers dans sa fe-
nêtre. Dans la barre laté rale, cochez
les cases devant cha que fichier
photo .
Sélectionnez la photographie qui
présente le meilleur cadrage. Si

toutes répondent à ce critère, choi-
sissez simplement la première de
la liste . Cliquez sur Start, puis
sur OK dans l’alerte qui surgit. Si
votre appareil n’est pas géré par le
logiciel, cliquez sur Disable super-
resolutiondans le dialogue suivant.
Dans la fenêtre Processing, posi-
tionnez les menus locaux sur les
options Combined 1x output, No
special processing of the scene et
Normal aligment . Cochez les
cases Auto-crop outputet Fix color
fringing (pour la correction des
franges colorées) .
Si l’option est disponible pour votre
appareil, vous pouvez corriger la
distorsion en barillet ou en coussinet
en cochant la case Correct image
geometry. Cliquez sur OKpour lan-
cer le calcul de l’image. Exportez le

résultat final via le bouton Save en
bas de l’interface.

UNE EXPOSITION PARFAITE
Pour parvenir à un rendu équilibré
de toutes les zones de l’image
lorsque vous photographiez en
contre-jour, recourez au bracketing
d’exposition – une technique que
nous avons déjà employée lors du
Pratique Express dédié à la photo-
graphie HDR (Vous et Votre Mac nº
56). Il s’agit simplement de prendre
trois vues successives avec des pa-
ramètres d’exposition différents
(–2 IL, 0 et +2 IL, par exemple). Im-
portez alors les images dans Photo -
Acute et choisissez le préréglage
High Dynamic Rage hand-helddans
le menu local situé en haut de la fe-
nêtre Processing. nD.A.Mary
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Tirez le meilleur de votre photoscope
grâce à PhotoAcute Studio
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�Puissant, mais quelque peu 
sous-estimé, PhotoAcute Studio 
améliore pourtant bien la qualité 
technique de vos prises de vue.�

� www.photoacute.com/studio
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Maîtrisez la profondeur de champ

�Utilisez un trépied. Fermez le diaphragme entre 
f/8 et f/11 selon votre objectif. À l’aide du collimateur

idoine, faites la mise au point sur la partie la plus 
proéminente de votre sujet. Prenez une première photo.

�Sans bouger le cadre, changez de collimateur et 
réalisez la mise au point sur une zone plus éloignée.

Déclenchez une seconde fois. Importez vos clichés sur 
votre Mac.

�Ouvrez PhotoAcute Studio et glissez les deux 
clichés dans son interface. Dans la colonne latérale,

cochez les cases en regard du nom des deux images.
Cliquez ensuite sur le premier élément de la liste.

�Si le nom de votre appareil photo n’apparaît pas 
en haut à gauche de l’interface de PhotoAcute, 

cliquez sur le bouton Settings. Appuyez sur le bouton
Camera, puis choisissez la marque, le modèle 
de votre photoscope, ainsi que l’objectif utilisé.

�Cochez la case Fix color fringing afin de corriger
d’éventuelles franges pourpres, puis fixez l’option

Lattice density à 9 et l’option Mask precision sur High.
Cliquez sur OK en bas à droite pour lancer le calcul.

�Cliquez sur Save pour exporter le résultat final. 
Dans le dialogue qui s’affiche, optez pour le format 

de fichier qui convient (JPeg ou Raw/DNG). Donnez 
un nom au fichier, puis validez l’enregistrement.

	Avant de traiter une nouvelle série de clichés, 
effacez les images contenues dans le logiciel 

(sélectionnez tour à tour leur nom dans la barre 
latérale, puis cliquez sur Close. Plus simplement, 
quittez et relancez l’application.

�De retour dans la fenêtre principale du logiciel, 
cliquez sur Start. Passée l’alerte, déroulez le menu

local Preset en haut de la fenêtre Processing et 
demandez Depth of Field expansion.

�Modifiez dans le menu local l’option Normal 
alignment pour Only small shifts in alignments

– si les décalages de cadrage entre les prises de vue 
sont infimes –, ou Wide distorsions allowed 
in alignement – pour plus de sécurité.

La pratique de la photo macro impose de nombreuses contraintes techniques. Pour augmenter 
la plage de netteté à l’ensemble du sujet, appelez PhotoAcute à la rescousse !
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P
our ce photomontage, vous aurez
besoin de plusieurs images. Celle de
l’iPad comme celle de l’iPhone sont
proposées par Apple aux adresses
suivantes: www.apple.com/pr/products/

ipad/ipad.html et www.apple.com/fr/pr/products/
iphone. Il vous faut aussi la photo d’une fermeture
éclair. Celle que j’utilise ici est incrustée de cristaux
Swarovski tout le long de la crémaillère. Vous
téléchargerez depuis le site de Vous et Votre
Mac les deux fichiers Glissière.png et Tirette.png
(que j’ai préalablement détourés pour vous fa-
ciliter le travail).

PRÉPARATION
Nous allons redimensionner l’iPhone et l’iPad
afin de travailler avec des fichiers plus légers.
Glissez-les sur l’icône d’Aperçu. Afin d’éviter
une erreur d’enregistrement lors de la conversion
des fichiers graphiques Tiff en JPeg, procédez
comme suit… Demandez le menu Édition > Tout
sélectionner, puis Fichier > Créer à partir du
presse-papiers. Dans le menu Outils > Ajuster la
taille, indiquez une hauteur de 1000 pixels pour
une résolution de 72 pixels par pouce. Cliquez
sur le bouton OK. Sauvegardez les documents
bitmap sous les noms de iPhone et iPad, au
format JPeg et en qualité maximale (réglette
basculée sur la droite).

EN ROUTE POUR AVIARY
Avec votre navigateur favori, connectez-vous
à Aviary (www.aviary.com), la suite graphique en
ligne. Si vous n’avez pas de compte utilisateur,
créez-le. Déjà enregistré? Cliquez sur Log In. En
haut de la page, déroulez le menu Create, puis
demandez Image Editor (Phoenix).
Dans la fenêtre d’accueil, cliquez sur Start from
Scratchavec les valeurs suivantes: 1400 de large
(Width) par 1400 pixels de haut (Height). Pour
la couleur de fond (Background Color), position-
nez le menu local Transparent sur Select Color

. La teinte blanche sera alors automatique-

m e n t
a p p l i -
quée. Cli-
quez sur le
b o u t o n
Create.
Pour avoir une
vue d’ensemble
du document de
travail, recourez à
la réglette de zoom
(en haut à droite de la
fenêtre). Importez en-
suite les éléments gra-
phiques dans l’ordre sui-
vant: l’iPad, l’iPhone, la glis-
sière (Glis sière.png), puis la
tirette (Tirette.png), le tout via le menu File

> Import File. En haut de l’écran, appuyez sur
le bouton Choisir le fichier.
Sélectionnez l’image à importer dans le dialo -
gue, puis cliquez successivement sur Ouvriret
Upload File. Si d’aventure Phoenix vous avertit
que l’image est plus grande que la sur face de
travail, cliquez tout simplement sur le bouton
Crop Image. Recommencez cette opération
pour chaque photo.
Avant de continuer, je vous propose de renom-
mer, pour des raisons pratiques, chaque calque
(dans la palette Layers). Pour cela, il suffit de
double-cliquer sur chaque intitulé par défaut.
Untitled – 4 est renommé iPad , Untitled –

5, iPhone;
Untitled – 6,
Glissière; en-
fin Untitled – 7, 
Tirette.
Cliquez sur Save
as(en haut à droite)
pour sauvegarder vo-
tre travail. N’oubliez
pas de le faire à intervalle
régulier afin de ne pas per-
dre les dernières modifica-
tions opérées. Rendez invi-
sibles tous les calques sauf

iPad, en appuyant sur les bou-
tons en forme d’œil . Avec l’ou-
til Sélection rectangulaire, tracez

un cadre tout autour de l’iPad, puis demandez
successivement Select > Invert selection, puis
Edit > Delete. Ainsi, vous conserverez de la pho-
tographie de départ uniquement l’iPad vu de
face . nD.A.Mary
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De l’iPhone à l’iPad…
en un clin d’œil
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� À l’image de l’affiche du film Body Snatcher
d’Abel Ferrara, nous allons révéler l’iPad 
qui sommeille en tout iPhone. �
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Un montage bling-bling

�Désactivez le calque iPad et activez le calque
iPhone. Avec l’outil de déplacement (Move Tool),

centrez l’image de l’iPhone. Tracez un cadre avec l’outil de
sélection rectangulaire sur la moitié gauche de l’iPhone.

�Faites un copier, puis un coller : la palette Layers
contient désormais deux moitiés d’iPhone. Sélec-

tionnez le calque représentant la moitié gauche. Activez
l’outil Transformation Tool.

�Placez le pointeur sur la poignée supérieure
gauche. Lorsque le curseur se transforme, faites pi-

voter la sélection. Procédez de même pour faire pivoter
l’autre moitié droite de l’iPhone.

�Sélectionnez l’outil Transformation Tool > 
Deformation Tool afin d’aplanir la base 

de chacune des moitiés de l’iPhone. Recourez 
aux poignées inférieures.

�Déplacez le nouveau calque et continuez à border
avec la moitié intérieure gauche de l’iPhone. 

Dupliquez à nouveau le calque autant de fois que 
nécessaire. N’oubliez pas de border également la moitié
intérieure droite de l’iPhone.

�Pour chaque calque représentant la glissière, 
cliquez sur Layer Filter (le bouton « f » en bas de 

la palette Layers), puis cochez la case Shadow. Pour les
calques de la glissière de gauche, recourez aux 
paramètres indiqués dans la capture. Cliquez sur OK.

	Recommencez l’étape 8 pour chaque calque 
de la glissière de droite. Changez la valeur du 

paramètre Angle à 180. Enfin, rendez visible le calque 
Tirette, ajustez sa taille si nécessaire à l’aide de l’outil
Transformation Tool.

�Rendez le calque iPad visible, puis déplacez-le très
légèrement vers le haut, comme s’il surgissait 

des entrailles de l’iPhone. Ensuite, sélectionnez 
le calque Glissière que vous rendez à nouveau visible.

�Avec l’outil Transformation Tool, inclinez 
le calque Glissière afin qu’il borde la moitié 

intérieure gauche de l’iPhone. Réduisez sa taille… 
Dupliquez (Layer > Duplicate Layer).

Passons à présent aux étapes clés de la réalisation, de l’incrustation de la fermeture éclair 
à la révélation de l’iPad.
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P
our cette réalisation,
vous utiliserez n’im-
porte quel cliché
contenant de l’eau
(une rivière ou un

océan, peu importe ). Nous
allons ici l’extraire avec Pixelma-
tor, mais vous pouvez utiliser un
autre éditeur bitmap bien sûr.
Ouvrez la photo dans Pixelmator,
puis dans la palette Calques, de-
mandez d’un clic-droit Dupliquer
le calquedans le menu contextuel.
Décochez alors le premier calque
(Calque sans titre 1), puis d’un clic-
droit sur le second calque, deman-
dez à ajouter un masque de fusion.
Optez ensuite pour l’outil Pinceau
et, dans la palette Outils, pour une
forme de taille 100.
Avec ce pinceau, effacez tous les
éléments du décor (rochers, ciel,
arbres…), sauf l’eau. Pour procéder
à des retouches plus délicates, mo-
difiez la taille du pinceau. Pas besoin
d’être très précis pour obtenir un
trucage de qualité honorable. Ex-
portez ensuite le calque courant

sous la forme d’un fichier PNG à
fond transparent (Fichier > Exporter
> PNG). Cliquez sur le bouton Sui-
vant, nommez l’imageEau.pnget
faites Exporter.

DES ONDES SUR LES ROCHERS
Pour créer l’illusion du mouvement
de l’eau, nous allons faire appel à
Quartz Composer (livré avec les
outils développeurs de Mac OS X).
Le trucage s’élabore en deux
temps… Tout d’abord, on génère
une texture animée à appliquer
ensuite sur la photographie de dé-
part. Pour vous faciliter le travail,
vous trouverez sur le site Internet
de Vous et Votre Mac un modèle
de composition comportant les
éléments de base nécessaires à
cette réalisation (fichier Ondes sur
les rochers.qtz).
Une fois le fichier téléchargé, dou-
ble-cliquez dessus pour l’ouvrir
dans Quartz Composer. Au centre
de la fenêtre se trouve un premier
module rectangulaire nommé Ren-
der in Image. Dans la terminologie

Apple, il s’agit d’unmacro-patch.
Celui-ci se comporte comme n’im-
porte quel autre module, vous pou-
vez donc lui attribuer divers para-
mètres et, bien entendu, le relier
à d’autres patchs. Mais ce qui le
rend spécial c’est sa capacité à
contenir (à l’ima ge des poupées
gigognes) d’autres patchs, voire
une composition nodale complète.

On recourra donc aux macro-
patchs pour rendre plus lisible un
document Quartz Composer ou
pour scinder différents aspects
d’une composition.

À L’INTÉRIEUR DU MACRO-PATCH
Pour explorer le contenu de Render
in Image, il suffit de double-cliquer
dessus – pour remonter d’un niveau
dans l’arborescence de la compo-
sition, vous devrez cliquer sur le
bouton Edit Parent de la barre d’ou-
tils. Dans Render in Image, vous
trouvez donc une sous-composi-
tion simulant le reflet de l’eau. Pour
qu’un mouvement soit visible à
l’image, nous allons étoffer cette
première ébauche du trucage…
Sélectionnez tous les patchs de la
composition nodale à l’exception
du second patch Sprite, puis de-

mandez Edit > Duplicate.
La composition étant dupliquée,
travaillez uniquement avec la copie.
Commencez par supprimer l’un
des deux patchs Sprite. Dans la pa-
lette flottante Inspector > Input
Parameters, faites attention à ce
que tous les champs X Position à
Z Rotation aient bien la valeur 0et
que les caractéristiques Widthet

Heightaient comme valeur 2. Po-
sitionnez le menu local Blending
sur Replace.
Pour les deux patchs Interpolation,
sélectionnez Predifined Interpo-
lation Curve dans la palette flot-
tante Inspector > Settings. Puis,
dans Input Parameters, vérifiez
que les menus locauxRepeat Mode
et Interpolation soient respecti-
vement positionnés sur Loop et
Linear . Attribuez au premier
patch Interpolation les valeurs
0,1 et 120, et les valeurs 0.25, –1.25
et 80 au second.
Enfin, sélectionnez le patch Image
Texturing Properties, et dans la
palette Inspector > Input Parame-
ters, entrez la valeur 0 dans le
champ Matrix Rotation. La suite,
c’est en page de droite…
nD.A.Mary
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� L’animation d’un élément d’une photo est un miracle
rendu possible grâce aux nouvelles technologies. Voici
comment y parvenir sans trop de difficultés…�
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Une composition au gré des flots

�Dans la barre d’outils de la fenêtre Editor, cliquez
sur le bouton Edit Parent. Toujours dans la barre 

d’outils, cliquez sur Patch Library, sélectionnez Image,
puis tapez la touche [Entrée] pour faire apparaître 
le patch dans la fenêtre de travail.

�En procédant comme à l’étape 1, ajoutez 
une nouvelle fois le patch Image, puis les patchs

Image Dimensions, Glass Distortion, Math, Billboard
et Sprite. Reliez les patchs Image et Billboard par 
leur connecteur Image.

�Sélectionnez le patch Image puis, dans la palette 
Inspector > Settings, importez la photographie 

d’origine (Import from file). Sélectionnez Billboard, toujours
dans Inspector > Settings. Tapez 2 dans le champ Width
et fixez Blending sur Replace.

�Reliez le second patch Image à Image Dimensions
par le biais du connecteur Image. Comme 

à l’étape précédente, importez dans le patch Image
la photo Eau.png préparée dans l’éditeur bitmap.

�Reliez le macro-patch Render in Image à Glass 
Distortion via les connecteurs Image et Texture.

Connectez Glass Distortion à Sprite par les connecteurs
Image et le second patch Image à Glass Distortion 
par leurs connecteurs Image respectifs.

�À intervalle régulier, dans la fenêtre Viewer,
cliquez successivement sur les boutons Stop et

Run afin de rafraîchir l’animation et éliminer certaines 
erreurs d’affichage parfois produites par le logiciel.

	Pour moduler l’intensité du mouvement de l’eau, 
les paramètres du patch Glass Distortion sont à

modifier à tâtons, en fonction de la taille de votre photo.
Center X et Y correspondent à la taille de la texture 
reproduisant les flots. Scale précise l’intensité de l’effet.

�Sélectionnez le patch Math, puis dans la palette 
Inspector > Input Parameters, choisissez le signe 

Division dans le menu local Operation #1. Tapez 2 dans
le champ Initial value. Reliez ensuite Image 
Dimensions au patch Math comme sur l’illustration.

�Reliez les patchs Math et Sprite via le connecteur
Height. Sélectionnez Sprite, et dans la palette 

Inspector > Input Parameters, entrez la valeur 2 dans 
le champ Width. Positionnez les menus locaux comme
montré dans la capture ci-dessus.

Les éléments de base de la composition ayant été assemblés, nous allons maintenant passer 
à la finalisation du trucage.
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L
a photo d’une pomme verte dans un dé-
cor en noir et blanc, le cliché en noir et
blanc d’un groupe de manifestants bran-
dissant des drapeaux rouges… Vous avez
sûrement déjà admiré ce genre de pho-

tos, et vous êtes demandé comment obtenir un
tel résultat. L’association du noir et blanc et de
la couleur produit un effet bluffant. Or, créer un
effet de ce genre n’est pas bien difficile…

DEUX EFFETS DE COLORATION
Il existe en fait deux types d’effets de coloration
sélective. Le premier affiche une portion du cliché
en couleur sur un arrière-plan en niveaux de gris.
Le second préserve une des couleurs primaires
de l’image dans un environnement en niveaux de
gris. Si le premier effet peut être appliqué à n’im-
porte quelle photographie composée d’un sujet
unique (une personne posant devant un paysage,
un fruit placé dans une assiette, etc.), en revanche,
pour obtenir un résultat vraiment intéressant

avec le second effet, le cliché
doit présenter des zones de
couleur assez concentrées (les
drapeaux, par exemple ).

LA TECHNIQUE CLÉ:
LA DÉSATURATION
À la base de ces deux effets, il
y a une seule et même tech-
nique, la désaturation. Elle
permet de supprimer la com-
posante couleur d’une image
tout en préservant ses niveaux
de gris. Dans le premier exem-
ple, on désatu re toute la zone
de l’image située autour du
fruit ; dans le second, on dés-
ature les
couleurs

primaires pour ne conserver
que le rouge.

AVEC LA GOMME
En pratique, il existe différen -
tes solutions pour produire
un même résultat : en tra-
vaillant avec l’outil Gomme,
en utilisant les calques de ré-
glages, ou en exploitant les
sélections. Voyons d’abord
la première solution… Après
avoir ouvert le cliché de dé-
part dans Photoshop Ele-
ments, affichez le panneau
Fenêtre > Calques et dupli-

quez le calque d’arrière-plan en le faisant glisser
sur l’icône Créer un calque, dans l’angle inférieur
gauche du panneau.
Le nouveau calque sélectionné, tapez [Maj Cmd U]
pour afficher son contenu en niveaux de gris. Acti -
vez l’outilGomme dans la barre d’outils, puis dans
la barre d’options située au-dessus de la fenêtre
de travail, choisissez Mode > Forme. Réglez l’opacité
autour de60%, sélectionnez une forme de brosse
au contour flouet réglez son diamètre en fonction
de la zone à retoucher. Dans la fenêtre du docu-
ment, appliquez la Gomme par petites touches:
l’outil supprime les pixels du calque en niveaux de
gris et fait apparaître le cliché en couleur du calque
d’arrière-plan. En page de droite, découvrez
comme travailler avec des calques de réglages.
nMathieu Lavant

1
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Photoshop Elements
La coloration sélective

� Pour mettre en valeur un 
cliché ordinaire, il existe une
multitude de solutions. 
Avez-vous essayé de mixer une
photo en couleur avec sa copie
en noir et blanc? L’opéra tion
produit un effet de coloration 
sélective souvent bluffant ! �

PHOTO024
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Une Chine toujours en rouge…

�Une fois la sélection terminée, affichez le panneau
Calques (menu Fenêtre), cliquez sur l’icône Créer un

calque de réglage située dans sa partie inférieure et 
choisissez Teinte/Saturation dans le menu local.

�Le calque de réglage étant sélectionné dans le 
panneau Calques, tapez [Cmd I] : le masque associé au

calque de réglage est inversé. À présent, les drapeaux 
apparaissent en couleurs dans un décor en niveaux de gris.

�Cliquez sur le masque du calque de réglage avec la
touche [Cmd] enfoncée, puis activez le calque Arrière-

plan : ce dernier affiche le contour de sélection. Inversez la 
sélection en tapant [Maj Cmd I] et créez un nouveau calque
de réglage Teinte/Saturation.

	Dans le panneau Réglages, ouvrez le menu local qui
affiche les gammes de couleur. Choisissez Jaunes et

ré glez la saturation à –100. Répétez l’opération pour toutes
les gammes de couleur à l’exception des Rouges: les étoiles
jaunes des drapeaux s’affichent en niveaux de gris.

�Le panneau Réglages s’affiche à l’écran avec les 
réglages Teinte/Saturation. Faites glisser le curseur

Saturation vers la gauche jusqu’à la valeur –100. Dans l’image
de travail, les drapeaux perdent leurs couleurs. C’est l’effet
contraire de celui que nous souhaitons produire!

�Le panneau Calques affiche à présent le calque de
régla ge au-dessus du calque Arrière-plan qui

contient l’ima ge de travail. Ce calque de réglage est constitué
de deux vignettes: à gauche le réglage, à droite le masque
issu de la sélection.

Dans ce second exemple plus détaillé, nous allons voir comment créer un effet de coloration 
sélective en exploitant un calque de réglage Teinte/Saturation.
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�Après avoir téléchargé le fichier drapeau.jpg depuis le
serveur de VVMac (www.vvmac.com, page Sommaire),

ouvrez-le dans Photoshop Elements. Activez ensuite l’outil 
Sélection rapide afin de sélectionner les drapeaux rouges
que brandissent les écoliers.

�Dans la barre d’options de l’outil, cliquez sur la 
vignette de la rubrique Forme et réglez son diamètre

à 80 pixels. Appliquez l’outil sur le fond d’un premier drapeau
en balayant la zone à sélectionner: un contour de sélection
apparaît autour du drapeau.

�Répétez l’opération de sélection sur les autres 
drapeaux. Si la zone de sélection s’étend au-delà du 

périmètre d’un drapeau, pressez la touche [Option] et cliquez
dans cette zone: la sélection est ramenée aux limites du 
drapeau.
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D
xO Optics s’emploie avec des fichiers
tirés de n’importe quel photoscope,
iPhone compris. Cela dit, il montre
l’étendue de son savoir-faire à partir
de fichiers Raw provenant d’appareils

de type bridge ou reflex. Pour dynamiser le rendu,
supprimer le bruit, optimiser la netteté, corriger
les aberrations et autres distorsions, il s’appuie
sur des profils de calibrage qui tiennent compte
des spécificités des boîtiers et des optiques.
Sans aller plus loin dans les détails techniques,
je vous propose de partir à la conquête de ce lo-
giciel. Vous pouvez vous faire la main avec une
version pleinement fonctionnelle valable 30 jours.
Notez que si DxO Optics Pro Édition Standard est
annoncé à un prix de 149€ (contre 49€ pour une
mise à jour), on le trouve aisément sur Internet
dans une fourchette allant de 99€ à 129€.

INSTALLATION DES PROFILS D’APN
Le téléchargement des mesures de calibrage a
été revu depuis la version 5 du logiciel. Il existe
désormais une procédure automatisée. Une fois
les photos importées, Optics Pro vous propose
les modules optiques dont vous avez besoin. Cela
étant dit, si vous souhaitez anticiper leur installa -
tion pour des raisons propres à vous, vous n’aurez
qu’à cliquer sur le bouton Télécharger des modules
optiques DxO situé dans l’écran d’accueil. Une
nouvelle fenêtre apparaîtra dans laquelle vous
choisirez les éléments qui vous seront nécessaires.
Le classement des modules est réalisé de la ma-
nière suivante: la marque de l’APN > le modèle
+ l’optique associée. Exemple: Canon > Canon
EOS 7D + Sigma 17-70mm ƒ/2.8-4.5 DC Macro.

D’IPHOTO À OPTICS PRO: UNE PARFAITE
COMPLÉMENTARITÉ
Couplé à iPhoto ’09 (pour le catalogage), l’ensem -
ble peut s’avérer fort attrayant pour qui n’a pas
vraiment besoin des fonctions de retouche avan-
cée d’Aperture 3 ou de Lightroom. Pour transférer
les photos (Raw comme JPeg) d’une application
à l’autre, voici la méthode à suivre… Dans les pré-
férences Généralesd’iPhoto ’09, positionnez le

menu local Modifier la photo sur Dans l’applica -
tionet sélectionnez DxO Optics Pro. Dans l’onglet
Avancées des préférences d’iPhoto ’09, cochez
la case Utiliser RAW en cas d’utilisation d’un édi-
teur externe. Pour envoyer une image vers DxO
Optics, vous n’aurez plus qu’à cliquer sur le bouton
Édition de la barre d’outils d’iPhoto ’09.

Pour faciliter la réimportation des clichés traités
dans iPhoto, ouvrez sur le Bureau le dossier Images
de votre compte utilisateur, faites un clic-droit
sur le fichier iPhoto Library, puis demandez Affi -
cher le contenu du paquet.
De retour dans Optics Pro, cliquez sur le bouton
Traiter . Dans la colonne latérale gauche, ajus-
tez la qualité JPeg sur 100% à l’aide de la réglette
idoine. Positionnez le menu local Dossiersur Choi -
sir et, depuis le dialogue, glissez le dossier Auto
Import contenu dans la fenêtre iPhoto Library.
Cliquez sur Ouvrirpour parachever les opérations.

DÉVELOPPEMENT SANS EFFORT
Une fois les photographies importées dans Optics
Pro, cliquez tout d’abord sur le bouton Person-
naliser . Déroulez le menu localAutoréglage

afin d’accéder à l’ensemble des préréglages
disponibles. Pour la quasi-totalité des appareils
photo numériques du marché, je vous conseille
l’emploi du preset DxO par défaut v2.
Utilisateur d’un Canon de la série 450D à 550D?
Recourez plutôt au preset DxO par défaut v2 -
Couleurs Neutres. Cliquez ensuite sur le bouton

Traiter qui se trouve simplement dans la barre
d’outils. Enfin, il faudra encore appuyer sur le
bouton Traiter le projet (dans le coin en haut à
droite de l’interface de DxO Optics).
Comme vous pouvez le constater après quelques
minutes d’usage, le traitement photo avec ce lo-
giciel spécialisé et professionnel reste à la portée
de tout utilisateur photographe!

QUEL FORMAT RAW EMPLOYER?
Pour vous assurer une totale compatibilité avec
Optics Pro, si vous recourez au format brut de
capteur (notamment dans le cas du Canon 7D),
évitez les formats S-RAW ou M-RAW. Ne travaillez
qu’avec celui qui offre la plus grande largeur
d’image et qui se nomme RAW, tout simplement.
n D.A.Mary
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� Tel le roi Midas, DxO Optics
transfigure tout ce qu’il touche.
Grâce à lui, tous vos clichés 
retrouveront éclat et netteté sans
grandes manipulations.�

� DXO OPTICS PRO 6.2 DE DXO OPTICS, 149€ (www.dxo.com/fr/photo/free_trial_version)

DxO Optics Pro 6.2
Sublimez vos photos!

PHOTO026
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Des ajustements optiques à la carte

�Passons au réglage manuel des aberrations géomé-
triques. Dans le module Géométrie > Distorsion, le

choix du type de correction (en barillet, en coussinet 
ou FishEye) s’effectue depuis le menu local correspondant.
Ajustez ensuite l’intensité de l’effet avec la réglette.

�En bas à droite du module Perspective/horizon, 
cliquez sur le bouton + pour révéler un nouveau jeu de

réglages. La compensation horizontale et verticale de 
la perspective s’effectue à l’aide des réglettes Haut/Bas 
et Gauche/Droite.

�Avant de corriger manuellement les franges colorées,
agrandissez la fenêtre de prévisualisation sur une 

valeur comprise entre 100% et 125%. 
Rendez-vous dans le module Détails - Les essentiels > 
Aberrations chromatiques.

	Deux réglettes sont ici à votre disposition: Intensité
qui contrôle la puissance de l’effet, et Taille qui ajuste

la largeur des franges colorées. N’oubliez pas de cocher la
case Franges violettes. Il ne vous reste plus qu’à traiter 
par lot vos clichés.

�Pour redresser la perspective d’une photographie prise
avec un objectif grand-angle, explorez le module 

Géométrie - Les essentiels > Perspective/horizon. 
Cliquez sur le bouton destiné à forcer les parallèles.

�Dans la fenêtre de prévisualisation, dirigez votre
pointeur vers la vignette de gauche. À l’aide de votre

souris, tracez deux lignes droites aux endroits de la photo que
vous savez parallèles.

Que votre matériel photographique soit reconnu ou non par l’application, DxO Optics Pro 6 
autorise un grand nombre de réglages manuels.
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�Un traitement soigné impose un travail attentif image
par image. Sélectionnez une première photographie en

bas de l’écran, puis appuyez sur le bouton Personnaliser
placé en haut à gauche de l’interface.

�Dans le menu local Espace de travail, on accède à de
nouvelles fonctions classées en trois niveaux: 

débutant: (DxO First Steps), avancé (DxO Essentials) et 
expert (DxO Advanced User). Nous utiliserons ici Essentials.

�La colonne de droite affiche les réglages actifs par 
défaut. Seuls quelques-uns ont un effet immédiat sur

les images provenant de boîtiers et optiques non reconnues
par le logiciel (Compensation de l’exposition, Vignetage et
DxO Lightning).
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P
our sublimer un portrait
féminin , il existe dif-
férentes techniques. Celle
que nous allons aborder
s’articule autour de cinq

axes de travail : mettre en valeur les
yeux, effacer les imperfections (rou-
geurs, boutons, grains de beauté,
etc.), atténuer les cernes, adoucir la
peau, et enfin accentuer le contour
des lèvres, des yeux et des sourcils.
Naturellement, il existe des logiciels
spécialisés dans ce type de traite-
ments, mais ils sont systématique-
ment forts coûteux. Toute la difficul -
té consiste ici à procéder aux diffé-
rents traitements avec les seules res-
sources de Pixelmator.

À LA PRISE DE VUE
Il est plus facile de procéder à une
retouche si le visage est baigné par
une lumière uniforme. Comme il y a
peu de chance que vous recourriez
à du matériel sophistiqué, à chaque
fois que possible, photographiez en
extérieur. Mieux encore, forcez l’uti-
lisation de votre flash escamotable
(réduisez au passage sa puissance
de 2 à 3 IL) et profitez-en pour sélec -
tionner le mode synchro au second
rideau (ou rear sync).
Éventuellement, coiffez le flash d’un
diffuseur comme le Soft Screen de
Lumiquest (15€ environ), voire

le modèle SoftBox si vous possédez
un flash cobra. Si vous ne disposez
pas dans votre photothèque d’un
portrait idoine, je vous propose en
remplacement un cliché provenant
de la banque d’images gratuites
Stock.xchg (www.sxc.hu/browse.phtml?f
=view&id=932746).

DEUX OUTILS SINON RIEN
L’image ouverte dans Pixelmator, le
travail de retouche va faire appel de
manière intensive aux calques, aux
modes de fusion (éclaircir, écran, lu-
minosité…), ainsi qu’aux masques
de fusion (afin de retoucher sans dé-
truire le calque original). Nous re-
courrons également aux seuls outils
pinceau et tampon pour procéder
aux différentes retouches. Pour ajus-
ter la taille des outils, rendez-vous

dans la palette Forme (si cette der-
nière n’est pas présente à l’écran,
demandez Affichage > Afficher les
formes). Nous choisirons par défaut
une forme de taille 30. Pour affiner
ses caractéristiques, il suffira par la
suite de double-cliquer sur son icône:
dans la fenêtre surgissante, vous
pourrez alors modifier sa taille avec
précision (réglette Diamètre ).
Enfin, nous aurons besoin également
de la palette Options d’outils (dé-
roulez le menu Affichage pour la faire
apparaître le cas échéant).

ILLUMINEZ LE REGARD
Passons à présent aux «choses sé-
rieuses». Les trois prochaines opé-
rations se déroulent exclusivement
dans la palette Calques. Commencez
par dupliquer le calque de base (clic-

droit ou [Ctrl clic] puis, dans le menu
contextuel demandez Dupliquer).
Déroulez ensuite le menu local Mé-
langeet demandez Écran. D’un clic-
droit sur le nouveau calque, deman-
dezAjouter un masque. Ce dernier
créé, faites le raccourci [Cmd I]. Le
masque de fusion devient noir. Nous
pouvons dès lors retoucher les yeux.
Pour ce faire, sélectionnez la teinte
blanche dans la palette Nuancier.
Puis, à l’aide de l’outil Pinceau (réglé

en taille 30), peignez les yeux. Ceux-
ci vont être alors beaucoup plus lu-
mineux. Hélas, le résultat en l’état
demeure peu naturel, j’en conviens.
Pour que tout rentre dans l’ordre, il
suffit d’ajuster l’opacité du calque
courant autour de 40%.
Quelques astuces sont à noter au
passage: pour zoomer ou dézoomer
sur l’image, utilisez les raccourcis
clavier [Cmd +] ou [Cmd –]. Pour cor-
riger les erreurs de retouche, sélec-
tionnez une teinte noire dans le Nuan -
cier, puis peignez les zones concernées.
Cette étape préliminaire accomplie,
faites un clic-droit sur le calque cou-
rant, puis demandez Fusionner tous
les calques.
Vous pouvez passer à présent au pas
à pas de la page de droite pour pro-
céder aux retouches les plus lourdes.
nD.A.Mary
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� La photo de mode expliquée à ma fille, tel pourrait être le sous-titre de ce pratique express. 
L’absence d’imperfections des top-modèles a de quoi laisser pantois, et pour cause ! Dans l’espace
médiatique, tout se fabrique, y compris la beauté. �

Pixelmator
Quelques secrets 
de la retouche de portraits

PHOTO028
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Des calques très esthétiques

�Maintenez la touche [Alt] enfoncée tout en cliquant sur
la pommette située à gauche de l’écran, puis peignez les

cernes de l’œil droit du modèle par petites touches. 
Recommencez ces deux opérations autant de fois que 
nécessaire, puis passez à l’autre œil.

�Dupliquez le calque, puis choisissez l’outil Goutte d’eau
(en taille 50). Dans la palette Options d’outils, ajustez

l’intensité sur 100%. Peignez tout le visage à l’exception des
yeux, des lèvres et de la base du nez. Cliquez avec la pipette 
sur la joue gauche du modèle.

�Sélectionnez l’outil Pinceau en taille 50. Ajustez dans
la palette Options d’outils l’opacité sur 42% et 

positionnez le Mélange sur Teinte. Peignez à nouveau le visage
comme précédemment. Réglez l’opacité sur 15% et le 
Mélange sur Luminosité. Peignez une dernière fois le visage.

�Dans la palette Calque, réglez le Mélange du calque
courant sur Écran et diminuez son opacité autour de

50%. Fusionnez les calques, puis dupliquez le calque. 
Demandez le menu Filtres > Renforcement > Renforcer la 
luminance. Ajustez la réglette Netteté à 40.

�Faites un clic-droit sur le calque courant, puis demandez
Ajouter un masque. Appliquez le raccourci clavier 

[Cmd I]. Munissez-vous de l’outil Pinceau, sélectionnez une
teinte blanche dans le nuancier. Dans les options d’outils, 
l’Opacité est à 100% avec un Mélange Normal.

	Peignez maintenant les cheveux, les yeux, les sourcils 
et les lèvres. Réglez l’opacité du calque courant sur

75%. Fusionnez tous les calques. Demandez Image > 
Luminosité et Contraste. Optez respectivement pour les 
valeurs -5 et +5.

En exploitant au mieux les ressources de Pixelmator, vous pouvez parvenir à un résultat convaincant.
Les seuls mots d’ordre sont ici minutie et patience !
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�Pour éliminer les petits boutons et autres imperfections
cutanées (sur la zone du front, des pommettes et du

menton), sélectionnez l’outil Tampon. Ajustez si nécessaire 
sa taille à 30 (depuis la palette Formes).

�Touche [Alt] enfoncée, cliquez non loin de la zone 
à corriger. Relâchez la touche du clavier, puis cliquez

précisément à l’endroit où la retouche doit être effectuée. 
Recommencez cette étape autant de fois que nécessaire.

�Pour les cernes du sujet, toujours avec l’outil Tampon,
déroulez dans la palette Options d’outils, le menu local

Mélange > Éclaircir. Profitez-en pour ajuster la réglette 
Opacité entre 15% et 30% selon les zones à corriger.
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P
remier gros changement,
Photoshop Elements 9
Mac abandonne le navi-
gateur Bridge au profit
du catalogueur de la ver -

sion Windows. Il faudra vous adap-
ter ou bien conserver le bon vieux
Bridge livré avec les versions précé -
dentes. Mais après tout, est-il vrai-
ment nécessaire de passer à Pho-
toshop Elements 9?
Absolument! Oui. Parce que l’appli-
cation apporte de véritables nou-
velles fonctions pour chaque type
d’utilisateurs. Pour les novices, PSE
étoffe son panneau Édition guidée,
véritable bibliothèque de pas à pas
illustrés. L’application propose éga-
lement de nouveaux effets (Pop Art,
Reflet…) et des outils inédits de créa-
tion: Calendriers, Collage photo…
Pour les utilisateurs plus expérimen-
tés, à deux doigts de passer à Pho-
toshop, Elements 9, qui intègre le
moteur de Photoshop CS5 – quelque
peu bridé, bien sûr – offre le nouvel
outil Correcteur localiséet la fonction

de masque de fusionqui simplifie à
l’extrême la création de photomon-
tage. Idem, un mode Expertqui dé-
voile par le menu les secrets des pas
à pas du mode Édition guidée.
Enfin, pour ceux qui s’intéressent à la
gestion de leur photothèque et au
partage de photos, l’Organiseur per-
met d’accéder directement aux fonc-
tions de partage et de création, et
remplacera pour certains avantageu -
sement iPhoto.

CLASSEZ ET PARTAGEZ
Avant l’apparition de Photoshop Ele-
ments 9, il y avait d’un côté iPhoto
et son catalogueur, et de l’autre Pho-
toshop Elements et son Bridge. Au-
jourd’hui, avec Photoshop Organi-
seur, plus question de parcourir vos
collections de photos comme vous
le faisiez avec Bridge, vous devrez
d’abord les importer.
Il gère également les vidéos et les fi-
chiers au format PDF – mais oui,
Adobe sort également Premiere Ele-
ments 9 pour Mac! Ce dernier est

vendu séparément ou dans la même
boîte. J’aimais bien Bridge, plus ou-
vert, mais l’Organiseur a également
ses avantages. À partir de ce dernier,
vous avez en effet un accès direct aux
fonctions Retoucher, Créer et Par -
tager, qui auparavant n’étaient ac-
cessibles que depuis l’éditeur.
Vous pourrez ainsi lancer la création
d’un album suite à une sélection de
clichés, ou même effectuer des cor-
rections rapides sur des photos, sans
même passer dans Photoshop Ele-
ments. De plus, Photoshop Organi-
seur intègre la reconnaissance de
visages et des fonctions de partage
via Facebook, Flickr ou Kodak Easy -
share – il ne lui manque plus que la
fonction de localisation…
Entre Photoshop Elements 9, iPhoto,
Picasa et GraphicConverter 7 (dont
je reparlerai), l’utilisateur de Mac ne
manque plus de choix!

UNE FONCTION TRÈS ATTENDUE
Côté photomontage, Photoshop Ele-
ments 9 introduit enfin les masques
de fusion qui devraient réjouir les
utilisateurs expérimentés et même
les débutants. Grâce à cette fonction,
la découpe d’une image à partir d’une
sélection s’effectue très simplement:
vous tracez une sélection de forme
quelconque, puis vous activez la com -
mande Créer un masque de fusion.

Il ne faudrait pas oublier les différents
effets et formes dynamiques qui
viennent enrichir les possibilités de
création. Les premiers sont accessi-
bles sous forme d’actions guidées à
partir du panneau Édition guidée ;
vous y trouverez les effets Reflets,
Lomo, Pop Art, mais aussi Concordan -
ce de style Photomerge.
Les seconds sont accessibles à partir
de la barre d’options de l’outil Forme
dynamique, lorsque ce dernier est
activé. Avec cette débauche d’effets
de toutes sortes, il devient difficile
de s’y retrouver. Outre ceux déjà ci-
tés, il existe toujours les filtres du
menu Filtrequi sont également pré-
sents dans le panneau Effets, sans
parler des commandes Photomerge
dans le panneau guidée, mais aussi
dans le sous-menu Fichier > Nou-
veau… D’autres options encore ne
sont accessibles qu’en mode Édition
Guidée.
Enfin, si Photoshop Elements 9 est un
grand cru, il faut tout de même noter
que l’application n’a pas été réécrite
pour Snow Leopard (contrairement
à Photoshop CS5). Et si certaines opé -
rations sont instantanées, d’autres
s’avèrent particulièrement lentes,
telle la mise en œuvre de Concor-
dance des styles, même sur un Mac-
Book Pro de dernière génération!
nMathieu Lavant

� Moins d’un an après sa sortie en version 8,
Photo shop Elements revient tout habillé de 9,
avec un plein de nouvelles fonctions qui 
intéresseront tout autant les débutants que les 
utilisateurs plus experts. Découverte en images. �

Photoshop Elements 9
Une mise en œuvre simple
de fonctions presque «pro»!

PHOTO030
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L’interface de l’Organiseur s’affiche à l’écran, avec dans 
sa partie droite les panneaux Albums et Étiquettes de 
mots-clés, ainsi que les onglets Organiser et Retoucher dans 
lesquels vous effec tuerez de nombreuses tâches sur une 
sélection d’une ou de plusieurs photographies.

Si vous décidez d’adopter Organizer comme catalogueur, il va
falloir dans un premier temps importer vos dossiers de photos
(et de vidéos). Faites Fichier > Obtenir des photos et des 
vidéos et choisissez À partir de dossiers… ou bien À partir
d’iPhoto… si vous utilisiez jusqu’alors l’application d’Apple.

Dans le dialogue qui s’affiche, sélectionnez un dossier de 
photos et validez. Elements Organizer importe alors les clichés
et les affiche sous forme de vignettes dans le panneau principal
de l’application, d’où vous pourrez les taguer et les trier 
comme vous le faisiez avec Bridge.

Elements Organizer, qui est une application autonome, intègre
une fonction de reconnaissance des visages accessible 
à partir du panneau Étiquettes de mots-clés. Lancez la 
reconnaissance de personnes en cliquant sur son icône. 
L’application analyse les fichiers importés, puis affiche 
un panneau de résultats.

Saisissez maintenant le nom des personnes que vous 
connaissez en cliquant sur la légende Qui est-ce? située 
sous chaque vignette. Cliquez ensuite sur Enregistrer. 
Le panneau affiche alors le premier visage identifié et les 
clichés dans lesquels Elements Organizer l’a repéré.

031

Quelques nouvelles fonctions de PSE 9 en images

Supprimez les clichés qui ne correspondent pas au visage 
identifié à l’aide des articles du menu contextuel, puis cliquez
sur Terminer. Le panneau affiche une seconde série de clichés
associés au second visage que vous avez identifié, ou d’autres
visages non identifiés. Répétez les opérations précédentes.

Revenez dans l’interface principale et sélectionnez une série 
de clichés pour construire un photomontage. Cliquez sur l’onglet
Créer dans la partie droite de la fenêtre, puis choisissez 
Collage photo dans le panneau qui apparaît dans la partie
droite de l’écran.

Photoshop Elements se lance automatiquement et affiche le
dialogue Collage photo. Sélectionnez une taille de document 
et un thème, puis validez. L’application mouline quelques 
dizaines de secondes et affiche le résultat final que 
vous pouvez ensuite modifier manuellement.

Dans les prochains numéros, j’aurai l’occasion de revenir sur certaines nouveautés de Photoshop
Elements 9 et de son Organiseur. Mais sans plus attendre, je vous propose un parcours de découverte
qui vous donnera un aperçu pratique de quelques nouvelles fonctions.

Vous avez installé Photoshop Elements 9 et lancé l’application:
un nouveau panneau d’accueil vous propose de choisir entre
deux activités, Organiser et Modifier. Choisissez la première
pour afficher le nouvel Organiseur, ou la seconde pour 
démarrer l’éditeur bitmap. Pour ce petit tour du propriétaire,
cliquons maintenant sur Organiser.
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Revenez dans l’Organiseur en cliquant sur son icône en haut à
droite de l’écran. Sélectionnez une photo que vous souhaitez
corriger dans Photoshop Elements, puis activez l’onglet 
Retoucher dans la partie droite de l’écran: le panneau affiche
les commandes de corrections automatiques.

Cliquez ensuite sur la flèche située à droite de l’onglet 
Retoucher, et dans le menu local qui apparaît, choisissez 
Retouche photo standard… La photo sélectionnée s’affiche
dans l’interface de Photoshop Elements. S’il s’agit d’un 
fichier Raw, il s’ouvrira d’abord dans l’interface de Camera Raw.

À présent, nous allons expérimenter les masques de fusion.
Double-cliquez sur la vignette du calque dans le panneau
Calques et validez le dialogue Nouveau calque avec 
ses réglages par défaut. Le calque d’arrière-plan est 
transformé en véritable calque. Activez l’outil Ellipse dans 
la barre d’outils.

Cliquez-glissez pour définir une sélection ovale, puis demandez
Calque > Masque de fusion > Faire apparaître la sélection.
Ou bien, cliquez sur l’icône Ajouter un masque de fusion
dans la par tie inférieure du panneau Calques.

Le masque de fusion est créé et masque la partie de l’image 
située en dehors de la sélection. Dans le panneau Calques,
la vignette du masque de fusion apparaît à droite de la vignette
du calque. Vous pouvez désactiver le masque en cliquant 
sur sa vignette avec la touche [Maj] enfoncée.

Revenez dans l’Organiseur, choisissez une autre photo à 
retoucher et ouvrez-la dans Photoshop Elements.
Vous allez exploiter le nouvel outil Correcteur localisé pour
supprimer un élément indésirable de l’image – ici le bras d’un
personnage hors-champ. Activez l’outil dans la barre d’outils.

Dans la barre d’option de l’outil, réglez le diamètre de la brosse,
puis activez l’option Contenu pris en compte. Appliquez 
ensuite l’outil sur toute la portion d’image à supprimer. 
Photoshop Elements mouline quelques instants et affiche
l’image corrigée.

Revenez une fois de plus dans l’Organiseur pour tester les 
nouveaux effets. Sélectionnez une photo quelconque, puis 
rouvrez le menu local de l’onglet Retoucher et 
choisissez Retouche guidée. Le cliché s’ouvre alors dans 
Photoshop Elements en mode Édition guidée.

Vous êtes satisfait de votre création? Vous disposez des 
boutons Terminer et Imprimer en bas à droite de l’écran. 
Le premier bouton affiche un dialogue d’enregistrement; 
le second, la nouvelle boîte de dialogue d’impression (ci-dessus)
à partir de laquelle vous pouvez imprimer directement 
le photomontage.
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Cliquez enfin sur le bouton Dupliquer l’image. La création 
de l’effet est achevée. Cliquez sur le bouton Terminer
en bas du panneau de réglage pour revenir au panneau Guidée
à partir duquel vous pourrez appliquer d’autres effets. Autre
possibilité, cliquez sur le bouton Annuler pour revenir 
à l’image de départ.

À présent, vous allez modifier l’ambiance d’un cliché en 
exploitant la nouvelle fonction Concordance de style. 
Sélectionnez une nouvelle photo dans l’Organiseur, faites
Fichier > Nouveau et choisis sez Concord. Style Photomerge :
Photoshop Elements ouvre l’interface de la nouvelle commande.

Choisissez une image dans le panneau Corbeille de styles
situé en bas de l’écran et faites-la glisser dans la partie gauche
de l’interface. Le «style» de l’image est appliqué à votre 
cliché. Testez les différentes images disponibles 
dans la Corbeille des styles, ou bien chargez l’une de vos 
photos à l’aide du bouton +.

Si vous souhaitez exploiter les tons de l’image de style, cochez
l’option Transférer les tons dans le panneau de réglage. Puis
ajustez éventuellement l’intensité du style et les autres 
paramè tres de la commande via les curseurs du panneau 
de réglage. Validez votre création à l’aide du bouton Terminer.

Enfin, si vous souhaitez partager vos créations sur le Web, 
l’Organiseur vous permet de publier directement celles-ci sur
des comptes Facebook, Flickr ou Kodak Easyshare. Pour ce faire,
activez l’onglet Partager dans la partie droite de l’Organiseur.

Sélectionnez les clichés que vous souhaitez publier, puis cliquez
sur la commande Partager sur Facebook. Un premier dialogue
vous demande d’autoriser la publication des clichés, puis votre
navigateur démarre en affichant la page de connexion 
Facebook.

Connectez-vous à votre compte Facebook. Lors de la première
publication, un dialogue vous demande une nouvelle fois 
d’autoriser Photoshop Elements et Premiere Elements 
à accéder à votre compte. Cliquez sur Autoriser, puis revenez
dans l’Organiseur.

Un dialogue vous informe que le processus d’autorisation est
terminé. Cliquez sur le bouton Autorisation complète pour
lancer le téléchargement. Dans le dialogue qui suit, choisissez
l’album de destination, puis cliquez enfin sur le bouton 
Télécharger.

Dans le panneau droit qui liste les effets, descendez jusqu’à la
rubrique Modifications amusantes et choisissez Pop Art.
Le panneau affiche les étapes de création de l’effet Pop Art.
Choisissez un style de rendu, cliquez sur le bouton Convertir 
le mode d’image, puis sur le bouton Ajouter une couleur.
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P
our bien aborder iMo -
vie, il faut surtout se rep-
peler qu’il se destine à
un usage familial, pour
un public n’ayant que

peu, voire aucune connaissance
des techniques de montage. 
Au fil des mois, je vous ai montré
comment vous affranchir des li-
mites du logiciel pour produire des
effets ou des utilisations inédites.
Cette fois, nous allons nous
concentrer sur ses aspects essen-
tiels sous la forme de questions/ré-
ponses.

LA BIBLIOTHÈQUE
�Comment importer une vidéo
provenant d’un caméscope?
Fichier > Importer depuis la caméra.

�Quels sont les formats
reconnus directement par
iMovie?
S’il sait théoriquement recon-
naître n’importe quel clip vidéo
au format QuickTime et l’im-
porter dans la vidéothèque, il
n’est en réalité à l’aise qu’avec
le DV, le MPeg-4 H.264, l’Apple
Intermediate Codec, le codec
Animation ainsi que le tout nou-
veau format iFrame.

�Peut-on utiliser Perian
pour augmenter le nombre de
formats reconnus?
Théoriquement, oui. Mais dans la

pratique, un «bogue» gênant em-
pêche la prise en charge des vidéos
WMV, XVid ou MKV dans iMovie
8.0.5. L’erreur se produit au moment
de la création des vignettes de pré-
visualisation et du document .plist
qui lui est associé. Il est obligatoire
de réencoder ce type de films avant
de procéder à leur importation.

�Comment importer les vidéos
provenant d’un caméscope 

à carte mémoire?
La connexion physique du camé-
scope au Mac est obligatoire: la fe-
nêtre d’importation apparaît alors,
vous permettant de choisir les clips
à importer. En revanche, si les fichiers
bruts (MTS, M2TS ou autres) ont di-
rectement été transférés sur votre

disque dur sans passer par iMovie,
l’application sera alors incapable de
les prendre en charge. Vous n’aurez
alors pas d’autre choix que d’encoder
les rushes (en Codec Intermediate
de préférence) à l’aide d’un utilitaire
comme VoltaicHD.

LA GESTION D’UN PROJET
�Quels sont les réglages 
préliminaires à effectuer?

Au premier lancement, iMovie ne
vous propose qu’une version sim-
plifiée du programme. Dans les pré-
férences de l’application, panneaux
Générales et Navigateur, veillez
à ce que toutes les cases soient co-
chées. Dans le panneau de préfé-
rences Vidéo, demandez PAL à 25
ips comme standard de montage
(valable pour tous les caméscopes
achetés en Europe).

�Comment monter mon premier
projet vidéo?
Commencez par créer un nouveau
projet (menu Fichier). Dans la fenêtre
surgissante , choisissez le format
d’écran (16:9 ou 4:3) et un thème
de présentation le cas échéant.
Après avoir cliqué sur le bou-ton

Créer, il ne vous reste
plus qu’à glisser dans
la fenêtre de projet
(en haut à gauche) les
clips vidéo prélevés au
sein de la bibliothèque
(en bas à droite de la
fenêtre).

�Comment modifier
les réglages du projet
en cours?
Très simplement, de-
mandezProjet > Pro-
priété du projet.

LES EFFETS VISUELS
�Où se cachent les effets
spéciaux et comment les utiliser?
Les effets spéciaux (noir et blanc, sé-
pia, rayon x…) sont à dénicher dans
la palette Inspecteur > Plan. Pour les
utiliser, commencez tout d’abord
par sélectionner un clip dans la fe-
nêtre de projet. Appuyez ensuite sur
le bouton [i] dans la barre d’outils

pour faire apparaître l’Inspecteur.
Enfin, au sein de la section Plan, ap-
puyez sur le bouton en regard de
l’intitulé Effet vidéo . Il ne vous
reste plus qu’à choisir l’effet dans le
panneau proposé.

�Comment accéder aux effets de
transitions et titrages?
Repérez les trois derniers boutons

à la droite de la barre d’outils.
Ils sont respectivement dévolus aux
titrages, aux volets de transitions et
à la création de fonds de cartes et
d’arrière-plans animés.

�Comment appliquer un titrage
ou une transition?
Le principe est proche dans les deux
cas. Une fois un titrage choisi dans
la colonne située en bas à droite de
l’interface, glissez et déposez-le sur
la vignette du clip. Pour une transi-
tion, glissez et déposez-la entre deux
clips consécutifsaffichés dans la fe-
nêtre de projet. nD.A. Mary
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Zoom sur des fonctions clés 
d’iMovie
� iMovie déroute toujours nombre d’utilisateurs. Pour les réconcilier avec 
ce logiciel, je vous propose de le redécouvrir sous un angle pratique. �
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Éditez vos séquences avec précision

�Pour scinder un plan en deux, placez votre curseur à
l’endroit voulu du clip vidéo, puis faites un clic-droit

et demandez Scinder le plan dans le menu déroulant.

�Pour élaguer à la volée le début ou la fin d’un plan
et ajuster les transitions « cut », cliquez sur le 

bouton à deux flèches dans le coin inférieur du clip. 
Déplacez le bord de la vignette (de couleur orange).

�Pour élaguer un plan plus précisément, sélection-
nez le clip et faites Fenêtre > Élagueur de plans.

Ajustez comme bon vous semble les points d’entrée et 
de sortie de la séquence avec les poignées jaunes.

�Pour un travail plus précis, faites appel à l’éditeur
de précision (menu Fenêtre). Un banc de montage

« traditionnel » apparaît alors en bas de la fenêtre.

�Pour rendre muet un clip ou un ensemble 
de clips situés dans la fenêtre de projet, demandez

le menu Édition > Couper le son des plans.

�Pour extraire la piste son d’une vidéo, faites Édition
> Détacher l’audio. Vous pouvez manipuler la piste

audio indépendamment de la vidéo et utiliser la bande-son
à un autre endroit du montage.

	Pour modifier le volume sonore d’une vidéo, ouvrez
l’Inspecteur, puis cliquez sur Audio. Vous pouvez

ajuster la durée des fondus en entrée et sortie de plan.
Pour augmenter à son volume maximal l’audio contenu
dans un clip, appuyez sur le bouton Normaliser.

�Pour naviguer d’une transition à une autre, appuyez
sur l’un des points placés sur la barre horizontale.

Vous pouvez alors déplacer les clips dans la chronologie
pour ajuster les raccords, et même dimensionner à la 
volée la durée des volets de transitions.

�Pour appliquer un ensemble de réglages (effets, 
rognage…) d’un clip à l’autre, sélectionnez la vidéo

servant de modèle, puis faite Édition > Copier. 
Cliquez ensuite sur la vidéo qui doit être modifiée 
et demandez Édition > Coller les ajustements > Tous.

La dernière version d’iMovie propose des outils d’édition avancés dans les domaines de la vidéo 
et de l’audio. Petit florilège des fonctions incontournables.
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� Le iMovie actuel, celui qui prit la succession d’iMovie 6HD, est
doté d’un gestionnaire de médias plutôt performant, et fidèle 
à l’esprit du catalogueur iPhoto.�

B
ien que ça n’apparaisse pas de ma-
nière formelle, iMovie ’09 est pourvu
de quatre modules principaux. Les
deux premiers regroupent toutes les
options liées au montage et à la ges-

tion des projets de travail. Le troisième est dé-
volu aux effets visuels ou sonores, titrages, tru-
cages et transition. Enfin, le quatrième s’oc-
cupe de la gestion des vidéos.

LA BIBLIOTHÈQUE D’ÉVÉNEMENTS
La vidéothèque d’iMovie, appelée aussi Biblio-
thèque d’événements, organise les séquences
vidéo à l’intérieur d’albums qui se nomment Évé-
nements, semblables en tout point aux Événe-
ments d’iPhoto. Tout commence, donc, au mo-
ment de l’acquisition des plans bruts (rushes)
depuis votre caméscope. Dans la fenêtre d’im-
portation, vous pouvez créer un nouvel événe-

ment ou en choisir un déjà présent dans la
vidéothèque. Laissez cocher la case située des-
sous : si le caméscope contient des clips tournés
à des dates différentes, iMovie créera de façon
autonome autant d’événements supplémen-
taires. De plus, si vous disposez de plusieurs
disques durs, vous importerez directement les
clips sur le disque de votre choix.

ORDRE CHRONOLOGIQUE
Dans la vidéothèque, les événe-
ments se classent automatique-
ment par année , puis par
date d’acquisition ou de tour-
nage. Faites un clic-droit dans la
colonne Bibliothèque d’événe-
mentspour affiner leur affichage
en fonction du mois ou du jour,
ou pour demander que le clas-
sement se fasse par ordre chro-

nologique inverse. Par défaut, iMovie affiche
l’ensemble des événements stockés sur plu-
sieurs disques durs sous la forme d’une vidéo-
thèque cohérente et unique. 
Vous pouvez tout autant demander à classer les
événements en fonction du support sur lequel
ils sont enregistrés, en cliquant sur l’icône du
disque dur .

MANIPULATIONS DIVERSES
�Fusion : selon le mode opératoire d’iPhoto,
plusieurs événements peuvent être fusionnés :
maintenez la touche [cmd] enfoncée pendant
la sélection, puis demandez Fichier > Fusionner
les événements. Dans le dialogue qui surgit, nom-
mez le nouvel événement. 
Vous pouvez fusionner plusieurs événements
stockés sur différents disques durs, selon la même
méthode, mais le dialogue vous  demandera de
préciser sur quel volume devra être créé le nou-
vel événement. 

�Scission : à l’inverse, pour couper un événe-
ment en deux, sélectionnez  le clip par lequel dé-
butera le second événement, puis demandez
Fichier > Scinder l’événement avant le plan sé-
lectionné.

�Déplacement : si votre mode de classement
regroupe les événements par disque, vous pou-
vez sans mal déplacer un ou plusieurs événe-
ments d’un support à un autre, par simple glis-
ser-déposer sur le nom du volume en question
(pour de plus amples détails, reportez-vous à la
boîte à outils parue dans VVMac n° 45).

�Renommer ou supprimer : en double-cliquant
sur l’intitulé d’un événement, vous pouvez chan-
ger son nom. 
Pour supprimer un événement ainsi que toutes
les vidéos qu’il contient, demandezFichier > Pla-
cer l’événement dans la corbeille.

TRIS SÉLECTIFS
Juste après importation, c’est une bonne idée
d’effectuer un premier tri des séquences à conser-
ver et des séquences à jeter. Plusieurs outils vous
aident dans cette tâche.

�Pour rejeter un clip : dans un événement, sé-
lectionnez le clip que vous jugez inutile, puis ap-
puyez sur la touche [R] du clavier ou sur l’outil
en forme de croix .

�Pour marquer les clips favoris : utilisez la touche
[F] du clavier ou bien l’outil en forme d’étoile
noire . Comme pour l’opération précédente,
la sélection peut s’effectuer sur une portion ou
sur la totalité d’un clip.

�Pour démarquer un clip : afin de retirer toute
marque (favori ou rejet), tapez la touche [U] ou
cliquez sur l’étoile évidée .

�Le choix des clips à afficher en fonction de cri-
tères préétablis (tous les plans, favoris, fa-
voris et démarqués, rejetés) s’effectue dans le
menu local Afficher (en bas de l’interface). En
cliquant sur le bouton situé à sa droite (des va-
guelettes rouges ), vous supprimerez auto-
matiquement toutes les portions d’une vidéo
qu’iMovie ne serait pas parvenu à «stabiliser» . 

�Enfin, pour éliminer en une seule manipula-
tion tous les clips qui n’appartiennent à aucun
projet de montage, qui ne sont pas signalés
comme favoris ou qui ne possèdent pas de mots-
clés, faites Fichier > Économiseur d’espace.  Après
ce grand «ménage», votre disque dur ne s’en
portera que mieux. n D.A. Mary
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�À présent que votre bibliothèque d’événe-
ment est parfaitement optimisée, cliquez

sur l’outil en forme de clef.
�La palette de mots-clés surgit. Au bas de 

la section Appliquer Autom., saisissez un
nouveau mots-clé dans le champ dédié.

�Cliquez sur le bouton Ajouter. Recommencez
l’étape 2 et 3 autant de fois que nécessaire

puis refermez la palette.

Bien travailler avec les mots-clés
Une bonne indexation des séquences vidéo vous assurera un travail de montage paisible 
et soigné.

�Cliquez de nouveau sur l’outil en forme de
clef. La palette flottante s’ouvre alors sur 

la section Inspecteur.

�Cochez à l’intérieur tous les mots-clés 
caractérisant au mieux les vidéos 

que vous venez de sélectionner.

�L’attribution de mots-clés peut s’effectuer 
à la volée, à différents endroits d’une 

séquence. Pour ce faire, à l’intérieur de la palette 
flottante, cliquez sur le bouton Appliquer Autom.

�Cochez à l’avance tous les mots-clés utiles.
Puis, à l’aide de la souris, surlignez les 

portions concernées d’un clip. Renouvelez les
étapes 7 et 8 autant de fois que nécessaire.

	Pour trier les éléments de la vidéothèque à
partir d’un mot-clé, cliquez sur l’icône en

forme de loupe. Cliquez ensuite sur le bouton
vert en regard de chaque mot-clé.
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�Pour attribuer une série de mots-clés à un
ou plusieurs clips, commencez par 

sélectionner les séquences voulues dans la 
vidéothèque.

PEX Gestion videotheque_JLOK_Mise en page 1  10/01/11  16:47  Page37



L
es utilisateurs d’iMovie 6
HD, encore nombreux, doi-
vent se satisfaire d’une mé-
thode de travail assez coû-
teuse en espace disque. Les

rushes ne peuvent être communs à
deux projets différents, difficile de
changer cet état de fait. En re-
vanche, vous pouvez tourner cette
limitation à votre avantage. Si vous
faites un clic-droit sur l’icône d’un
projet iMovie HD, puis demandez
Afficher le contenu du paquet,
vous constaterez que le dossier
Contents/Shared Movies/ abrite
deux répertoires, GarageBand et
iDVD, contenant chacun une copie à
l’identique du montage de votre
film. Ne soyez pas étonné de leur
faible poids, il s’agit de séquen ces
QuickTime «de référence» qui pui-
sent leurs sources dans le dossier
Media. En tirant parti de cette dé-
couverte, je vais vous montrer
comment encoder en tâches de
fond plusieurs projets iMovie 6
avec l’application MPEG Streamclip
(www.squared5.com/svideo/mpeg-
streamclip-mac.html).

ENCODAGE PAR LOT
À l’ouverture de MPEG Streamclip,
demandez le menu Liste > Liste des

lots. Retournez dans le Finder. Pour
chaque projet iMovie, affichez le
contenu du paquet et rendez-vous
dans le dossier Contents/Shared Mo-
vies/iDVD. Glissez la séquence recueil-
lie dans la fenêtre Liste par lots de
MPEG Streamclip.
Un dialogue vous propose alors de
choisir le mode d’exportation .
Pour cet exemple, j’emploie le mo-
dule MPEG-4. Après avoir cliqué sur
le bouton OK, on vous demande de
sélectionner le dossier où seront en-
treposées les futures séquences en-
codées.
Ceci fait, affinez les réglages de l’en-
codeur. Pour obtenir un résultat com-
patible avec les iPod ou iPhone, cli-
quez sur le bouton iTuneset choisis-
sez le préréglage adapté à votre ap-
pareil. Ajustez la réglette de qualité
sur 100%. Cochez les cases Désen-
trelacer la vidéo et Meilleur réduc-
teur. Sélectionnez comme priorité
de trame Trame supérieure d’abord,
sauf si votre montage est au format
DV. Cliquez enfin sur le bouton Vers
les lots.
Pour éviter d’avoir à effectuer tous
ces réglages à chaque ajout d’un nou-
veau film dans la liste, cochez la case
Utiliser le dossier et réglages précé-
dents dans la première fenêtre
de dialogue. Pour démarrer l’enco-
dage par lot, cliquez sur le bouton
Lancer.

MONTEZ VOS ÉMISSIONS
TV FAVORITES
Récupérer dans iMovie’09 des vi-
déos issues de la TNT ne pose pas de
difficulté, à condition de procéder à

un désentrelacement. Dans le cas
contraire, des stries disgracieuses se
manifestent lors de mouvements ra-
pides de l’image. La procédure d’ex-
portation d’EyeTV s’effectue via le
menu Fichier > Exportation > Pour
iMovie ’09.
Rendez-vous dans le dossier Sé-
quences/Séquences originales iMovie.
La vidéo précédemment exportée
s’y trouve. Déposez-la sur l’icône du
logiciel JES Desinterlacer (www.xs4all.
nl/~ jeschot/home. html). 

Réglez ensuite le menu local nclcde
la section Input sur PAL. Cliquez sur
le bouton Project (en haut de la fe-
nêtre), puis sélectionnez Deinterlace

dans le menu local. Veillez à ce
que l’option Blend fields soit rete-
nue, puis cochez les casesAdapta-
tiveet Filter chroma. Enfin, dans la
section Output, sous l’intitulé Video

output > Compressor > Direct ,
demandez Apple Intermediate Co-
dec. Appuyez sur le bouton OK pour
lancer le processus d’encodage.

CHÉRIE, J’AI AGRANDI
L’IMAGE!
Les vidéos provenant d’un iPhone
3GS ont une cadence de lecture avoi-
sinant les 30 images par seconde,
mais elles sont aussi d’une taille in-
férieure à 576 lignes. Si nous souhai-
tons conformer le clip à un projet de
montage PAL, JES Desinterlacer va
nous être à nouveau d’un grand se-
cours. Dans la section Input, cochez
la case Progressive (in) et fixez le
menu local nclcsur None. Cliquez sur
le bouton Projectpuis, dans le menu
local, sélectionnez Standards conver-
sion. Les options Customet Minimal
blend doivent être actives. Veillez
bien à ce que toutes les cases soient
décochées. Entrez les valeurs 576,
720 et 25.000 dans le cadre Settings

. Et pour terminer, dans la sec-
tion Output, sous l’intituléVideo out-
put > Compressor > Direct, deman-
dez Apple Intermediate Codec.
n D.A. Mary
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Dopez iMovie avec des
outils complémentaires
�iMovie est un banc de montage d’accès simple
et sympathique mais son rayon d’action est 
limité. Et qu’il s’agisse du prétraitement des
rushes ou des fonctions d’importation ou 
d’exportation, recourir à des outils spécialisés
est parfois nécessaire.�
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�Téléchargez la version la plus récente de
HandBrake (http://handbrake.fr)qui lit

l’AVCHD sans difficulté.

�À l’ouverture du logiciel, sélectionnez le 
fichier MTS à importer. Optez pour le format

MP4 file et le codec vidéo MPEG-4 (FFMpeg).

�Optez pour un encodage constant 
en qualité 100%, puis appuyez sur le bouton

Start de la barre d’outils.

La compatibilité HD sans bourse délier
Quand QuickTime n’est pas en mesure de vous aider, il vous reste encore deux atouts 
dans votre manche pour rendre vos vidéos compatibles iMovie.

Vous et Votre Mac • Hors-série n°3 • Février 2011

�En bas de la fenêtre-tiroir, appuyez 
sur le bouton HD converter.

�Dans la fenêtre principale, actionnez le petit
triangle sous l’intitulé Source. Sélectionnez 

dans la fenêtre de requête le fichier vidéo HD 
à convertir (AVCHD 1080 ou « Lite » 720p).

�Dans le menu local Options, choisissez 
la taille d’image qui correspond aux rushes 

d’origine. La lettre « i » signifie image 
entrelacée, et « p » progressive.

�Cliquez sur le bouton Go pour procéder 
à l’encodage. Si vous prenez une licence

(15€ pour un particulier), MovieConverter 
s’exécutera jusqu’à trois fois plus vite !

�À l’ouverture de l’application, cliquez 
sur le bouton Accès direct au module 

gratuit SuntaicHD.

         

�MovieConverter (www.movieconverter-stu-
dio.com) est un bon choix pour 

travailler avec le codec Intermediate d’Apple.
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D
isponible dès la sortie de la première
version d’iMovie ’09, le cache patate
n’en demeure pas moins une fonc-
tion très peu documentée. Elle n’a
pas été améliorée au cours des dif-

férentes mises à jour, mais elle se révèle néan-
moins particulièrement utile si vous êtes un
mordu des effets spéciaux, ou pour seulement
corriger quelques imperfections dues aux con -
ditions de tournage.

INCRUSTATION CHROMA KEY
Lecache patateest associé à l’incrustation sur
fond vert appelé green matteou green screen.
Un compositing amusant, mais pas toujours
aisé à réaliser. Pour le créer, iMovie ’09 impose
l’emploi d’un fond vert. Si on trouve actuelle-
ment des décors à moins de 60€ au rayon
photo des boutiques Internet, vous pouvez
tout autant recourir à l’emploi d’un drap ou
d’une nappe. Pour des petits objets – comme
la sculpture sur bois utilisée dans mon exem -
ple –, un intercalaire en carton souple fera l’af-
faire. Pour l’éclairage, là encore, inutile de vous
ruiner : de simples halogènes de jardin ou de
bureau placés derrière un diffuseur photo suf-
fisent à la tâche.
Enregistrez la scène avec votre caméscope,
puis importez-la dans iMovie. Ou bien, si iMovie
vous y autorise, filmez le tout directement sur
le disque dur de votre Mac. Pour ce faire, de-
mandez Fichier > Importer depuis la caméra,
et dans la nouvelle fenêtre, le nom de votre
caméscope apparaît automatiquement dans
le coin inférieur gauche. Cliquez sur le bouton
Importerà droite. Dans la fenêtre surgissante,
créez un nouvel événement si nécessaire, puis
appuyez sur le bouton Importer : la capture vi-
déo commence alors dans la foulée. Cliquez
sur Arrêterpour interrompre l’enregistrement.
Rendez-vous dans les Préférences d’iMovie
’09 > Généraleset veillez à ce que la case Afficher
les outils avancés soit cochée. Dans le menu
Fichier, demandez ensuite la création d’un
nouveau projet de montage. Dans la biblio-
thèque de l’application, sélectionnez un premier
clip qui servira de décor de fond et glissez-le

dans la fenêtre de montage. Saisissez-vous
ensuite de la vidéo tournée en fond vert et su-
perposez-la au premier clip (reposant dans le
banc de montage). Un menu contextuel surgit,
choisissez alorsÉcran vert.
Dans la fenêtre de visualisation, cliquez sur le
bouton Rogné . Le cache patate à 4 points
apparaît… Délimitez le sujet filmé à l’aide des
points d’articulation afin d’éliminer du
cadre les imperfections du décor et les ombres
éventuelles. Cliquez sur le bouton « i» (dans
la barre d’outils). Quand la palette Inspecteur
> Vidéo fait son apparition, déplacez votre
souris dans l’écran de visualisation. Le pointeur
se transforme en pipette. Faites un clic gauche
dans l’espace situé derrière votre sujet .
L’incrustation devrait être un peu plus convain-
cante… Enfin, retouchez si nécessaire la lumi-
nosité, le contraste ou l’équilibre des couleurs
à l’aide de la palette Inspecteur.

CORRECTION DE LA
SUREXPOSITION
Il existe une autre utili-
sation du cache patate
pour  améliorer  des
plans tournés dans des
conditions difficiles !
Quand on filme en inté-
rieur, il arrive parfois que
l’on soit amené à avoir
de grandes disparités
de lumière entre diffé-
rentes zones de l’image.
Tel est le cas si le plan

tourné est proche d’une fenêtre (ou d’une
baie vitrée) : cette dernière se résume à un
halo blanchâtre. Pour récupérer un peu de dé-
tails à l’image et éviter tout scintillement à
l’écran, voici la bonne méthode…
Placez le clip vidéo dans la fenêtre de montage.
Retournez dans la bibliothèque d’iMovie ’09
pour refaire la même chose, en veillant à ce
que le second clip se superpose au premier.
Dans le menu contextuel qui surgit, choisissez
Écran vert. Dans la fenêtre de montage, sélec-
tionnez le second clip (celui du «dessus»), puis
dans la fenêtre de visualisation, cliquez sur le
bouton Rogné : le cache patate apparaît.
À l’aide des points d’articulation, bordez la
zone de l’image à retoucher . Appuyez sur
le bouton « i » de la barre d’outils, et dans le
panneau Vidéo, réduisez un peu les paramètres
de luminosité et de contraste – ajustez le
point blanc si nécessaire. nDavid A. Mary
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Une fonction discrète d’iMovie ’09

le cache patate
� Appelée aussi Garbage Matte, cette fonction permet d’isoler à la volée une portion de l’image pour faciliter
des travaux d’incrustations ou de retouches vidéo. En pratique, cela donne ceci…�
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Un générique de type Experts Miami

�Sélectionnez dans la bibliothèque d’iMovie un clip 
de 3 à 5 sec, avec des mouvements de caméra 

rapides, des gens qui marchent ou des enfants qui 
courent. Créez un nouveau projet et placez-y la séquence.

�Dans la barre d’outils, appuyez sur le bouton « i ».
Dans la palette Inspecteur > Plan, choisissez 

l’effet vidéo Romantique. Sélectionnez de nouveau 
le clip vidéo utilisé à l’étape précédente.

�Superposez-le à celui contenu dans la fenêtre 
de montage. Un menu contextuel surgit : optez pour

Écran vert. Dans le visualiseur, il se peut que l’image se
brouille, mais ceci est parfaitement normal.

�Dans la fenêtre de montage, sélectionnez le second
clip vidéo, cliquez sur le bouton Rogner, Faire 

pivoter et effets Ken Burns (dans la barre d’outils). Dans
la fenêtre de visualisation, cliquez sur le bouton Rogner.

�Affichez une fois encore la palette Inspecteur.
Dans la section Vidéo, réduisez la Saturation

ainsi que le Gain (vert) pour éviter tout problème 
d’incrustation. Profitez-en pour modifier la luminosité si
nécessaire.

�Recommencez toutes les étapes autant de fois que
nécessaire. Une fois le montage de la séquence

achevé, sélectionnez le titrage Tiers inférieur ou
Contour flou. Disposez-les à divers endroits de votre 
projet.

�Utilisez de préférence la police de caractères 
Bank Gothic ou Futura Condensed Extrabold. Dans 

le visualiseur, surlignez le texte puis, avec le raccourci
[Cmd T], affichez la palette de caractères habituelle.

�Placez le pointeur de la souris dans le coin haut à
gauche du visualiseur. Et tout en maintenant 

appuyé le bouton gauche, déplacez la souris vers la droite
de façon à ce qu’un cadre vert se matérialise. Ajustez le
cadrage de la scène à votre guise.

�Cliquez sur le bouton Terminé du visualiseur. 
Sélectionnez de nouveau le second clip dans la 

fenêtre de montage puis, dans le visualiseur, cliquez sur 
le bouton Rogné. Cette fois, le cache patate apparaît… 
Formez un rectangle à un endroit de l’écran.

Grâce au cache patate 4 points d’iMovie ’09, vous pouvez également réaliser des montages 
de type «split screen».
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L
e prologue du film original de 1977 est
construit en trois parties. Tout d’abord
apparaît un premier texte bleu sur fond
noir (« Il y a bien longtemps dans une
galaxie lointaine, très lointaine… »)

d’une durée de six secondes environ. Puis, re-
tour au noir pour une seconde. Arrive ensuite le
logo Star Wars en très gros plan, s’éloignant
dans l’espace près de dix secondes durant. Enfin,
avant que le logo ne disparaisse de l’écran, le fa-
meux texte d’introduction défile à son tour pen-
dant une durée de 1 min 14 sec environ. 

LE LOGO STAR WARS
Avant de passer au montage, il faudra créer de
toutes pièces le logo Star Wars, et bien sûr l’ani-
mer. Pour corser le tout, le compositing obtenu
devra être incrusté dans iMovie ’09 au-dessus du
fond étoilé. Dernier obstacle, ce fond n’est pas du
tout statique! Pour le rendre vivant et donner un
peu plus de profondeur au trucage, nous lui assi-
gnerons un effet Ken Burns.
Pour faciliter la réalisation de cette partie, vous
trouverez la séquence vidéo du logo animé, ainsi
que tous les fichiers complémentaires, sur le site
Web de Vous et Votre Mac. Le titrage est réalisé
avec l’application Pixelmator, l’animation avec le
module de composition nodale de Blender. Pour
préserver la transparence du lettrage au moment
de l’export, il existe un petit secret de fabrication:
utilisez impérativement le codec de compression
Animationen millions de couleurs+.

ORGANISEZ VOS PROJETS
Ouvrez iMovie ’09. Demandez Fichier > Nouveau
dossier afin d’y regrouper tous les projets relatifs
à la création du générique . Notez que nous
aurons besoin, en tout et pour tout, de deux pro-
jets distincts (Fichier > Nouveau projet): un pour
la création du fond étoilé, un autre pour le mon-
tage proprement dit.
Nommez tout d’abord le premier projet, Étoiles
par exemple, et le second Montage Star Wars. En-
fin, faites Fichier > Nouvel événement, que vous
intitulerez Rushes Star Warspour y ranger la vi-

déo du fond étoilé que nous allons réaliser ainsi
que le logo animé (www.wwmac.com).
Double-cliquez sur le projet Étoiles afin de faire
apparaître la fenêtre de montage. Choisissez,dans
la section Cartes et arrière-plans, le fond dé-
nommé Étoiles que vous déposez dans le banc de
montage.

LE FOND ÉTOILÉ
Sélectionnez l’élément graphique que vous ve-
nez de glisser et cliquez sur le bouton Inspecteur.
En haut de la palette flottante, indiquez une du-
rée d’une minute et vingt-trois secondes, sous
cette forme: 1:23:00. Cliquez sur le bouton bleu
Terminé.
Sélectionnez maintenant l’outil Rognerpuis, dans
la fenêtre de visualisation (en haut à droite de
l’écran), appuyez sur le bouton Ken Burns. Dispo-

sez les cadres rouge et vert de manière approxi-
mative: le seul impératif est que le second doit
être de taille plus modeste et obligatoirement
contenu à l’intérieur du premier. Référez-vous à
la capture d’écran ci-dessus . Exportez le film
(Partage) à une taille HD. L’export achevé, pro-
cédez à son importation dans iMovie (Fichier >
Importer > Films). Dans le dialogue, veillez à ce

que l’ajout se fasse dans l’événement Rushes Star
Wars . Profitez-en également pour procéder
à l’importation du logo animé (intitulé Titre prin-
cipal.mov) dans le même événement.

LA PRÉPARATION DU TEXTE DÉFILANT
Le module de titrage d’iMovie n’est pas conçu
pour gérer facilement de longs textes usant de
multiples polices de caractères. La navigation à

l’intérieur de la fenêtre de saisie peut devenir dif-
ficile, voire provoquer parfois des plantages. Ré-
digez donc le texte d’introduction dans TextEdit
avec la police Arial Rounded MT Bold (livré avec
Mac OS X), en taille 30 et de couleur orange .
Quant au nom de l’épisode (Un nouvel espoir)

, utilisez la police Tall Dark And Handsome, en
taille 60 (à dénicher surwww.dafont.com). Un peu

feignant? Le fichier texte déjà préparé se trouve
dans l’archive accompagnant cet article (sur
www.vvmac.com)… À présent, il est temps de pas-
ser au montage complet du générique, suivant le
pas à pas de la page de droite…
n D.A. Mary
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Recréez le fameux générique
de Star Wars
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� La séquence d’ouverture de La Guerre des étoiles ne se résume 
pas à un simple texte défilant dans l’univers intergalactique. 
Et c’est d’ailleurs là toute la difficulté de l’exercice…�
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�Déposez le titrage Centrer dans le projet 
Montage Star Wars. Une palette flottante 

surgit : choisissez l’arrière-plan Noir.

�Dans la fenêtre de montage, cliquez 
sur la vignette noire. Appelez l’Inspecteur

et indiquez une durée de 8 secondes.

Le montage final pas à pas
iMovie ’09 se montre parfaitement à l’aise avec l’incrustation vidéo, offrant un rendu digne 
des meilleures productions hollywoodiennes !
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�Superposez le logo sur le fond étoilé. 
Dans le menu qui surgit, demandez Plan de

coupe. Sélectionnez la vignette représentant le logo
Star Wars, affichez de nouveau l’Inspecteur Plan
pour régler l’opacité à 94 %.

�Ajoutez le titrage de type Éloignement
dans le banc de montage. Ce dernier débute au

2/3 du plan de coupe (logo) et se poursuit jusqu’à la
fin de la séquence. Ajustez le bandeau de titrage en
conséquence.

	À présent, copiez le texte contenu dans 
le document TextEdit préalablement créé et 

collez-le à l’intérieur de la fenêtre de visualisa-
tion. Ajoutez la musique de John Williams 
qui débutera avec l’apparition du logo animé.

�Sélectionnez le bandeau de titrage. Dans la 
fenêtre de visualisation, tapez le texte 

introductif puis faites [cmd-a] et [cmd-t].

�Dans la palette des polices, sélectionnez
Arial/Gras/20. Cliquez sur Couleur de texte

pour changer la teinte en bleu. Ajustez le bandeau 
de titrage à 6:18 sec environ.

�Dans la bibliothèque d’événement Rushes 
Star Wars, déposez dans la fenêtre de 

montage le clip contenant le fond étoilé. 
Sélectionnez-le, puis affichez l’Inspecteur Plan.

�Appuyez sur le bouton qui fait face à Effet 
vidéo et optez pour Bords adoucis. Cliquez 

sur Terminé. Sélectionnez dans les rushes le logo
animé et glissez-le dans la fenêtre de montage.
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A
vec iMovie’08, Apple a abandonné l’idée
d’ouvrir le logiciel à des éditeurs tiers qui
l’auraient enrichi de fonctions diverses.

Il en est de même de la version ’09; il semble
pour le moment acquis qu’Apple évite de met-
tre en concurrence la suite Final Cut Express 4
(dont la politique tarifaire a été revue à la bais -
se) avec ses produits grand public.

LE HACK ET SES LIMITES
La bidouille que je vous présente a été conçue
pour l’article de présentation d’iMovie ’08 (paru
dans VVMac n°28). Je montrais alors qu’il était
possible de substituer aux transitions et titrages
de base d’autres réalisés par mes soins. Je re-
courais à l’application Quartz Composer. La si-
tuation n’a pas changé : le «nouvel» iMovie est
conçu pour ne charger en mémoire que les titrages
et effets Apple. Aussi, la seule méthode valable
est de modifier ces derniers tout en gardant
intact le nom des fichiers. Cette astuce revêtirait
un caractère gênant si tous les artifices visuels
proposés dans iMovie vous étaient indispensables.
Mais, parmi le vaste choix proposé, il y en a sans
doute que vous n’utilisez jamais et d’autres que
vous aimeriez améliorer. C’est là tout le propos
de cet atelier.

TRAVAIL PRÉPARATOIRE
Il est entendu que vous avez déjà installé les
outils développeurs (depuis le DVD de Leopard).
Rendez-vous dans le dossier Applications à la re-
cherche d’iMovie. Cliquez une fois sur son icône
et demandez Fichier > Dupliquer ([Cmd D]). À
présent, vous ne travaillerez que sur la copie réa-
lisée: en cas d’erreur, les dégâts seront limités.
Et si l’application ainsi transformée n’est plus à
votre goût, il vous suffira de la glisser à la Corbeille. 

Quoi qu’il en soit, vous gardez toujours l’original
«sous le coude».
Faites un clic-droit sur l’icône iMovie-copie, puis
demandezAfficher le contenu du paquetdans
le menu contextuel. Ouvrez successivement les

dossiers Contentset Resources. Les titrages et
effets sont dans des fichiers .qtz . Il en va de
même pour les cinq thèmes de montage et leurs
déclinaisons. Pour ces derniers, un fichier addi-
tionnel TitlePercent Adjustments.plists’occupe
d’affiner le comportement des animations dans
le temps.

MODIFIEZ L’ASPECT D’UN TITRAGE
Prenons pour exemple le fichierWhitePaper.qtz
qui correspond au titrage nommé Papier. Dou-
ble-cliquez dessus afin de l’ouvrir dans le logiciel
Quartz Composer .
Dans un éditeur bitmap (Pixelmator, LiveQuartz
ou Photoshop Elements), élaborez au préalable
une bannière originale. Si vous êtes à court d’ins-
piration, j’ai réalisé pour vous un modèle que
vous pouvez télécharger sur le site de Vous et
Votre Mac (www.vvmac.com).
Dans la fenêtre Editor, sélectionnez le module
White-Paper. Cliquez sur le bouton Patch Ins-
pector , et en haut de la palette flottante qui
vient d’apparaître, déroulez le menu local, puis
demandez Settings .
Juste au-dessous, appuyez maintenant sur le
bouton Import From File . Dans le dialogue,
choisissez le fichier graphique qui servira d’ha-
billage au titrage. Enregistrez les modifications
(File > Save).
Lancez iMovie-copie et utilisez le titrage Papier
dans votre projet de montage afin d’apprécier
les changements opérés . nDavid A. Mary
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Changez l’apparence
des titrages
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� Puisqu’Apple n’a toujours pas prévu la possibilité d’ajouter de nouveaux 
titrages, effets et transitions, rien ne vous empêche de modifier 
ceux déjà existants, comme je vais vous le montrer…�
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Un effet «à la Minority Report»
Du Soldat Ryan à Minority Report, Spielberg recourt à une image blafarde et quelque peu 
granuleuse. Voici comment recréer cet effet pour iMovie’09.
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�Quant au second module Exposure Adjust, 
attribuez-lui une valeur de 0.14.

Pour ajouter du grain photographique, retournez
dans les ressources d’iMovie et double-cliquez 
sur le fichier Style_Grain.qtz.

�Sélectionnez les modules Random
et CIVideoNoiseFilter. Copiez, puis collez-les

dans le document Style_BleachBypass.qtz. 
Reliez les modules comme ci-dessus (à placer 
entre Exposure Adjust et Fit Image).

	Dans le document Style_Grain.qtz, fenêtre
Editor, cliquez sur le cadre Texture, puis de-

mandez le menu Fichier > Copier. Collez le tout
dans le cadre Texture du document Style_Bleach-
Bypass. qtz. Enregistrez les modifications.

�Ce dernier vous servira d’image témoin 
pendant les ajustements. Les modifications sont

à observer dans la fenêtre Viewer.

�Pour se débarrasser de l’effet de flou, reliez 
le module Image à Exposure Adjust. Le mo-

dule Bloom reste orphelin. Affichez la palette Patch
Inspector avec le bouton de la barre d’outils.

�Sélectionnez le module Exposure Ajust, 
puis attribuez la valeur –0.056 dans 

la palette Patch Inspector > Input Parameters.

�Pour le module Color Controls, modifiez 
les valeurs de saturation, de luminosité 

et de contraste comme ci-dessus. La valeur 
du module Gamma Adjust est ajustée à 1.23.

�Dans les ressources d’iMovie, double-cliquez 
sur le fichier Style_BleachBypass.qtz. Il 

correspond à l’effet vidéo nommé Procédé sans
blanchiment.

�Dans la barre d’outils de la fenêtre Editor, 
cliquez sur le bouton Patch Parameters. 

Glissez dans le cadre Image n’importe quel fichier
photo.
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L
a compression est la pierre angulaire
de la technologie informatique mo-
derne. Grâce à elle, les données peu-
vent être transmises en réseaux plus
rapidement ou bien stockées sur des

médias de «faibles» capacités comme un CD-
Rom ou un DVD-vidéo.
Un seul exemple suffit pour illustrer l’efficience
d’un tel procédé: une séquence vidéo d’une mi-
nute et demie et d’une taille de 868x560 pixels
pèse 2,63 Go sans compression. Elle n’occupe

plus que 260 Mo d’es-
pace disque si l’on uti-
lise un codec Motion
JPeg, et seulement 87
Mo lorsqu’on la passe
à la moulinette du
H.264. Aussi, disposer
d’outils performants
pour économiser l’es-
pace disque tout en
préservant la qualité
représente la quête
du Saint-Graal tant
pour les éditeurs de
contenus que pour les
diffuseurs et les utili-
sateurs. Pour cela,

deux grandes familles de codecs arrivent à la
rescousse: les formats sans perte (lossless en
anglais) et les formats destructifs (ou lossy).
YUVSoft et Apple Uncompressed appar-
tiennent à la première catégorie, les incontour-
nables MPeg-1, 2, 4 et consort (H.264) font partie
de la seconde catégorie. Si vous souhaitez bé-
néficier d’un tour d’horizon plus complet, je vous
renvoie à la lecture des articles Les différents

formats audio et vidéoet Bien utiliser les codecs

audio et vidéo parus respectivement dans les
numéros 23 et 34 de Vous et Votre Mac.

LA RECETTE D’UN BON CODEC VIDÉO
Bien que les artifices employés soient plétho-
riques, on peut distinguer quelques axes clés

d’intervention ou d’optimisation du flux vidéo:
réduction de l’espace colorimétrique, repérage
entre deux trames consécutives d’éléments

communs ou disparates, élimination d’informa-
tions visuelles redondantes ou échappant à l’œil
humain. Avec l’explosion de l’Internet mobile
et de la vidéo à la demande, les besoins évoluent
et la barre se place de plus en plus haut pour sa-
tisfaire le consommateur: une meilleure image
pour un poids toujours plus faible. Aussi, pour
parvenir à pareil exploit, plutôt que de creuser
le sillon d’un énième codec, l’idée est de filtrer
au mieux l’image à la source selon deux mé-
thodes.
La première s’opère par soustraction de la lumière
au moment de la compression pour la restituer
de manière choisie pendant la phase de décom-
pression. La seconde réduit, puis réorganise les
informations de couleurs afin d’être traitées de
façon optimale par le compresseur. C’est ainsi
qu’est né le JPDM qui use de ces deux techniques.

L’ENVERS DU DÉCOR
Contrairement à ce qu’on laisse souvent entendre,
le JPDM (appelé aussi JPDMovie) n’est pas un
codec. Il ne s’oppose donc pas au H.264 dont il
est en réalité… le meilleur allié. Le JPDM est une
méthode de filtrage des données con çue pour

optimiser la compression vidéo avec n’importe
quelle norme, qu’elle soit MPeg-4/H.264 ou
MPeg-2. Plus prosaïquement, voici comment
se déroulent toutes les opérations.
Le clip vidéo que vous soumettez pour l’encodage
est examiné et préparé par le JPDM, puis envoyé
trame par trame vers le compresseur. Le résultat
est présenté sous la forme d’un conteneur Quick-
Time  .mov. Une déclinaison de ce filtre de pré-
traitement existe également pour les documents
bitmap (PNG, JPeg ou GIF). Et comme pour la vi-
déo, la réduction de la taille des fichiers est de
l’ordre de 30%.

DU PRÉFILTRAGE AU CODEC
Comme personne n’a le monopole des idées, il
n’a pas fallu attendre longtemps pour qu’un
nouveau codec propriétaire, décliné à partir de
la norme MPeg-4/H.264 et usant du préfiltrage
JPDM, voit le jour. Il est édité par la société lon-
donienne Kandalu Software, et intégré à de nom-
breux produits. Le plus polyvalent se nomme
KLite et s’adapte à tout type d’utilisation. Il
se permet même, après encodage, de transférer

vers un iPod, un iPhone ou une Apple TV vos sé-
quences ou rushes JPDM vers du H.264 standard.
Et comme vous le voyez , sans aucune perte
visible! nD.A. Mary

1
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� Maintes fois décrit comme le rival du H.264, produisant de meilleures images 
tout en réduisant la taille des fichiers, le JPDM est la dernière 
sensation à la mode. Du H.264, il est en fait le meilleur allié. Kandalu Lite est 
l’outil le plus simple pour en tirer rapidement parti. � 

VIDÉO046

L’optimisation vidéo 
selon JPDM
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Encodez le H.264 autrement!
Pour faire maigrir vos vidéos tout en préservant leur qualité esthétique, le régime KLite s’impose.
S’en servir sans souci, telle est sa devise !

         Vous et Votre Mac • Hors-série n°3 • Février 2011

�Fixez le menu local Compression Type sur
JPDM. Laissez Frame Rate sur Current et Key

Frame sur Automatic. Ajustez Data Rate sur 6400
kbits/sec. Placez la réglette Quality sur Best.
Cliquez sur OK pour valider.

�L’encodage terminé, KLite vous propose 
de créer une copie destinée à l’iPhone/iPod 

ou l’Apple TV. Si vous acceptez, cliquez sur Send 
to Exporter (sinon optez pour Close).

	Précisez dans le menu local l’appareil destiné à
lire la vidéo. Cochez la case Add videos 

to iTunes when done pour que la séquence soit ajou-
tée à iTunes automatiquement. Cliquez 
sur le bouton rouge pour conclure.

�Lancez Kandalu Lite et glissez-déposez la vidéo 
à encoder dans la partie centrale de l’interface.

�Cliquez sur le bouton Export pour commencer
les opérations d’encodage. �Dans le dialogue qui s’affiche, spécifiez 

l’endroit où le fichier sera enregistré.
Donnez-lui un nom, puis cliquez sur le bouton Save.

�La fenêtre Movie Settings apparaît. Veillez 
à ce que les cases Sound et Video soient co-

chées. Appuyez sur le bouton Settings (Vidéo).

�Avec votre navigateur Internet, rendez-vous 
à l’adresse http://www.kandalu.net/uk/klounge/klite. 

Cliquez sur le bouton Download.

�Une fois l’image disque téléchargée, 
double-cliquez sur son icône, puis procédez 

à l’installation de l’application Kandalu Lite.

047

PEX KandaluLite_JLOK_Mise en page 1  10/01/11  16:55  Page47



D
ans la séquence géné-
rique de la série TV amé-
ricaine 24 Heures
Chrono, le titrage est
réalisé avec une police

de caractères spéciale reprodui-
sant l’afficheur LCD typique des
montres à quartz. Vous trouverez
plusieurs varian tes de ce type de
police sur le site dafont.com (ru-
brique Techno > LCD). Deux choses
sont à observer dans le générique
initial : d’une part, chaque seg-
ment de l’afficheur digital apparaît
de manière aléatoi re. Si vous sou-
haitez reproduire ce trucage à
l’identique, vous aurez besoin
d’une application de retou che bit-
map sachant gérer les cal ques
(comme Pixelmator, Photoshop
Element…). D’autre part, autour
de la police de caractères apparaît
un halo de couleur orangé. Cet ef-
fet Glow peut être reproduit
sans grande difficulté dans iMo-
vie… à condition de modifier cer-
taines ressources internes du logi-
ciel. Encore une fois, tout le défi
con siste à produire un résultat
convaincant avec des outils qui
n’ont pas cette vocation première.

L’EFFET GLOW
La technique de réalisation de l’effet
a déjà été décrite dans le détail dans

VVMac n°48. Je m’en tiendrai ici à
l’examen chronologique des modi-
fications à opérer.
Quittez iMovie si ce dernier est ou-
vert, puis faites un clic-droit sur son
icône dans le Finder et demandez
Afficher le contenu du paquet dans
le menu contextuel.
Le fichier Quartz Composer que nous
allons modifier se trouve caché dans
le dossier Contents/Resources: il s’agit
du document Style_ DreamWarm.qtz.
Commencez tout d’abord par en
faire une copie de sécurité (via Fichier
> Dupliquerdans le Finder).
Si vous ne vous sentez pas le courage
de modifier le fichier Quartz Com-
poser, ou que vous n’avez pas installé
les outils développeurs sur votre
disque dur, vous trouverez sur le site
www.vvmac.com, à la page Sommaire
51, un lien vers le fichier déjà modifié
par mes soins. Glissez-le dans le dos-
sier Contents/Resources du logiciel
iMovie pour procéder au remplace-
ment du fichier original.
Voici le détail des modifications opé-
rées dans le document Style_Dream-
Warm.qtz: l’intensité du module Blur
(Retain Size) a été renforcée
quelque peu; j’ai déconnecté le mo-
dule noir et blanc, B&W , pour
que l’effet final conserve le coloris
des polices (sinon, elles seraient ap-
parues blanchâtres); j’ai ajouté pour
finir le module Bloom afin
d’adoucir le bord du titrage.

LE DÉCOUPAGE DES CARACTÈRES
La fragmentation du titrage et son
apparition aléatoire à l’écran ne sont
pas compliquées à réaliser, mais elles
nécessitent d’avoir un peu de temps
devant soi… Dans un nouveau do-
cument – ici je travaille avec Pixel-

mator – d’une taille adaptée au type
d’écran pour lequel vous le destinez
(720 x 576 pour la définition standard
4:3, 720 x 405 pour le 16:9, ou bien
encore 1 280 x 720  pour la HD 720),
remplissez le premier calque d’une
couleur noire. Rapidement, faites
Image > Inverser.
Depuis la palette idoine, créez un
deuxième calque, et avec l’outil
Texte, inscrivez le contenu de votre
titrage – dans mon exemple, «24».
Surlignez le texte, et dans la palette
des polices (Affichage > Afficher les
polices), choisissez la fonte imitant
un affichage LCD. Optez pour une
couleur de caractère jaune.
Transformez le calque Texte en
calque bitmap (Calques > Pixellisa-
tion des calques de texte). Dupliquez
le calque, puis décochez le calque
texte original.
Sur la copie du texte, à l’aide de l’outil
Lasso, sélectionnez au hasard diffé-
rents segments LCD que vous sou-
haitez faire disparaître . Ensuite,
effacez-les (via le menu Édition >
Supprimer).
Demandez alors Édition > Désélec-
tionner, puis enregistrez la première

image au format PNG (Fichier > Ex-
porter > Format PNG). Intitulez le
fichier, par exemple, «logo 01».
Décochez le calque texte modifié,
dupliquez le calque texte original et
recommencez ensuite les deux der-
nières étapes autant de fois que né-
cessaire. Pour ce type d’animation,
vous pouvez réaliser entre vingt et

cinquante images au total. 
Le travail préliminaire de modification
du fichier étant ache vé, il est grand
temps de passer au montage dans
iMovie dans lequel nous allons pro-
fiter de notre effet Glow flambant
neuf. Et cela se passe en face sur la
page de droite!
n D.A. Mary
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Réalisez des titrages façon
24 Heures Chrono
� Une fois encore, avec l’aide du magicien Quartz Composera, la réalisation de cet effet va nous permettre de
pousser une nouvelle fois l’application iMovie dans ses derniers retranchements! �
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En route pour le montage!

�Créez un nouveau projet de montage iMovie. Depuis
le Finder, glissez dans la fenêtre de montage tous

les fichiers PNG réalisés avec Pixelmator ou tout autre 
éditeur bitmap.

�Dans la fenêtre de montage, sélectionnez la 
première image, puis appuyez sur le bouton 

Inspecteur de la barre d’outils. Dans le panneau Plan, 
spécifiez une durée de 0:04 et cochez la case en regard.

�Appuyez maintenant sur le bouton Terminé. 
Placez votre souris dans la fenêtre de montage,

puis demandez Fichier > Tout sélectionner.

�Faites apparaître à nouveau la palette Inspecteur
> Plan, puis sélectionnez l’effet Dessin animé.

Ce dernier va imiter la texture caractéristique d’un af-
fichage LCD.

�Importez dans la bibliothèque iMovie la séquence
précédemment réalisée. Créez un nouveau 

projet de montage et glissez la vidéo à l’intérieur.

�Dans la palette Inspecteur > Plan, choisissez l’effet
vidéo Rêve (il s’agit de l’effet Glow que nous 

avons réalisé précédemment). Ajustez la réglette de 
vitesse à 200% ou 400% si vous souhaitez un défilement
plus rapide.

	Vous pouvez enfin ajouter comme image finale 
un fichier PNG contenant le titrage « 24 » complète-

ment reconstitué et auquel vous aurez pris soin d’ajouter 
l’effet Rêve.

�Dans le panneau Inspecteur > Vidéo, diminuez 
le niveau de blanc à 84 %, l’exposition à 78 %, 

augmentez le contraste à 19 %, ainsi que la saturation 
à 162 %. Placez le point de blanc sur l’orange et ajustez les
gains Rouge, Vert et Bleu comme ci-dessus.

�Exportez ce premier montage via Partage > 
Exporter à l’aide de QuickTime > Vidéo vers 

séquence QuickTime. Employez de préférence le codec
Animation > Millions de couleurs+.

La réalisation du titrage combine plusieurs techniques alliant l’animation image par image 
et l’application d’effets visuels. Voici comment procéder…

         Vous et Votre Mac • Hors-série n°3 • Février 2011
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L
e Matroska Video (ou
MKV) est un conteneur
multimédia au même ti-
tre que le MOV de Quick-
Time, ou l’AVI de Micro-

soft. À une différence près, mais
d’importance: il s’agit d’un format
ouvert dont les spécifications tech-
niques sont publiques et sans res-
trictions d’accès ni d’usage. 
Le MKV est aussi multiplate-forme,
compatible avec tous les systèmes
Linux, Windows, et bien sûr Mac OS
X. Pour le lire avec le lecteur Quick-
Time 7, il convient d’installer le plug-
in Perian (www.perian.org). Alterna-
tivement, on utilisera VLC (www. vi-
deolan.org/vlc/). De nombreux ma-
tériels de salon peuvent également
le lire, même l’Apple TV lorsqu’elle
est débloquée avec aTV Flash.

QUELS FORMATS
DE FICHIERS SUPPORTÉS?
Le conteneur Matroska (poupée
russe) accueille un grand nombre
de formats dont les fameux DivX,
XviD, H.264 pour la vidéo ainsi que
l’AAC, le MP3, l’AC3, le DTS et le
PCM pour l’audio. Il accepte le cha-
pitrage, les sous-titres et les vignettes
d’illustrations. Le fichier multimédia
se décline en .mkv pour la vidéo,
.mka pour l’audio et .mks pour les
sous-titres seuls.

MÉTHODE DE TRAVAIL
De l’acquisition jusqu’au montage,
aucune de vos habitudes n’est à
changer. Pour la numérisation de
vos vieilles cassettes VHS, vous pou-
vez désormais utiliser une solution
clef en main comme le Video Capture

d’Elgato (www.elgato. com/elgato/
int/mainmenu/products/Accessories/
Video-Capture/product1.fr. html) qui
propose une option d’exportation

directe vers iMovie. Le montage réa-
lisé, demandez Partage > Exporter
le film. Choisissez la taille de la vidéo
dans la fenêtre surgissante, puis

nommez votre vidéo en évitant
tout caractère accentué. Cliquez
ensuite sur le bouton Exporter.

TÉLÉCHARGEZ MKVTOOLNIX
Pour la création d’un document
MKV, il vous faut le bon outil…
MkvToolNix cumule bon nombre
d’avantages. Tout d’abord, il est
gratuit. Le sutilisateurs sous leopard
et SnowLeopard le téléchargeront
sur la page http://jonthn.free.fr/
MKVtoolnix Mkvtoolnix-4.4.0_2010-
11-02-6315.dmg.

Les utilisateurs qui disposent d’une
ancienne version du système (Mac
OS X 10.4 et antérieurs suivront eux
le lien www.bunkus.org/videotools/
mkvtoolnix/macosx/ MKVToolnix-2.3.zip
(mais il s’agit d’une vielle version).

À LA DÉCOUVERTE DU LOGICIEL
MkvToolNix regroupe quatre utili-
taires dans une même interface.
Pour passer de l’un à l’autre, il faut
utiliser les boutons situés dans
le haut de la fenêtre.
Le panneau Inputest dévolu à l’en-
codage ou à la concaténation des fi-
chiers sources (images et sons). Le
panneau Attachements con cerne
l’ajout d’informations complémen-
taires telles que les paroles des chan-
sons. Le panneau Global sert à in-
corporer les données de chapitrage,
mais aussi à découper un film en plu-
sieurs fichiers indépendants. Enfin,
l’écran Chapter Editorest un éditeur
de chapitres complet avec lequel
nous allons faire plus ample connais-
sance dans la page ci-contre. 
nD.A. Mary

1
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� Compatible toute plateforme, acceptant n’importe quel codec, le conteneur Matroska 
est une curiosité à découvrir de toute urgence! �

2

1

Et si vous passiez toutes 
vos vidéos en MKV?
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Un chapitrage en toute simplicité

�Dans le panneau Input de MkvToolNix, cliquez sur
Add. En bas du dialogue, demandez Enable > All

files. Choisissez ensuite la première vidéo à importer. Cli-
quez sur Open pour valider cette étape.

�Pour les vidéos supplémentaires que vous souhai-
tez concaténer, cliquez sur le bouton Append

en lieu et place du bouton Add précédemment utilisé.
Pour le reste, le mode opératoire ne change pas.

�En bas de la fenêtre, précisez l’endroit du disque
dur où sera compilé le film Matroska (Browse). 

Profitez-en pour choisir l’intitulé du document à exporter,
suivi de l’extension .mkv qu’il est impératif de mentionner.

�Cliquez sur le bouton Start muxing (en bas 
de l’écran) pour créer le document MKV. Puis cliquez

sur le bouton Chapter Editor et demandez Chapter 
Editor > New chapters.

�Plus bas, dans le champ Name, donnez un titre 
au premier chapitre. À présent, vous pouvez passer 

à la création du deuxième chapitre en appuyant sur 
le bouton Add chapter. Recommencez les manipulations
effectuées à l’étape précédente.

�Il ne reste plus qu’à placer les chapitres dans 
la vidéo MKV. Demandez Chapter Editor > 

Save to Matroska file. Dans le dialogue qui s’affiche, 
sélectionnez votre film.

	Pour tester le résultat, ouvrez le document MKV
dans QuickTime 7 (doté du module Perian). Dans 

le coin inférieur droit du lecteur, un menu déroulant vous
donne un accès direct aux différentes scènes de votre
film.

�Ouvrez le film MKV à l’aide du lecteur QuickTime 7,
VLC ou MPEG Streamclip. Cette étape va servir à 

repérer les endroits de la vidéo où les futurs chapitres 
seront placés. Le code temporel est exprimé en hh:mm:ss.

�Dans le panneau Chapter Editor de MkvToolNix, 
cliquez sur Add chapter. Dans le cadre en haut 

de la fenêtre, sélectionnez « (unnamed) [und] ». 
Dans le champ Start, entrez le code temporel marquant 
le départ du premier chapitre.

Vous venez de finaliser plusieurs montages vidéo avec iMovie ’09, il est temps de les rassembler 
dans un seul fichier MKV, puis d’ajouter les informations de chapitres.
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V
ous ne connaissez pas HandBrake?
C’est vraiment dommage! Cet en-
codeur vidéo spécialisé prend en
charge les séquences vidéo de type
AVI, Mov, DivX, MTS, Vob, …, et même

les dossiers VIDEO_TS provenant d’un DVD-
vidéo. Il sait produire en sortie un document
MPeg-4 compatible avec nombre d’appareils
domestiques, du baladeur à l’ordinateur en
passant par l’Internet. Toutefois, certains
codecs (notamment ceux provenant d’Apple,
le Pixlet par exemple) manquent à l’appel.
Par ailleurs, il s’avère capable de lire les vidéo-
grammes du commerce directement depuis
le lecteur optique du Mac. Mais afin qu’il puisse
travailler de façon optimale, HandBrake né-
cessite la présence du lecteur VLC (www.videolan.
org/vlc/download-macosx.html)dans le dossier
Applications de votre Mac.

CHOISISSEZ LA BONNE VERSION
Si votre Mac supporte l’exécution des pro-
grammes en mode 64 bits (Intel Core 2 Duo
ou plus), vous trouverez alors en télécharge-
ment une version optimisée sur le site officiel
(http://handbrake.fr/downloads.php). La langue
anglaise vous handicape? Une version traduite
dans la langue de Molière est disponible sur
le site MacLocal (http://maclocal.free.fr/tele
chargement). Mais dans les deux cas, il vous fau-
dra également placer dans le dossier Applica-
tions le lecteur VLC en version 64 bits – obli-
gatoire pour lire les DVD du commerce. Cette
dernière est à dénicher sur le site MacLocal ou
bien en version originale à cette adresse: http://

nightlies.videolan.org/
build/macosx-intel/ (cli-
quez sur l’un des liens
portant comme en-tête
1.0-branch-intel64). À titre
d’information, l’enco-
dage sur un Core 2 Duo
2,8 GHz est environ 1,5
fois plus rapide qu’en
mode 32 bits.

LES PREMIERS
RÉGLAGES
Rendez-vous maintenant
dans le menu HandBrake
> Preferences > Audio, et
demandez dans le menu local Langage par dé-
faut > Français. En bas du panneau Preferences
> General, cochez également les cases Nom
automatique (si vous souhaitez que le nom
du fichier soit automatiquement attribué en
fonction du document source) et Extension
iPod/iTunes… .

COMMENT ÇA MARCHE?
À chaque démarrage, un dialogue s’ouvre, qui
vous réclame un document vidéo ou un dossier
VIDEO_TS provenant directement d’un DVD.
Si d’aventure vous avez refermé cette fenêtre
par mégarde (bouton Annuler), il vous suffit
d’appuyer sur le bouton Source pour pouvoir
importer une nouvelle séquence vidéo. Une
analyse complète du média est alors effectuée.
Si l’interface demeure grisée, c’est que le clip
ou le film que vous souhaitez encoder n’est
pas reconnu par HandBrake.
Dans le tiroir, sélectionnez le préréglage cor-
respondant au matériel destiné à lire la vidéo
(iPod, iPhone…). Dans le cas d’une lecture sur
votre ordinateur, optez pourApple > Universal.
Si le tiroir n’apparaît pas d’emblée, cliquez sur
le bouton Préréglages – ou Toggle Presets
en version anglaise.
Comme option de sortie, dans le menu local
Format , deux types de conteneurs sont
proposés : MP4 file pour le MPeg-4 ou MKV
Filepour le Matroska. Le choix de l’un ou de

l’autre n’influence en rien la qualité de com-
pression. Le premier s’adresse aux produits
Apple ou à la diffusion Internet, tandis que le
second est plus adapté à l’échange avec des
ordinateurs sous Windows ou à une lecture
de salon (via un médiacenter).
Cinq boutons (Vidéo,Audio, Sous-titres,
Avancées etChapitres)permettent d’affiner
les paramètres de compression, d’intégrer des

sous-titres ou encore d’autoriser le chapitrage
automatique de vos films. Dans la barre d’ou -
tils, l’onglet Réglages de l’image assure le re-
cadrage d’une séquence et le désentrelace -
ment de l’image. Le boutonFenêtre d’aperçu
vous offre la possibilité d’inspecter le contenu
de la vidéo, et même de tester in situ la qualité
d’encodage (Aperçu ) sur un échantillon
allant de 5 à 60 sec. nDavid A. Mary
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Encodage vidéo facile 
avec HandBrake
� Multiplate-forme et open source, HandBrake 
est le meilleur encodeur gratuit. �
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Encodez vos vidéos en un clin d’œil

�À l’ouverture de HandBrake, sélectionnez 
une séquence ou bien le dossier VIDEO_TS d’un DVD.

Si la vidéo le permet, vous pouvez aussi spécifier 
les chapitres qui doivent être encodés.

�Dans letiroir, choisissez le préréglage du matériel
de diffusion (Apple TV…). Pour l’Internet (podcast),

choisissez iPhone & iPod Touch, puis cochez la case Web
optimized dans l’interface principale.

�Pour une diffusion sur Apple TV ou tout autre mé-
diacenter compatible 5.1, dans la section Audio,

ajoutez une seconde piste en français (AC3 5.1) avec 
AC3 Passthru en codec audio pour l’option de mixage.

�Dans la section Sous-titres, sélectionnez 
éventuellement un sous-titrage dans la langue 

de votre choix, via le menu local idoine. S’il provient d’un
DVD-vidéo, le sous-titrage sera alors incrusté 
définitivement dans l’image après encodage.

�Deux modes d’encodage sont à votre 
disposition. Si vous souhaitez procéder à un 

traitement immédiat, cliquez sur le bouton Encoder
dans la barre d’outils.

�Si vous préférez différer l’encodage ou procéder 
à un traitement par lot, cliquez sur le bouton Ajou-

ter à la queue. Chargez ensuite une nouvelle vidéo 
(Source) et procédez aux réglages qui s’imposent.

	Lorsqu’il sera temps de lancer le traitement 
de toutes les séquences mises en attente, cliquez 

sur le bouton Afficher la queue puis, dans la barre 
d’outils de la nouvelle fenêtre, appuyez sur Encoder.

�Pour obtenir un sous-titrage escamotable, 
il vous faut recourir à un fichier externe (fichier

doté de l’extension .srt). Cliquez sur le bouton 
Add External SRT pour l’importer dans HandBrake.

�Si une vidéo est déjà chapitrée (à l’instar 
d’un DVD), vous pouvez personnaliser le nom 

des chapitres. Dans la section dédiée, double-cliquez 
sur chacun d’eux afin de changer leur nom.

De votre vidéothèque personnelle à votre iPod ou Apple TV, HandBrake offre le plus court chemin.
Même l’audio multicanal ne lui fait pas peur !
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L
a vidéo HD sur Mac, c’est
avant tout un florilège de
problèmes auxquels il faut
faire face. Les vidéos sont
enregistrées dans un for-

mat de fichier (MTS, M2T ou TOD)
illisible par l’ordinateur. Pour pro-
céder au montage des clips, Apple
exige que le caméscope soit relié
physiquement au Mac (dans le cas
des appareils AVCHD à mémoire
de masse intégrée) ou que la carte
SDHC ayant servi au tournage soit
insérée dans le lecteur idoine. D’au-
torité, iMovie et Final Cut Express
réencodent les fichiers d’origine
avec le codec Intermediate d’Apple.
S’il permet le montage à l’image
près sans épuiser les ressources
processeur, il dégrade aussi sensi -
blement la qualité d’image, contrai-
rement à d’autres formats.
Le format de tournage dit «pro-
gressive scan» est boudé par l’ap-
plication iMovie ’09. Les films HD
transférés sur DVD ont une qualité
d’image médiocre. Enfin, il pourra
arriver que votre caméscope (ou
photoscope) HD ne soit tout bon-
nement pas reconnu par le logiciel
de montage. Plutôt embêtant…
Pour contourner ces limites et dif-

ficultés, j’ai mis au point une mé-
thode pour mes besoins personnels,
qui assure une compatibilité avec
iMovie ’09, ainsi qu’une moins
grande dégradation de l’image pen-
dant le montage et l’exportation
finale. J’ai pensé que cela serait
bien de la partager avec vous!

DÉRUSHEZ SANS PERTE
DE QUALITÉ
Si vous avez un caméscope FireWire
(au format HDV, par exemple), vous
pouvez dérusher directement en
MPeg-2 à l’aide d’un utilitaire Apple
destiné aux développeurs :
DVHSCap (http://mac.soft
pedia.com/get/Developer-Tools/Apple-
FireWire-SDK-X.shtml).
Une fois le caméscope relié au Mac,
ouvrez l’utilitaire. Lancez la lecture

, puis appuyez sur le bouton
Capture from D-VHS/Stop Capture

. Donnez un nom à la capture
vidéo dans la fenêtre de dialogue
qui surgit. L’acquisition achevée,
vous obtenez sur votre disque dur
un fichier M2T que vous pourrez
transcoder par la suite.
Vous avez un caméscope ou un pho-
toscope AVCHD? Bonne nouvelle,
vous pouvez dorénavant copier di-
rectement sur le Mac les fichiers
MTS contenus dans la mémoire de
votre appareil.

ENCODEZ AVEC
FFMEDIA BROADCAST
Pour encoder les rushes dans un
format destiné au montage, il faut
un moteur de transcodage univer-
sel. Le meilleur choix en la matière
demeure FFMpeg dont il existe des
déclinaisons pour le montage pro-
fessionnel. Cela permet de recourir

à des codecs pas ou peu destructifs
comme Huffyuv (reconnu par Final
Cut) ou MJpeg (compatible avec
iMovie ’09). C’est ce dernier que
j’emploierai dans les exemples qui
vont suivre…
Commencez par installer les outils
développeurs depuis le DVD d’ins-
tallation de Mac OS X. Téléchargez
la version 0.3 de FFMedia Broadcast
(FFmbc), développé par Baptiste
Coudurier (http://code.google.com/
p/ffmbc/downloads/list). L’archive dé-
compactée, déposez le dossier sur
votre Bureau, puis ouvrez le Termi-
nal (Applications/Utilitaires).
Vous allez compiler FFmbc de la
manière suivante…
Tapez l’instruction cd suivie d’une
espace. Glissez-déposez dans la fe-
nêtre du Terminal le dossier conte-
nant FFmbc. Le chemin vers le ré-
pertoire va s’afficher sans au-
cune erreur de frappe. Tapez suc-
cessivement ./configure [Entrée], puis
make [Entrée]. Une suite ininterrom-
pue de lignes de code va défer-
ler dans la fenêtre pendant près

d’une minute. La compilation est
terminée; l’exécutable Unix ffmpeg
apparaît alors dans le dossier FFmbc

. Déplacez ffmpeg sur votre Bu-
reau : il va servir de base pour la
création d’un processus d’encodage
Automator, com me je vous l’ex-
plique dans la page de droite…
nD. A. Mary
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La Haute Définition 
pour tous!
� Lorsqu’il s’agit de monter des films en haute définition, nombre de difficultés surviennent. 
Heureusement, il existe des remèdes à tous ces tracas! �

Au passage, voici la formule magique pour transformer n’importe quel fichier
.m2t ou .mts en document QuickTime (.mov)…

ffmpeg -i [chemin vers mon fichier MTS] -acodec pcm_s16le -ac 2 -vcodec mjpeg -qscale 1 
-s 1920x1080 [chemin vers la video encodée].mov

Cela signifie que ffmpeg a ordre de transcoder l’audio du fichier MTS au format
PCM 16 bits Little Endian (-acodec pcm_s16le), en stéréo (-ac 2), et d’encoder
la vidéo avec le codec MJPEG (-vcodec mjpeg) en qualité maximale (-qscale 1)
pour un format d’image de 1920 x 1080 (-s 1920x1080).

VIDÉO054
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Concevez votre propre encodeur vidéo

�Lancez Automator, choisissez Applications. Dans la
barre latérale, depuis la rubrique Utilitaires, glissez

le processus Exécuter un script AppleScript vers la zone
d’édition des enchaînements.

�Remplacez (* Your script goes here *)
par les instructions ci-dessus. Définissez le chemin

vers le fichier haute définition original (variable « ori-
gine ») ainsi que son nom (variable « nom_du_clip »).

�Créez une fenêtre de requête pour définir sur 
le disque dur le lieu où sauvegarder les vidéos 

encodées. Le nom de la nouvelle séquence est établi à
partir du nom du rush d’origine.

�Afin que l’application Automator soit portable 
d’un ordinateur à un autre, précisez que FFMPeg

sera rangé dans le dossier Contents du programme.

�Terminez le script avec les instructions de la 
capture ci-dessus. Ajoutez comme second proces-

sus, Remplacer du texte dans les noms d’éléments du
Finder.

�Positionnez le premier menu local sur Remplacer 
du texte. Recherchez le signe « / », à remplacer par

« - » pour éviter des erreurs dans la prise en charge du
nom des fichiers par iMovie. Enregistrez l’application.

	Dans le Finder, faites un clic-droit dessus, 
demandez Afficher le contenu du paquet et 

glissez l’exécutable ffmpeg dans le dossier Contents.
Déposez une vidéo sur le « petit robot encodeur » pour 
débuter l’encodage.

�Récupérez la date du jour ainsi que l’heure, 
à ajouter au nom du fichier vidéo encodé. Cela faci-

litera plus tard le tri des rushes.

�Place à l’encodage proprement dit. Le script shell 
ci-dessus est destiné aux vidéos en progressive

scan ou n’ayant pas besoin d’être désentrelacées.
Pour les vidéos en 1080i (format entrelacé), ajoutez 
l’instruction -deinterlace avant -vcodec.

Automator et quelques lignes d’AppleScript suffisent pour créer une application d’encodage,
très basique, mais qui rendra de fiers services.

055
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U
n travail de montage cohérent passe
par une organisation sans faille des
médias. Aussi, prévoyez un espace
de stockage de très grande capacité,
surtout si vous disposez d’une ca-

méra haute définition. Un disque dur externe
(7200 tours/min connecté en Firewire 800) de 

1 To dédié à cette activité ne sera pas de trop
pour stocker vos films de famille. Afin d’éviter
toute déconvenue, je vous suggère le flux de
production suivant…
Lancez Premiere Elements 9 afin de procéder à
l’importation de vos vidéos. Recourez à Organizer
pour classer les clips et ajouter des mots-clés. Les
rushes seront automatiquement rassemblés aux
côtés de leur projet de montage respectif et cela
facilitera leur archivage ultérieur ainsi que le par-
tage du projet de montage d’un ordinateur à un
autre (Mac ou PC Windows).

L’ÉTAPE PRÉLIMINAIRE
Dans la fenêtre d’accueil de Premiere Elements,
demandez tout d’abord Nouveau projet. Donnez
un nom à votre projet.
Au-dessous, cliquez sur le boutonParcourirpour
indiquer l’endroit où l’importation de vos clips va
s’effectuer. Appuyez ensuite sur le bouton Nouveau
dossier et nommez le dossier en relation avec
votre projet de montage pour faciliter toute re-
cherche ultérieure depuis le Finder. Cliquez suc-
cessivement sur Créer, puis Sélectionner.
En bas, appuyez sur le bouton Modifier les para-
mètres, puis sur le fichier de préconfiguration en
rapport avec votre matériel (HDV, AVCHD) et vos
conditions de tournage (HDV 1080i 25, AVCHD
Lite 720p 25). Certains intitulés ne sont pas tou -
jours explicites. Pour le mini-DV, il faudra ainsi ex-
plorer le dossier Interface DV > 48 KHz standard
(pour un écran 4:3) ou Grand écran 48 KHz (pour
un écran 16:9). Pour un reflex numérique, vous
devrez examiner le dossier DSLR.

MINI-DV ET HDV
Ceci fait, passez dans l’onglet Organiserde Pre -
miere et cliquez sur Obtenir le média > Caméscope
DV ou Caméscope HDVselon votre modèle. Dans

le champ Nom de l’élément, donnez un nom gé-
nérique à vos rushes. Au-dessous, dans la section
Acquisition, cochez les cases Acquisition sur la
fenêtre Montage et Scinder les scènes par Code
temporel . Pour mémoire, ces options sont
valables pour le mini-DV uniquement.

DÉTECTION DE SCÈNE EN HDV
Adobe n’ayant pas implémenté un module d’im-
portation aussi perfectionné que dans Premiere
CS5, les propriétaires de modèles HDV devront
utiliser VideoPier HD (www.aquafadas.com/fr/videopier)

pour bénéficier de la détection de scènes. Dans
la colonne Sourcesdu logiciel VideoPier HD, sé-
lectionnez votre caméra. En bas, cliquez sur l’icône

Capture, puis demandez Créer une nouvelle source
. Dans la fenêtre de capture, à l’intérieur du

champ Préfix, nommez votre projet. Cliquez sur
le bouton Choisir. Dans le dialogue, sélectionnez
comme dossier d’accueil celui du projet de mon -

tage Premiere précédemment créé. Cochez les
cases Scinder les clips aux changements de scène
et Prévisualiser pendant l’enregistrement .
Retournez dans Premiere Elements pour référen -
cer les rushes à l’intérieur du projet de montage.
Dans l’onglet Organiser, cliquez sur l’icône Projet.
Faites un clic-droit à l’intérieur du panneau, puis

demandez Obtenir le mé-
dia de > Fichiers et dossiers
d’ordinateuret sélection-
nez le dossier contenant
les rushes.

CAMÉSCOPES AVCHD
ET PHOTOSCOPES
Cette étape préliminaire
accomplie, passez dans l’on-
glet Organiser, choisissez
Flip, AVCHD, caméscopes
et téléphones. Sélectionnez
le dossier d’accueil de vos
rushes en cliquant sur l’icô -
ne de dossier en regard de
la mention Enregistrer

dans. Décochez la case Ajouter au montage .
Dans le cadre gauche de la fenêtre, décochez les
séquences que vous ne souhaitez pas importer,
puis cliquez en bas à droite sur Obtenir le média.
nD.A. Mary
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� Pour que le dérushage ne soit
plus qu’une simple formalité,
voici quelques con seils et 
méthodes à adopter. �

Premiere Elements 9
L’acquisition vidéo

VIDÉO056
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Du dérushage à l’organisation de la vidéothèque

�Dans Adobe Organizer, si les clips vidéo ne présentent
qu’une vignette de prévisualisation générique, 

deman dez Édition > Tout sélectionner, faites un clic-droit sur
l’une des vignettes, puis demandez Mettre à jour la vignette.

�Cliquez sur le bouton +, puis demandez dans le menu
local Nouvelle étiquette de mots-clés. Sélectionnez

la catégorie Événements et tapez le nouveau mot-clé à 
l’intérieur du champ Nom.

�Pour associer un mot-clé à une vidéo, il suffit de 
déposer l’étiquette de mots-clés sur la vignette de 

prévisualisation du clip. Puis, pour opérer un tri des clips, 
cliquez sur la case en regard du ou des mots-clés de 
votre choix.

	L’option d’analyse automatique permet à Organizer
d’attribuer des mots-clés de façon dynamique en 

fonc tion du contenu des séquences (une option non 
compatible HDV). Pour cela, faites un clic-droit sur le clip pour
demander Exécuter l’analyse automatique.

�Cliquez sur Affichage dans le coin supérieur droit, puis
demandez Emplacement du dossier. Sélectionnez le

projet de montage en cours dans la colonne latérale, puis 
ap puyez sur le bouton Créer un album instantané.

�Cliquez sur le nom du nouvel album dans la colonne de
droite et demandezÉdition > Désélectionner.

Passons à présent à l’ajout de mots-clés. Rendez-vous pour
cela en bas de la colonne latérale droite.

Pour gérer de manière rationnelle les séquences vidéo importées dans Premiere Elements 9, faites
donc appel à Adobe Organizer !
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�Une fois l’acquisition des séquences réalisée, procédez
à leur visionnage dans Premiere. Depuis l’onglet 

Organiser > Média, déroulez le menu local Filtrer par et 
demandez dans la rubrique Projets le nom du projet de 
montage en cours.

�Double-cliquez sur chacune des vignettes pour 
procé der à leur examen… Placez, si vous le souhaitez,

les points d’entrée et de sortie de chaque plan en faisant 
glisser les deux poignées dédiées.

�Ajoutez à chaque clip une note de 1 à 5 étoiles en 
fonc tion de critères techniques ou artistiques pour 

faciliter le travail de montage ultérieur. Cliquez sur le bouton
Organiseur situé dans le coin supérieur droit de l’interface.
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D
ropbox (https://www.dropbox.com/home)
est un service de stockage en ligne,
gratuit dans la limite de 2 Go, dont le
contenu est synchronisé sur plusieurs
ordinateurs, smartphones et autres

appareils, tel l’iPad. Vos données sont quelque
part dans le nuage (clouden anglais), mais vous
ne savez pas sur quel serveur exactement. Peu
importe! Dropbox n’est pas forcément très original
(certains lui préfèrent SugarSync), mais son inté -
gration avec Mac OS X est très bien pensée.
L’accès aux données peut s’effectuer depuis un
logiciel à installer sur les ordinateurs et périphé-
riques mobiles. Ces clients Dropbox existent sur
Mac, iPhone et iPad (Windows ou Linux itou). On
peut aussi accéder aux fichiers via une page In-
ternet sécurisée, avec les navigateurs les plus
courants. Dropbox propose donc un accès univer -
sel à tous les fichiers que vous placerez dans votre

Dropbox. Il en assure aussi la synchronisation.
Lors de l’installation de Dropbox, un dossier épo-
nyme est créé sur votre Mac dont le contenu sera
répliqué sur Internet et tout autre matériel équipé

d’un client Dropbox. Bien entendu, tout est sécu -
risé: votre compte est protégé par un identifiant
et un mot de passe et toute transaction est chiffrée.
Dropbox utilise aussi le service Amazon S3 réputé
pour sa fiabilité et la protection des données.
Tout document placé dans votre dossier Dropbox
sera automatiquement recopié sur tous vos pé-
riphériques intelligents dès qu’une connexion à
Internet peut être effectuée. Même chose après
modification d’un fichier…
Dropbox est gratuit dans la limite de 2 Go, au-
delà il vous faudra payer un abonnement mensuel
de 9,99€ pour un espace de 50 Go. En parrainant
un nouvel utilisateur, vous pouvez gagner 250 Mo
supplémentaires gratuits. Dropbox servant avant
tout à échanger des fichiers de façon ponctuelle,
et non à effectuer une sauvegarde de volumes
entiers en ligne, 2 Go c’est déjà très bien.
Dropbox est devenu très populaire et beaucoup
de développeurs proposent un accès direct à ce
stockage distant depuis leurs applications. C’est
en particulier le cas pour les applications iPhone,
et surtout iPad. Dropbox fluidifie la gestion des
fichiers et évite de passer par iTunes.
nHenri-Dominique Rapin

Installez et utilisez Dropbox sur votre Mac
En quelques écrans, familiarisez-vous avec les fonctions de base de Dropbox sur Mac.
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�Dropbox est un de ces nouveaux services qu’offre désormais Internet.
Il est particulièrement bien intégré à Mac OS X et aux ippareils d’Apple.
Et pour vous en convaincre, voici une suite de quatre Pratiques Express
utiles au quotidien. �

�Ouvrez Safari et rendez-vous à l’adresse www.dropbox.
com. Suivez le lien Download Dropbox. Le logiciel est en

anglais, mais son interface est tellement simple que, aidé en sus
par nos Pratiques, vous n’aurez aucun problème à utiliser ce
service!

�L’image disque (fichier .img) s’ouvre automatiquement à
la fin du téléchargement (sinon, ouvrez-la depuis le 

dossier Téléchargements). Déplacez l’icône Dropbox bleue en
forme de boîte ouverte vers votre dossier Applications. Voila, 
il n’y a rien de plus à faire.

�Au tout premier lancement, Dropbox propose de créer
un compte. Suivez la procédure (I don’t have a Dropbox

Account) : vous obtiendrez un disque virtuel de 2 Go gratuit.
Seules la déclaration d’une adresse email valide et la création
d’un mot de passe sont nécessaires, nul besoin de carte 
bancaire. Il vous sera ensuite proposé de créer un dossier, placé
par défaut dans votre dossier personnel – ne modifiez pas les
réglages proposés. Cliquez sur Continue pour passer d’écran 
en écran.

Dropbox
Vos fichiers toujours disponibles
sur Mac, iPhone ou iPad!

Internet058
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�Après ce premier lancement, Dropbox va installer son
icône à plusieurs endroits. Tout d’abord, dans la barre

des menus: cliquez dessus et ouvrez les Preferences… En bas
de la fenêtre, vérifiez que certaines options sont bien activées.
La première utilisera Growl pour afficher les alertes, la seconde
lancera Dropbox au démarrage. La troisième option, Enable Lan
sync, permet une optimisation de l’utilisation du réseau.

�Le dossier Dropbox de votre Mac se comporte
tout comme un répertoire. Pour y placer un 

document, vous l’y glissez ou l’y copiez. Il n’est pas 
nécessaire de dupliquer vos fichiers. Toutefois, il
conviendra, pour les fichiers importants que vous 
glissez dans le dossier Dropbox, d’en conserver une 
copie à un autre endroit…
Il faut bien comprendre que si vous supprimez sur votre
MacBook, autorisé sur le même compte Dropbox, un 
fichier du dossier Dropbox, il disparaîtra aussi de votre
iMac dès que la synchronisation sera effectuée par le
logiciel. En réalité, vous ne faites rien, c’est Dropbox qui 
s’occupe de tout. Dès qu’il détecte un nouveau fichier,
ou même un nouveau dossier dans son dossier 

Dropbox, il effectue une copie des éléments sur les 
serveurs Dropbox présents sur Internet. Puis, dès qu’un
ordinateur autorisé sur le même compte interroge le
serveur afin de connaître les modifications apportées
au dossier Dropbox, les nouveaux fichiers et fichiers
modifiés sont récupérés, les fichiers supprimés ailleurs,
détruits aussi… Bref, votre fichier est présent sur votre
ordinateur fixe, sur les serveurs sur Internet et sur tous
vos ordinateurs et ippareils ou smartphones connectés.
Les dossiers synchronisés sont marqués d’une petite
icône verte. Les fichiers non encore synchronisés ont,
eux, une icône bleue et un symbole de synchronisation.
Tant que le symbole n’est pas vert, le fichier n’est pas
synchronisé avec vos autres ordinateurs.

�Dropbox a créé sur votre Mac un dossier portant son
nom, automatiquement synchronisé avec votre espace

sur Internet et avec tous les autres ordinateurs ou ippareils 
disposant également de Dropbox. Pour accéder à ce dossier, 
cliquez sur Dropbox dans la barre des menus et demandez
Open Dropbox Folder. Ou bien, lorsqu’une fenêtre du Finder est
ouverte, choisissez le dossier Dropbox dans la barre latérale.

�Les fenêtres du Finder possèdent une barre d’outils que
vous pouvez personnaliser. Dropbox ajoute de lui-même

une icône à la droite du bouton Actions (la roue crantée), une
autre façon d’accéder directement à votre dossier Dropbox. Cer-
tains préféreront passer par le Dock; il suffit de glisser l’icône
du dossier Dropbox dans sa section droite.
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Éditez un fichier MS Office sur votre iPhone ou iPad

�La première opération consiste à placer dans votre 
dossier Dropbox un document à un format de la suite

Office de Microsoft. Ils peuvent être au format le plus récent,
dotés des exten sions .docx ou .xlsx, ou au format plus ancien
.doc et .xls.

�Sur votre iPhone/iPod Touch/iPad ou via iTunes, achetez
l’application Quickoffice. Plusieurs versions existent,

mais celle qui intègre l’accès à Dropbox est la plus chère: Quick
Connect Mobile Suite (7,99€, 12€ pour iPad). Notez qu’il existe
d’autres suites équivalentes, notamment Documents To Go qui,
elle aussi, offre un accès à Dropbox (9,99€, app universelle).

�L’utilisation de Quickoffice demande la création d’un
compte sur le site de l’éditeur. Dans la section 

Préférences de l’application, cliquez sur le bouton Connexion,
sous la mention Compte: non connecté. Entrez une adresse
email ainsi qu’un mot de passe pour votre compte Quickoffice.

   
    

En utilisant conjointement Dropbox et Quickoffice, la tâche est très simple. De plus, Dropbox est un outil
collaboratif : un collègue peut déposer un fichier dans le dossier Public de votre Dropbox (pour autant
que cet accès soit autorisé).
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Lisez des PDF avec Dropbox et GoodReader sur iPad

�Ensuite, cliquez sur un lien placé dans le corps de l’email
de confirmation que vous avez reçu et connectez-vous

sur le site. Cela pourrait bien entendu être plus simple, mais
l’éditeur du logiciel veut absolument que l’utilisateur 
s’enregistre pour activer tous les services.

��Sélectionnez maintenant un 
document Word ou Excel. Une fois

ledit document ouvert, vous pouvez le modifier
directement dans l’interface de Quickoffice. 
Les fichiers pris en compte sont de type Word
(.doc), Excel (.xls) et PowerPoint (.ppt).
Une fois votre fichier modifié, enregistrez-le.
Il va alors être immédiatement synchronisé (si
une connexion Internet est active, par 3G ou
WiFi) avec les serveurs de Dropbox, puis sur
tous vos ordina teurs ou périphériques mobiles.
Si vous le laissez dans votre dossier Public, il
pourra être récupéré ou consulté par vos 
divers collègues ou partenai res autorisés.

�Votre compte Quickoffice est désormais activé. Vous
avez accès à plusieurs services dont MobileMe et 

Dropbox. Dans la fenêtre principale, cliquez sur le bouton 
Modifier. Apparaissent alors deux icônes: la première en jaune
donne accès au contenu de votre iPhone ou iPad, tandis que la
seconde permet d’utiliser un service Internet. Optez pour cette
dernière et tapez sur le signe Plus, puis choisissez Dropbox. 
Entrez ensuite votre compte et votre mot de passe Dropbox.

�Une fois les réglages terminés, vous accéder aucontenu
du disque en ligne Dropbox. Pour cela, revenez sur le

premier écran de l’application. Une nouvelle icône est apparue,
c’est celle de Dropbox. Tapez dessus pour naviguer dans les
dossiers et documents de votre dossier Dropbox.

Pour la lecture de PDF, l’utilisation conjointe de Dropbox et GoodReader offre une grande efficacité et
une indépendance vis-à-vis d’iTunes.
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�L’application GoodReader pour iPad valait, lorsque j’ai
écrit cet article, 0,79€, tout comme la version iPhone. 

À ce petit prix, cela aurait été dommage de rater les fonctions
supplémentaires qu’elle apporte à l’iPad!

�GoodReader sait afficher plusieurs types de fichiers, mais
se démarque des autres applications par sa capacité à lire

des PDF gros et sophistiqués. Le rendu est superbe et les options
de navigation, nombreuses. Glissez un ou plusieurs fichiers PDF
dans votre dossier Dropbox, ils seront synchronisés.

�L’interface de la version iPad est différente de celle de la
version iPhone; elle tire parti de tout l’écran de la 

tablette. La colonne de gauche liste les fichiers, celle de droite
donnant un accès aux informations ou aux emplacements 
des fichiers. Une présentation très agréable à l’usage…

Internet060
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Jouez la synergie Dropbox-1Password

�La version Pro de 1Password Mobile coûte 11,99€ sur
iPad. C’est cher pour un simple utilitaire, mais il vous

simplifiera la vie en regroupant tous vos mots de passe 
et autres secrets en un lieu sûr.

� Il est indispensable d’utiliser sur Mac la dernière version
3.3.0 ou supérieur. Lancez 1PassWord Mac… Dès que le

mot de passe principal a été saisi, ouvrez les préférences de
l’application (menu 1PassWord > Préférences).

�Dans la section Fichier de données, cliquez sur le bouton
Move, puis désignez votre dossier local Dropbox ou un

dossier à l’intérieur de celui-ci pour y déplacer la base de don-
nées de 1PassWord et la synchroniser via Internet.

�Si vous n’avez pas créé de base, essayez dans un 
premier temps de la synchroniser via WiFi – pour cela, 

il faut que l’application soit ouverte sur le Mac. Dans le cas
contraire, vous pouvez créer une base sur votre iPhone, 
plusieurs mots de passe vous seront demandés.

�Cliquez sur l’icône Settings en bas à gauche, puis sur
Sync (icône orange). L’icône Dropbox devrait être grisée

et pla cée sur Off. Tapez dessus pour activer la synchronisation
avec Dropbox: vos identifiant et mot de passe Dropbox vous 
seront demandés. Tapez sur Sync Now.

�Dans le menu principal, cliquez sur Logins pour retrouver
vos mots de passe Internet. Vous pouvez les copier pour

les utiliser dans Safari ou simplement les révéler (Reveal). 
Cela dit, le plus simple est d’utiliser 1PassWord pour naviguer sur
les sites protégés par mot de passe sans passer par Safari. 
Sélectionnez un site dans 1PassWord et cliquez sur la flèche 
située à droite: le site s’ouvrira sur la page d’authentification et
l’identifiant et le mot de passe seront saisis automatiquement…

�Dans la colonne de droite, tapez sur la section Connect
to Servers, puis sur Add. Dans la liste, tapez sur l’icône

de Dropbox. Saisissez l’identifiant et le mot de passe de votre
compte, donnez un nom à l’espace Dropbox que vous utilisez.
Chose faite, tapez sur Done.

�Lorsque vous avez sélectionné un fichier PDF, celui-ci
est téléchargé en local dans la base de documents de

Good Reader. La lecture n’est donc pas instantanée, mais cela
permet également de consulter les ouvrages et documents en
mode déconnecté d’Internet.

�Une fois lu, vous pouvez supprimer le fichier PDF de la
base de documents locale en tapant sur l’icône 

Poubelle (le bouton rouge). Le fichier est supprimé de l’iPad,
mais pas de votre Dropbox! Une solution idéale.

1Password pour Mac et sa version Pro pour iPad et iPhone peuvent désormais utiliser le fichier des
mots de passe localisé sur Dropbox. Idéal pour synchroniser ce fichier entre plusieurs ordinateurs.
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M
ême si les réseaux so-
ciaux, Facebook et
Tweeter en tête, ont
bousculé quelques
habitudes dans les

campagnes de communication,
les bandeaux publicitaires sont en-
core un moyen efficace pour faire
la promotion de biens et services
sur Internet.
Si vous êtes à la tête d’une petite
entreprise ou d’une association,
vous n’avez sans doute pas dans
votre équipe un virtuose de la pro-
grammation Flash. C’est en partant
de ce constat que l’éditeur mont-
pelliérain Aquafadas (PulpMotion,
iDive…) a conçu une solution logi -
cielle intuitive à prix budget.
Dans cette deuxième version de
BannerZest, deux innovations prin-
cipales sont à souligner. En version
standard (37€), le logiciel intègre
désormais la possibilité d’ajouter
une musique d’illustration. Pour
ce qui est de la version Pro (89€),
les bannières produites peuvent
être déclinées dans un format lisi -
ble par un iPhone.

PERSONNALISATION POUSSÉE
Ouvrez BannerZest, puis déposez
sur l’unique palette les images
nécessaires à l’élaboration de la
bannière. Il n’est pas utile de pro-
céder à un découpage préalable
ni à une mise à l’échelle des clichés,

BannerZest dispose de son propre
éditeur bitmap , minimal mais
suffisant. Tous les formats graphi -
ques reconnus par Mac OS X sont
acceptés, y compris les fichiers
bruts de capteur (Raw) provenant
d’appareils photo reflex et bridge.
Ceci fait, la personnalisation de vo-
tre bannière commence.

Dans la palette flottante Inspecteur,
vous choisissez l’habillage graphi -
que qui convient. 32 thèmes sont
offerts en version de base . Ban-
nerZest Pro propose un pack d’ha-
billages supplémentaires et vous
offre même la possibilité d’en créer
de nouveaux! Un kit de dévelop-
pement est mis gracieusement à
votre disposition par Aquafadas.
La présentation s’effectue princi-
palement en mode paysage ou
carré, et pour quelques rares
thèmes (trois au total) en mode
portrait. Dans le panneau dédié

, vous affinez l’ensemble des
réglages, qu’il s’agisse de la couleur
des titrages, les polices de carac-
tères utilisées, la couleur de fond
d’écran ou la personnalisation des
éléments du thème graphique.
Tous ces réglages peuvent parfai-
tement être mémorisés en prévi-
sion d’un projet ultérieur (Préré-
glage > Ajouter un Préréglage).
En version de base, BannerZest

réalise des bannières publicitaires
composées d’une ou plusieurs
photos en rotation. La version Pro
permet de lier chaque image que
contient la bannière à une adresse
Internet. Aussi, vous pouvez, au
sein d’une même animation Flash,
cumuler sans mal plusieurs messa -
ges. Mieux, au-delà de la publicité,
BannerZest pourra être détourné
pour illustrer sur un blog les der-
nières actualités, chaque écran
renvoyant vers l’article qui lui est
consacré. Et comme avec PulpMo-
tion dont BannerZest reprend une
partie du design et de l’ergonomie,
vous réaliserez des diaporamas
familiaux ou des «books» interac-
tifs pour les photographes de
mode, de portrait ou de paysage.

Pour la mise en ligne, BannerZest
s’accommode tout aussi bien
d’une publication dans un dossier
local que sur un espace distant, via
FTP ou MobileMe. Le paramétrage
des comptes s’opère dans les Pré-
férences de l’application, panneau
Serveurs.
Le meilleur moyen de se faire une
idée des possibilités d’un tel outil
est de l’utiliser. Ce que nous allons
faire sans plus tarder, en page de
droite…nDavid A. Mary
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� BannerZest est un petit logiciel malin, facile d’accès, qui permet de créer 
des bannières de publicité ou autres en quelques clics. �
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Du peps dans les bannières avec
BannerZest
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Intégration parfaite avec iWeb et MobileMe

�Choisissez le ou les images à intégrer à la bannière
à glisser sur la palette flottante de BannerZest. 

Dans l’Inspecteur, panneau Thème, choisissez l’habillage
graphique qui convient le mieux à votre projet.

�Dans Inspecteur > Média,  placez les informations
utiles face aux cadres de chaque photo. Envisagez 

le cadre texte supérieur comme titre principal de votre
bannière, et le cadre inférieur comme un sous-titre.

�Si nécessaire, procédez au recadrage de chaque
image en appuyant sur le bouton idoine situé 

dans la palette Inspecteur > Média, ou bien celui placé
dans la barre d’outils.

�Utilisez la réglette pour ajuster la taille de l’image.
Déplacez ensuite la photo à l’aide de la souris afin

d’affiner son placement dans le cadre. Cliquez sur le 
bouton Appliquer (en bas à droite de l’Éditeur) pour 
valider les modifications.

� Dans le panneau Publication, déroulez le menu 
local Serveur > Éditer la liste de serveurs. Dans

la nouvelle fenêtre, cliquez sur le bouton + situé en bas 
à gauche de l’écran. Sélectionnez MobileMe dans le menu 
contextuel. Le compte se paramètre tout seul.

� Palette Inspecteur toujours, indiquez dans le
champ Sous-dossier le chemin suivant :

/Sites/Web. Cochez la case Convertir les images en
JPeg. Cliquez sur Publier. Puis sur le bouton Afficher
HTML : une palette vous proposera le code à intégrer 
dans iWeb.

	 Dans iWeb ’09, déposez le widget Fragment HTML 
à l’endroit où devra être affichée la bannière. 

Dans la palette flottante, collez le code informatique
provenant de BannerZest.

�Procédez à l’ajustement de la taille de la bannière 
dans le panneau Réglages > Taille. Habituellement,

un bandeau de publicité pour le Web est d’une taille de
468 x 60 pixels, mais rien ne vous empêche d’utiliser 
d’autres valeurs.

�Ajustez la taille du titre et du sous-titre, 
les polices ainsi que leur couleur respective dans 

les sections correspondantes. Juste au-dessous, 
les options de mise en page contrôlent le placement 
de l’image et des différents titres.

Intégrer une bannière Flash dans son blog n’est pas réservé aux webmestres «pro». 
Vous ne disposez que d’iWeb et d’un compte MobileMe? BannerZest s’adapte à la situation !

063
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I
l existe pléthore de solutions
pour partager le contenu de
sa bibliothèque iTunes, en re-
courant aux fonctions du lo-
giciel ou différents services en

ligne (de Simplify Media à Dot
Tunes). Nicecast, lui, se situe bien
au-delà des besoins domestiques.
Non seulement il diffuse le son pro-
venant de n’importe quel logi ciel
présent sur le Mac, mais en plus il
offre nombre d’outils pour trans-
former le flux audio en une véritable
radio du Web. Avec un budget très
réduit et quelques logi ciels com-
plémentaires, vous pouvez envisa-
ger de faire concurrence aux radios
commerciales de la bande FM, en
proposant à vos auditeurs du talk-
show, du reportage, de l’informa-
tion, de la création radiophonique
(fiction, théâtre…), ou encore des
playlists.

CHOISISSEZ UN COMPAGNON POUR
NICECAST
Si votre souhait n’est que de diffuser
un programme musical préétabli à
l’avance, iTunes sera le complément
idéal. C’est d’ailleurs ce dernier que
je vais employer dans ce Pratique.
Pour un travail de «direct», où les
morceaux sont mixés en temps
réel, je vous conseille de recourir à
DJ MasterMix, DJay ou Disco DJ.
Dans l’hypothèse d’une radio as-
sociative ou tout autre projet sé-
rieux, il vous faudra, en remplace-
ment d’iTunes, un logiciel d’auto-
mation radio plus étoffé.
Le choix sur Mac est assez restreint:
je citerai RadioLogik DJ (http://ma
cinmind.com) ou le très profession -
nel AudioRack Suite (http://red
mountainradio.com/arsuite/). Enfin,

si votre web-radio «pro» diffuse
des titres appartenant au répertoire
de la Sacem, il vous sera sans doute
utile de connaître le montant des
redevances (www.sacem.fr/musi
que/webradios.html).

INSTALLEZ NICECAST
Pour rediriger le flux audio, Nicecast
emploie les modules additionnels
Instant HiJack et SoundFlower (gra-
tuiciel édité par Cycling ’74). Ils s’ins-
tallent automatiquement au lan-
cement du logiciel. Dans la fenêtre
principale de Nicecast,
appu yez tout d’abord
sur la touche Info .
Une fenêtre tiroir ap-
paraît : remplissez les
différents champsqui
permettront à l’audi-
teur d’identifier votre
radio, à savoir son nom,
le type de programme

proposé (pop, rock, jazz…), ainsi
qu’une brève description. Cliquez
ensuite, sur le bouton Source .
Par défaut, l’application de gestion
des listes de lecture est iTunes .
Pour utiliser tout autre logiciel, dé-
roulez le menu local Select et
demandez Select applications.

CONTRAINTES TECHNIQUES
Pour offrir vos programmes musi -
caux à vos auditeurs éparpillés de
par le monde, il vous faut vérifier
que le flux audio est bel et bien dis-

tribué sur Internet. Dans l’application
Nicecast, cliquez sur le bouton Start
Broadcast, puis sur Share, et des-
sous, demandezCheck Now. Si vous
obtenez un message d’erreur, il est
impératif de paramétrer votre box
ADSL.
Au cas où vous utiliseriez NetBarrier
en lieu et place du pare-feu de Mac
OS X, dans la section Règle, optez
pourSans restriction.
Connectez-vous ensuite à la con -
sole de votre modem-routeur avec
un navigateur Internet. Un nom
d’utilisateur ainsi qu’un mot de
passe vous seront demandés (vous
trouverez tous ces renseignements
dans la notice jointe à l’appareil).
Dans un écran généralement intitulé
NAT/Firewall ou NAT/DMZ (situé
dans les paramètres avancés de vo-
tre routeur), ajoutez un tout nou-
veau service que vous nommerez
Nicecast. Le protocole de commu-
nication estTCPet le port adéquat
est numéroté 8000. Indiquez enfin
l’adresse locale de l’ordinateur 
sur lequel est installé Nicecast.
Dernier point : pour connaître le
nombre théorique d’auditeurs si-
multanés que votre ligne ADSL peut
supporter, divisez votre débit mon-
tant (upload) par 8. nDavid A. Mary
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Lancez votre web-radio
avec Nicecast
� Avec iTunes, vous pouviez diffuser le contenu de votre bibliothèque 
à destination de vos proches. Le logiciel Nicecast, lui, vous offre 
la possibilité d’étendre votre auditoire à la Terre entière! �
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De la musique pour votre blog!

� Dans les préférences d’iTunes, panneau Lecture, 
placez le curseur de Lecture en fondu sur 12. 

Cochez la case d’Égaliseur de volume. Validez ensuite 
les modifications.

� Dans une nouvelle liste de lecture, compilez les 
titres de votre choix. Demandez Contrôle > 

Répétition > Tous (la playlist tournera sans interruption).
Lancez la lecture. Dans Nicecast, cliquez Start Broadcast.

�Cliquez sur Quality. Si votre débit montant (upload)
est supérieur à 128k, optez pour High (DSL/Cable

Modem). En choisissant Low, vous pouvez augmenter le
nombre d’auditeurs, au détriment de la qualité d’écoute.

� Appuyez sur le bouton Effects. Dans la colonne de
gauche, appuyez sur le bouton WET. Au-dessous,

faites un clic-droit sur Off et demandez Out Peak. Veillez 
à ce que le volume sonore général n’atteigne jamais 0.

� Dans la section Bands, ajustez les réglettes EQ2 
et EQ4 autour de 3  dB, et EQ3 à 1,4  dB. Pour ce qui

est de la courbe de compression située dans le haut 
de palette, abaissez le point de seuil autour de –21 dB.

� Si vous possédez un plug-in de type limiteur 
« brickwall » (MPL-1 Pro, Elephant ou Max Limiter 

de Sonalksis), ajoutez-le comme second effet. Abaissez
Threshold à un maximum de –6,90 dB. Maximisez 
le volume sonore final (nommé Out ou Ceiling) à –1 dB.

	 Appuyez sur le bouton Share dans l’interface 
de Nicecast. Cliquez sur Save. Le fichier m3u 

obtenu contient l’adresse de votre web-radio, lisible 
depuis iTunes. Il ne reste plus qu’à le proposer 
aux lecteurs de votre blog ou à vos proches.

� Faites un clic-droit sur la case située en haut à
gauche de la palette d’effets, demandez AudioUnit

Effect > Apple > AUMultibandCompressor. Cliquez sur le
bouton Editor pour révéler le panneau de configuration.

� Le son typique des radios FM se compose de graves
et de bas médiums renforcés, avec des fréquences

haut-médiums en retrait. Pour ce faire, optez en bas 
pour le preset Sub Control. Juste au-dessus, cliquez sur
Details.

Donner un cachet «pro» à votre web-radio implique l’ajout d’effets sonores sur le flux audio, 
ainsi qu’un réglage global des fondus enchaînés. Voici comment procéder…
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L
e web de nouvelle géné-
ration (dit « 2.0 ») dans les
premières années de la
décennie entraîna l’appa-
rition progressive de dif-

férentes technologies, dont le lien
de syndication RSS. Il permet au-
jourd’hui à tout un chacun de se
tenir informé des dernières nou-
velles de notre monde. Et le pod-
casting (ou baladodiffusion) est
devenu un nouveau mode de
consommation des médias massif
et populaire. Si Apple n’est en au-
cun cas à l’origine du concept –
des programmes thématiques sur
abonnement existaient déjà à la
fin des années 90, le succès de
l’iPod et la volonté d’ajouter à
l’iTunes Music Store un contenu
éditorial plus éclectique ont permis
l’éclosion du phénomène. Si le
mot-valise podcast (contraction
d’iPod et Broadcast) a été lancé
par un journaliste du quotidien an-
glais The Gardian, en revanche, le
terme photocastingest une pure
invention d’Apple. Prosaïquement,
il s’agit de mettre à disposition de
votre entourage une galerie
d’images dont il est possible de
suivre les mises à jour en temps
réel.

S’ABONNER À UN PHOTOCAST
Si des membres de votre famille
publient des photographies sur
des services comme MobileMe,
vous pouvez vous abonner à leur
galerie en ligne et consulter leur
contenu directement depuis
iPhoto. Pour ce faire, cliquez sur
le bouton S’abonnersitué en haut
de la page web, et choisissez l’item
via RSS dans la fenêtre surgis-
sante. Dans la barre latérale du lo-

giciel iPhoto, vous verrez s’afficher,
dans une section Inscriptions, la
galerie d’images. Pour s’en débar-
rasser ultérieurement, il vous suffira
de faire un clic droit sur son intitulé
puis de demander Supprimer l’al-

bum. Sur ce même principe, vous
pouvez vous abonner à n’importe
quel fil de syndication offrant des
photographies – provenant d’un
blog ou d’un service d’héberge-
ment spécialisé comme FlickR ou
PicasaWeb. Pour ce faire, à l’aide
de votre navigateur internet, ren-
dez-vous à l’adresse d’une galerie
en ligne. Cliquez ensuite sur le bou-
ton RSS situé à droite du champ
d’adresse afin de voir s’afficher
l’URL du flux. Copiez-le puis, dans
iPhoto, demandez Fichier > S’ins-
crire au flux photoet collez l’adresse
internet dans le champ adéquat
en haut de l’écran.

PUBLIER AVEC IPHOTO
Pour créer un photocast avec
iPhoto’09, il faut être abonné à
FlickR ou à MobileMe. Si c’est votre
cas, choisissez un album photo

dans la barre latérale puis deman-
dez Fichier > Nouvel album. Dans
la fenêtre surgissante, appuyez
sur le bouton MobileMe, puis choi-
sissez les options de publication
qui s’affichent dessous. Par défaut,

l’album est visible par tous .
Mais vous pouvez très bien en dé-
roulant le menu local en restreindre
la portée à quelques membres de
votre entourage. Sélectionnez
alors dans ce menu local Modifier
noms et mots de passe. Pour FlickR,
il vous suffit de choisir un album,
puis d’appuyer dans le bouton
idoine de la barre d’outils.

UN PHOTOCAST À DOMICILE
Reste que si vous ne souhaitez pas
utiliser un service en ligne pour la
publication de vos clichés, vous
avez toujours la possibilité de le
faire depuis votre domicile. Il ne
faut pas oublier que Mac OS X peut
transformer votre ordinateur en
un serveur web performant! Alors,
pourquoi ne pas s’en servir pour
diffuser vos photos ? Seule
contrainte pour être retrouvé dans
l’immensité de la toile : avoir une
IP fixe. Notez que c’est le cas gé-
néralement des abonnés en dé-
groupage total. Sinon, il vous faudra

souscrire un abonnement gratuit
au service DynDNS (www.dyndns.
com) pour avoir une adresse de
connexion unique du type « chez-
moi.dyndns.org ». Vous trouverez
de plus amples explications à ce
sujet dans un article écrit par Henri-
Dominique Rapin (VVMac N°20,
ça n’a pas changé)
nDavid A. Mary
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Photocasting:
photos sur « abonnement »

� Tenir informés automatiquement sa famille ou ses amis des derniers clichés réalisés, c’est possible grâce aux
technologies de syndication. �
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Hébergez votre photocast, vous-même!

�Si vous n’avez pas d’IP fixe, allez sur DynDns.com,
entrez le «  nom de domaine » de votre choix, 

appuyez sur le bouton Add. Si vous n’avez pas encore
souscrit de compte, vous en créez-un dans la foulée.

�Dans l’interface web de votre box ADSL (accessible
depuis une adresse du type 192.168.xxx.xxx), 

choisissez le panneau dévolu au service DynDns 
et remplissez le formulaire.

�Dans la section Nat/Firewall ou Nat/DMZ de votre
box, entrez l’IP locale de votre Mac, ainsi que le port

de connexion : 80 et le protocole : TCP. Intitulez le service
créé comme bon vous semble.

�Dans le panneau Partage des Préférences du 
Système, cochez la case Partage web. Lancez

iPhoto. Créez le cas échéant un ou plusieurs albums photo
et ajoutez-y les images de votre choix.

�En dessous, l’emplacement du dossier devrait être
par défaut /Users/Votre compte/Sites. Quant à

l’URL, entrez votre nom de domaine suivi des caractères
/~ et du nom de votre compte. Si vous avez une IP fixe,
vous pouvez l’utiliser à la place du nom de domaine.

�Dans la colonne de gauche d’iWeb, cliquez sur
Mes albums. Puis, cliquez sur le bouton Photos

situé dans la colonne de droite. Glissez et déposez dans la
partie centrale de la fenêtre le ou les albums provenant
d’iPhoto.

	Cliquez sur le bouton Publier le site. Communiquez
l’adresse de votre site à vos proches. Pour s’abon-

ner au photocast, il leur suffira de relever l’adresse du flux
RSS en cliquant sur le lien S’abonner puis de le reporter
dans iPhoto (Fichier > S’inscrire au flux photo).

�Ouvrez iWeb. Créez un nouveau site (Fichier > 
Nouveau site). Dans la fenêtre des modèles, le choix

du style (élégant, bloc-notes,...) n’a aucune importance, mais
il est impératif d’utiliser le gabarit Mes albums.

�Toujours dans la barre latérale gauche, sélectionnez
l’icône du site (intitulé par défaut «  site  »). Dans la

partie centrale, demandez la publication dans un dossier 
local, et intitulez votre site comme il vous plaît.

Il n’est pas toujours nécessaire de recourir à un hébergeur spécialisé pour diffuser ses photos 
à son entourage: Mac OS X suffit à la tâche.
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D
ès que l’on souhaite sor-
tir des sentiers battus,
il convient d’avoir de
solides connaissances
en programmation Web.

Apple propose iWeb, fort pratique
à l’usage, mais qui produit des

pages lourdes et peu optimisées.
Pour qui se soucie des standards
du Web (ce qui, in fine, permet éga-
lement une meilleure indexation
par les moteurs de recherche),
Goldfish 3.1 (www.fishbeam.com/en/
goldfish) constitue alors une bien
meilleure alternative.

UN CONCEPT QUI FAIT ÉCOLE
Au démarrage de l’application, la
traditionnelle fenêtre d’accueil
propose divers modèles de sites
prêts à l’emploi, facilement person -
nalisables. L’interface principale
du site, relativement dépouillée,
se décompose en quatre zones.
Les colonnes latérales gauche
et droite sont respectivement
dévolues à la création et la gestion

des pages Web. En bas , vous
disposez de widgets qui vous per-
mettront d’ajouter toutes sortes
de fonctions à votre site: un lecteur
vidéo, une galerie d’images, un
menu déroulant, un formulaire de
contact, etc. Enfin, au centre de

l’écran s’affiche votre projet
grandeur nature. Les liens hyper-
textes et autres boutons ne sont
pas fonctionnels tant que vous tra-
vaillez sur l’architecture du site.
Pour tester leur validité, demandez
Format > Preview in Browser. Les
pages seront alors compilées dans
un dossier temporaire et s’affiche-
ront dans votre navigateur Internet
favori. Le logiciel est capable de
déployer en quelques clics des
technologies un brin complexes,
comme un mini-forum de discus-
sion en PHP, des menus déroulants
en CSS, un gestionnaire de caddie
pour boutique en ligne, ou bien
encore une galerie photo avec vi-
sionneuse Ajax à la manière du site
d’Apple (voir ci-contre en page de

droite). Goldfish 3 se décline en
deux versions standard (49,90€)
et professionnelle (99,90€), mais
seule cette dernière vous autorise
une personnalisation très poussée
du code informatique.

FACILE ET COMPLEXE À LA FOIS
Comme toutes les applications de
conception Web orientées tout
public, Goldfish 3 ne demande pas
d’écrire du code HTML et CSS pour
parvenir à des résultats probants.
Dans un modèle, vous sélectionnez
tout simplement les éléments à
modifier, puis vous vous rendez
dans la colonne de droite pour ré-
gler les derniers détails d’affichage
(taille du texte, liens hypertextes
ou RSS…) .

Cela dit, si vous souhaitez exploiter
tout le potentiel de Goldfish, il vaut
mieux être au fait de la philosophie

du logiciel, un brin complexe tout
de même. Voici la méthode de tra-
vail que je vous conseille…
Tout d’abord, faites une esquisse
papier de l’habillage graphique de
votre site pour déterminer les dif-
férentes zones d’affichage: la ban-
nière du site, la colonne de texte
principale, le pied de page, les me-
nus… Élaborez ensuite un modèle
de présentation pour chaque zone
(dénommée Area Template). Enfin,
assemblez chaque pièce du puzzle
dans votre projet.
Une fois la maquette des différen -
tes zones réalisée, appliquez-la
aux pages de votre choix avant
d’insérer le contenu rédactionnel.

QUELQUES CONSEILS
Dans les préférences, panneau
Create Website , vous pouvez
utiliser l’extension de page .HTML
au lieu de .HTM proposé par défaut,
choisir l’encodage texte (UFT-8
ou ISO Latin 1) ainsi que la qualité
d’exportation des images JPeg.
Pour la mise en ligne de votre site,
demandez File > Publish Website.
Vous pouvez redistribuer vos pro-
pres modèles de sites sous forme
de documents qui regroupent tou -

tes les ressources graphiques utili -
sées. Faites File > Export > Design.
n David A. Mary
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� Accessible et puissant, à mi-chemin entre iWeb et Dreamweaver, Goldfish 3 est tout à la fois simple 
d’accès pour le béotien et programmable pour l’amateur exigeant. �

Goldfish, un générateur
de sites polyvalent
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Réalisez un élégant portfolio 

�Dans la fenêtre d’accueil, choisissez le modèle
Blank Website. En bas de la colonne de gauche du

logiciel, appuyez sur le bouton + de couleur verte et de-
mandez Add Area Templates par deux fois.

�En haut de cette même colonne, dans la section 
Area Templates, renommez le premier modèle

Banniere et le second Corps de page (double-cliquez sur 
leur intitulé). Enfin, sélectionnez le modèle Banniere.

�Avec un éditeur bitmap (Photoshop Elements, 
Pixelmator…), créez une bannière contenant une

image ainsi que le nom de votre site. Mon exemple mesure
600 x 342 pixels en 72 dpi. Exportez en JPG ou PNG.

�De retour dans Goldfish, indiquez dans la colonne 
de droite les dimensions de la bannière. Pour im-

porter l’image élaborée à l’étape précédente, appuyez 
sur le point d’interrogation en face de Background 
Picture, puis cliquez sur Ouvrir et OK.

�Dans la section Gallery, donnez un titre à votre 
galerie, cliquez sur Edit, puis sur le bouton Choose

en regard d’Add From Folder afin d’importer un lot
d’images préalablement placées dans un dossier.

�En haut de la colonne de gauche, sélectionnez 
Start Page, puis cliquez dans la partie supérieure 

de la page Web. Dans la colonne de droite, demandez Area
Template > Banniere.

	Glissez-déposez le widget Page Area dans le bas 
de la page Web. Cliquez dans la partie inférieure 

de la page puis, dans la colonne de droite, demandez Area
Template > Corps de page. Le portfolio est prêt !

�Dans la colonne de gauche, sélectionnez 
Area Templates > Corps de page. En bas, prenez 

la Widget Gallery et glissez-la sur la page. Vous pouvez
ajouter d’autres éléments dans la foulée (cadre de texte,
compteur, etc.).

�Sélectionnez sur la page le cadre qui doit 
contenir la galerie puis, dans la colonne de droite, 

à la section Presentation Page, choisissez 
Animated Gallery. À la section Preview Icon, décochez
Background color.

Concevoir des sites esthétiques n’est pas uniquement l’apanage d’iWeb. J’en veux pour preuve 
la conception d’un portfolio usant de la technologie Ajax.
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N
ous allons utiliser la version d’évalua-
tion de 30 jours de Freeway Express
5, un excellent logiciel de mise en
page Web… un peu particulier. Vous
la trouverez à cette adresse Internet:

www.softpress.com/downloads/freetrial/. Remplissez le for-
mulaire et cliquez sur le bouton Request Free
Trial et optez pour Freeway 5 Express 30-Day
Trial – DMG File. Si l’application vous plaît, au-
delà de 30 jours, il vous faudra obtenir un numéro
de série moyennant 59€ (www.softpress.com/fr/buyexpress).

DES MODÈLES À PROFUSION
Freeway 5 Express (59€) s’ouvre sur un écran
d’accueil qui vous invite à prendre connaissance
du guide de l’utilisateur afin de vous familiariser
en douceur avec le programme. Cliquez sur Fer-
merpour accéder aux modèles de sites Internet
prêts à l’emploi et répartis en cinq catégories
(Autre, Divertissement, Générales, Maison et
Vacances) . Si vous souhaitez partir d’un
projet vierge, rendez-vous dans la catégorie
Vide . Freeway Express peut être enrichi de
nouveaux modèles en libre téléchargement de-
puis le site de l’éditeur : appuyez sur le bouton
Plus de modèles . Ceux compatibles avec le
logiciel sont à dénicher dans les catégories Free-
way 5 Express Templates et Freeway 5 Express
Blogger Templates. Mais vous pouvez en outre
importer ceux provenant d’anciennes versions

(Freeway 4 & 5 Templates), ils fonctionneront
pour la plupart sans aucune difficulté. Une fois
les archives téléchargées sur votre disque dur,
puis décompactées, cliquez sur le bouton Installer
modèles afin de les importer dans l’applica-
tion.

LES FONCTIONS CLÉS
La fenêtre principale de Freeway Express res-
semble à s’y méprendre à celle d’un logiciel de
publication assistée par ordinateur. Les fonctions
essentielles sont à dénicher dans la barre d’ou -
tils. La création de boutons, de tableaux et de
zones de texte passe par l’icône HTML .
L’icône Actions regroupe, elle, des widgets
façon iWeb, des modules préprogrammés, dé-
volus à une fonction précise comme une carte
Google, un lecteur vidéo au format Flash, un
menu de navigation… Cela raccourcit grande-
ment le temps de développement et permet à
tout un chacun d’élaborer des contenus Web
complexes avec une grande facilité.
Autre particularité intéressante, chaque bloc
texte peut être chaîné de l’un à l’autre . De
la sorte, vous pouvez concevoir une présenta -
tion en colonnes à la manière d’un magazine.
Pour paramétrer finement chaque fonction uti-
lisée, des palettes flottantes sont proposées
dans le menu Fenêtre. Vous pouvez ajouter ou

retrancher des pages à votre projet. Il vous est
également permis d’inscrire du code HTML per-
sonnalisé à n’importe quel endroit de la page
(menu Insertion > Bloc marqueur), ainsi qu’à
l’intérieur d’une balise spécifique HTML, HEAD
ou BODY (menu Page > Marqueur HTML). Enfin,
à tout moment, la prévisualisation peut être ef-
fectuée dans le navigateur de votre choix – ici,
j’emploie Safari . Pour en changer, il suffit
d’appuyer sur son icône, puis de demander dans
le menu local Réglage du navigateur. Dans la
nouvelle fenêtre, cliquez dans la colonne Défaut
en regard du navigateur Internet que vous sou-
haitez employer.

UNE MÉTHODE DE TRAVAIL
La philosophie de Freeway est très proche de
Pages ’09, ou mieux de Quark Xpress. Il convient
en premier lieu de réaliser la conception gra-
phique (incorporation d’images, bannières et
textes à l’intérieur de cadres nommés «blocs»)
avant d’implémenter les diverses interactions.
Si de nombreux éléments sont communs à
toutes les pages de votre site, je vous conseille
d’élaborer la maquette graphique de la page
Master1 ; chaque modification opérée dans
cette page mettra à jour l’ensemble des pages
du site. Très pratique à l’usage! 
nDavid A. Mary
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� Concevoir son site Internet avec
des outils dévolus aux graphistes,
quelle drôle d’idée! Et pourtant, 
cela fonctionne à merveille. 
Démonstration avec Freeway. �

Freeway Express
La PAO adaptée au Web
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Une visionneuse Flash compatible iPhone

�Pour encoder la vidéo au format Flash (FLV), 
utilisez le gratuiciel FFMpegX (ffmpegx.com). 

Cliquez sur le bouton Ouvrir, sélectionnez la vidéo à 
encoder et demandez FLV comme format de destination.

�Dans le panneau Vidéo, ajustez le débit vidéo 
à 1400 Kbit/sec, sélectionnez un Framerate de 

25 im/sec si votre vidéo provient d’un caméscope PAL.
Appuyez sur le bouton Encoder.

�Lancez Freeway Express, choisissez le modèle 
de votre choix (Vacances > Congé dans mon 

exemple). Dans les préférences de Freeway > Générales,
cochez la case Autoriser AppleScript dans les actions.

�Faites Fichier > Réglages du document > 
Transfert. Réglez le menu local Mode sur Copie 

fichier si vous souhaitez publier votre site en local 
(ou bien FTP ou MobileMe). Entrez les données 
de connexion ainsi que l’URL de votre site.

�Tracez un cadre de la dimension voulue à un endroit
de la page Web. Demandez Fenêtre > Actions. 

Dans la palette flottante, positionnez le menu local 
Fichier FLV sur Sélectionner. Choisissez le fichier vidéo
préalablement encodé avec FFMpegX.

�Positionnez le menu local Lecteur sur Under. 
Cochez les cases Transparence et Compatibilité

avec l’iPhone. Cliquez successivement sur les deux 
boutons Calculer afin que soient encodées les versions 
des vidéos destinées à l’iPhone (WiFi/3G et Edge).

	Prévisualisez le résultat en appuyant sur le bouton
idoine situé en haut de la fenêtre. Ceci fait, il ne

vous reste plus qu’à mettre le résultat en ligne via le
menu Fichier > Publier le site.

�Personnalisez les différents cadres texte en double-
cliquant sur chacun d’eux. Pour changer le contenu 

d’un cadre image, sélectionnez-le au préalable, puis faites
Fichier > Importer (ou Importer depuis iPhoto). 
Sélectionnez ensuite la photo de votre choix.

�Afin que le cliché s’adapte à la dimension du cadre
existant, faites un clic-gauche sur la vignette, puis 

dans le menu contextuel demandez Image > Ajuster 
la taille de l’image au bloc. Cliquez sur le bouton Actions de
la barre d’outils et sélectionnez Lecteur FLV.

Adapter des vidéos en fonction du débit de connexion et du matériel utilisé relève du tour de force, 
pensez-vous? Pas du tout ! Freeway Express propose une solution élégante !
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Q
uand on décide de se
lancer dans la program-
mation d’un site pour
des besoins personnels,
une association, un club,

voire une petite entreprise, iWeb
’09 d’Apple est la première solution
à laquelle on songe, car elle est in-
tuitive et donne des résultats plutôt
bluffants d’un point de vue esthéti -
que. Las, le code généré n’est pas
des plus élégants, ni efficaces. Et
il est toujours difficile de personna -
liser le contenu d’un site sans re-
courir à des subterfuges plus ou
moins grossiers… Les utilisateurs
ayant quelque talent de graphiste
auront une inclination pour Free-
way Express. Flux (www.theescapers.
com/flux, 49£ ou 55€ou env.), quant
à lui, est un cas à part. Il se distingue
très nettement des autres solutions
«premiers prix» comme Goldfish
ou Rapidweaver par sa très grande
polyvalence et les nombreux outils
de développement mis à disposi-
tion de l’utilisateur.

IL FAIT TOUT… OU PRESQUE
Flux pourrait être qualifié à bon
droit de couteau suisse de la pro-
grammation Web, car il fait feu de
tout bois : HTML 4 et 5, XHTML,
CSS, Javascript, PHP, Ruby On Rails.
Il propose même la création de
contenus iTunes LP et Extra.
Bien que d’un abord un peu plus
difficile que ses concurrents, Flux
tente de jouer la carte de la convi-
vialité en proposant des modèles
de sites «prêts à l’emploi». Leur
personnalisation est aisée si l’on
s’en tient aux seuls blocs de texte.
Dans ce cas, il suffit simplement
de double-cliquer à l’endroit de la
page où l’on souhaite apporter
des modifications. En revanche,
le remplacement ou la modification
des images d’origine est plus con -

traignant qu’avec Freeway Express,
nécessitant quelques notions de
base en HTML et CSS. Je vous le
confirme donc, l’univers de Flux
est bien celui de la programmation
et non celui de la PAO!

UN FLUX DE PRODUCTION
RATIONNEL
L’édition du code peut se faire «à
la main» dans l’éditeur interne ou
bien de manière semi-automatique
par le biais d’une palette flottante.
Si vous utilisez cette dernière pour
l’élaboration d’un document CSS,
sachez que l’application Flux ajoute
systématiquement du code inutile.
Même si cela ne gêne en rien l’af-
fichage des pages, le code ne sera
pas aussi léger que si vous l’aviez
écrit vous-même.

TOUR D’HORIZON RAPIDE
Par ailleurs, vous pouvez recourir
à un éditeur externe; dans ce cas,
la moindre modification d’un élé-
ment de votre projet est automa-
tiquement prise en compte par
Flux – le résultat s’affichant dans
la foulée. Enfin, le logiciel impose
la constitution d’un dossier de tra-
vail dûment hiérarchisé où viennent
se ranger tous les éléments néces-
saires au projet. Un bon moyen de
gagner en productivité !

Flux se compose de deux fenêtres
de travail principales. Nous béné-
ficions ainsi du Gestionnaire de site

qui donne à voir le site Web
sous la forme d’une arborescence,
et de l’Éditeur de page pour la
programmation.
Chaque écran a des outils spécifi -
ques comme la manipulation des
images bitmap ou l’ajout de
fonctions complémentaires: biblio -
thèque jQuery, visionneuse Light-
box ou Slimbox, etc. L’Éditeur de
page dispose d’un jeu de palettes
flottantes pour une gestion aisée
des médias comme des lignes de
code. Vous pouvez, par exemple,
consigner dans la palette Brides

les lignes de programmation les
plus utilisées pour les utiliser de
nouveau dans le projet.
Naturellement, comme tout édi-
teur WYSIWYG (« ce que vous
voyez est ce que vous obtenez»),
vous agissez à même la page, re-
dimensionner, modifier ou déplacer
un élément. La publication s’ef-
fectue d’un clic vers MobileMe ou
n’importe quel compte FTP. Flux
est bon candidat au développe-
ment de projets ambitieux (une
boutique en ligne) ou à  la confec-
tion de thèmes pour des blogs et
sites d’information spécialisés
(pour les moteurs Wordpress,
Joomla ou SPIP). nDavid A. Mary
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Création de pages Web 
avec Flux 
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� S’adressant plutôt aux utilisateurs 
avancés, Flux n’en demeure pas moins un
outil séduisant, souple et proposé à prix
budget, ce qui ne gâche rien. �
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Premiers pas en HTML et CSS

�Cliquez sur Create new empty project dans 
l’accueil de Flux. Dans le dialogue, nommez le 

projet Web, puis cliquez sur Enregistrer. Un message
d’avertissement apparaît alors : cliquez sur Oui.

�Demandez Fenêtre > Navigateur de média.
Choisissez une photographie (issue de votre 

bibliothèque iPhoto, par exemple) que vous glissez dans 
la fenêtre Gestionnaire de site > Site > dossier images.

�Double-cliquez sur le dossier Images. Relevez 
le nom du fichier bitmap utilisé, vous en aurez 

besoin à l’étape 7. Double-cliquez sur main.css. La feuille 
de style s’ouvre automatiquement dans TextEdit.

�Effacez les instructions .mystyle {} et remplacez-
les par les lignes de code ci-dessus, définissant 

un identificateur unique nommé #mapage qui 
contiendra tous les éléments de la page. Sa largeur 
(width) est de 800 pixels.

�Pour l’affichage de l’image, j’utilise la même astuce
qu’à l’étape 5. Étant donné que la photo sera 

redimensionnée avant affichage, je spécifie déjà sa 
largeur finale de 600 pixels (paramètre width). 
Enregistrez le document « main.css ».

�De retour dans Flux > fenêtre Gestionnaire 
de site, double-cliquez sur index.html. Dans la

barre d’outils, cliquez sur Code. Vous allez à présent 
intégrer les éléments de la feuille de style dans la page
Web.

	En bas de la fenêtre, placez avant la balise
</body> les instructions ci-dessus. Dans l’élément

image, indiquez le nom exact de la photo (exemple : <img
src="images/Pingo.jpg"). Cliquez sur le bouton 
Prévisualiser pour observer le résultat définitif.

�Pour que le bloc #mapage soit toujours au centre 
de la page, j’utilise une astuce tirée du livre Le Zen

des CSS. Elle consiste à utiliser une marge négative (mar-
gin-left) de la moitié de la largeur de la page. Enfin,
conservez la couleur de fond (background) en blanc.

�Nous définissons à présent le style du texte
« Hello World ! » qui servira de titre principal. 

Pour ce faire, utilisez l’élément bloc h1 : police 
Georgia, 32 pixels en petites majuscules, de teinte noire et
en position centrée.

Si vous envisagiez de passer un jour prochain à la programmation Web, mais que vous n’avez 
aucune idée de ce qui vous attend, cet exemple constitue une première approche…
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L
’usage du blog s’est diver-
sifié à tel point qu’il est
désormais présent dans
le monde de l’éducation,
et plus particulièrement

à l’école primaire dans le cadre de
projets pédagogiques spécifiques.
À titre d’exemple, les classes trans-
plantées sont l’occasion pour les
élèves de découvrir un milieu, des
métiers ou des pratiques qu’ils ne
connaissaient pas.
L’intérêt d’un site Internet est de
faire partager leur expérience avec
la famille et le reste de l’école. Aussi,
pour faciliter la mise en ligne de
documents visuels et sonores, Pos-
terous offre de nombreux atouts
comme l’intégration automatique
d’une visionneuse vidéo ou d’un
album photo sans programmation
additionnelle. De plus, le processus
de publication s’effectuant par
courriel, vous pouvez facilement
mettre à jour le site depuis n’im-
porte quel appareil nomade, iPad
et iPhone inclus.

SOUSCRIVEZ AU SERVICE
À l’aide de votre navigateur Inter-
net, rendez-vous à l’adresse https:
//posterous.com/main/register. Dans
le premier champ, entrez le nom
du site que vous souhaitez créer.
Pour vérifier sa disponibilité, cliquez
sur le lien Check for availability. Si
la mention Cool, this site address
is good to gos’affiche, vous pouvez
passer à la suite. Vous pourrez com-
muniquer ultérieurement l’adresse
de votre blog à toutes les person -
nes concernées. Pour mémoire,
elle apparaîtra sous la forme sui-
vante: http://le_nom_de_votre_

blog.posterous.com. Entrez ensuite
successivement votre adresse de
courriel, puis le mot de passe de
votre choix, lesquels protégeront
l’accès au panneau de réglages de
votre site. Cliquez ensuite sur le

bouton Sign up. Un courriel de
confirmation d’inscription vous
est envoyé dans les minutes qui
suivent. Ouvrez Mail, puis cliquez
sur le lien contenu à l’intérieur.

PERSONNALISATION DU SITE
Une page Web est dévolue aux ré-
glages de votre site Posterous.
Pour y accéder directement, tapez
simplement l’adresse http://pos
terous.com/manage. Entrez si né-
cessaire votre adresse email ainsi

que votre mot de passe. Commen-
cez tout d’abord par choisir l’ha-
billage graphique en cliquant sur
Theme my site , à droite de la
page. Sélectionnez l’un des dix
thèmes mis à votre disposition.

Pour personnaliser la bannière-titre
, cliquez sur Customize . Ap-

puyez successivement sur les bou-
tons UpdateetSave I’m Done (en
bas de la page) pour valider les mo-
difications. Refermez la fenêtre.
De retour à la page Manage, cliquez
sur Settings . Pour restreindre
l’accès du blog par un mot de passe,
rendez-vous à la rubrique Privacy.
Cochez la case Password-protect
my site, puis entrez dans le champ
situé au-dessous le mot de passe

que devront taper vos visiteurs.
La section Posting and Commenting
sert à fixer les droits régissant le
contenu éditorial du site. Si vous
n’autorisez pas les commentaires
à la suite des articles, demandez
Disable all commentsdans le se-
cond menu déroulant. Pour cacher
aux visiteurs les liens de téléchar-
gement des images et vidéos, de-
mandez Do not show download
links dans le troisième menu dé-
roulant. Pour autoriser une autre
personne à publier sur le blog, cli-
quez sur le bouton Add contribu-
tors, dans l’onglet Contributors

: un formulaire apparaît en su-
rimpression. Ajoutez la nouvelle
adresse de courriel dans le champ
Enter name or email adresses.
Chose faite, cliquez sur le bouton
Add contributorsen bas de page.

PUBLIEZ SUR LE BLOG
Pour publier de nouveaux articles
sans avoir à vous connecter à l’in-
terface de Posterous, il vous faut
utiliser Mail (depuis votre ordina-
teur portable ou à partir de votre
iPhone). Le mode opératoire est
d’une simplicité biblique!
Rédigez le texte, puis ajoutez si
nécessaire en pièce jointe les do-
cuments de votre choix. Notez
que le titre de votre article sera dé-
fini à partir du champ Objet de
votre missive. Enfin, envoyez le
courriel à l’adresse indiquée dans
la page principale de votre compte
Posterous (post@le_nom_de_votre_
blog.posterous.com). nDavid A. Mary
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Posterous vous facilite

le moblog
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�Bloguer librement depuis n’importe quel terminal mobile, telle est la définition 
du moblog. Simple d’accès, Posterous démocratise désormais sa pratique. �
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Sauvegardez votre blog au format XML

�Dans la page Manage de votre compte Posterous, 
onglet Settings, rubrique Privacy, désactivez 

momentanément l’accès par mot de passe à votre site. 
Demandez ensuite Save Settings.

�Dans le panneau d’accueil d’Automator, demandez 
la création d’une nouvelle Application. Confirmez

en cliquant sur le bouton Choisir.

�Dans la bibliothèque Actions > Internet, choisissez
Obtenir les adresses URL indiquées, à glisser 

dans la zone du processus. Supprimez l’adresse par 
défaut www.apple.fr et cliquez sur le bouton Ajouter.

�Tapez l’adresse suivante : http://posterous.com/api/
readposts?hostname=nom_de_votre_blog&num_

posts =100. Cette dernière instruction indique le nombre 
d’articles (ici 100) à sauvegarder.

�Ajoutez par trois fois l’action Renommer les 
éléments du Finder dans la zone du processus. 

Un message d’alerte surgit à chaque fois : cliquez 
systématiquement sur le bouton Ne pas ajouter.

�Dans la première des trois actions, fixez le format
jour mois année et un tiret en guise de 

séparateur, puis cochez la case Préfixer par des zéros.
Dans la seconde action, demandez le format 
heure minute seconde.

	Dans la troisième action, déroulez le menu local
Ajouter date ou heure et demandez Nommer 

un seul élément. Positionnez le menu local Nom
sur Extension seulement et tapez xml dans le champ 
en regard. Enregistrez l’application Automator.

�Dans le Finder, créez un nouveau dossier de sauve-
garde que vous nommez Sauvegarde Posterous, 

par exemple. De retour dans Automator, glissez l’action 
Télécharger les URLs dans la zone du processus.

�Dans le menu local Emplacement, optez pour 
Autre, puis choisissez dans le dialogue le dossier

Sauvegarde Posterous précédemment créé. Cliquez 
sur le bouton Choisir.

Posterous ne vous offre pas la possibilité d’effectuer une sauvegarde 
de votre site. Qu’à cela ne tienne, Automator vous aide à réaliser l’impossible !
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L
a conception d’un blog requiert des
connaissances techniques. Même si
ces dernières sont abordables, du
temps et de la pratique sont néces-
saires pour parvenir à un résultat cor-

rect. Las, peu d’outils sont d’un abord facile.
iWeb? À l’instar des logiciels du même genre,
il génère des sites ou des weblogs statiques
tels que l’on en a connus à la fin des années 90,
sans mise à jour dynamique du contenu éditorial,
sans communication permanente avec les ré-
seaux sociaux. Un blogueur «dans le mouv’»
préférera un moteur de publication comme
Wordpress qui combine tous ces raffinements.

RÉVEILLEZ LE GRAPHISTE QUI DORT EN VOUS
Pour un premier blog, se concentrer sur la
qualité de la ligne éditoriale est une excellente
chose! Pour autant, il ne faut pas négliger l’ha-
billage graphique. Si vous n’êtes pas un as de
la programmation et du design, plutôt que de
passer de longs mois à apprendre le métier,
confiez sans crainte cette tâche à Artisteer 2

, un générateur de site semi-automatique.
Vous lui indiquez les éléments nécessaires à
la réalisation de la mise en page (nombre de
colonnes, menus déroulants, couleur de fond,
image de fond, habillage des paragraphes,
type de fontes, etc.) et le logiciel s’exécute.
Notez que pour les besoins de cet article, je
me concentre uniquement sur Wordpress,
mais l’application est capable de produire des

«templates» compatibles avec d’autres moteurs
de publication. En version Personnelle/Éduca -
tion (37€ environ), Artisteer est également
compatible avec Blogger, la plateforme de
blogs de Google. En revanche, pour habiller
son site Joomla (version 1.5 et supérieure),
Drupal (version 5 et 6) ou DotNetNuke, voire
pour profiter du support des technologies
Web de Microsoft (ASP.NET), vous devrez
passer par l’édition Standard (105€).
Quelle que soit la version retenue, une pléthore
d’objets graphiques, photos et autres textures
vous est offerte, ce qui vous permettra de ga-
gner du temps dans l’élaboration de la ma-
quette. Une fois le webdesign achevé, rien ne
vous empêche de distribuer le thème à titre
gracieux, voire le proposer à la vente!

LA MÉTHODE ALÉATOIRE
L’application est par défaut en anglais, mais
on peut avoir une interface française! Rendez-
vous dans le menu Artisteer > Preferences. En
bas de la fenêtre, déroulez le menu local, puis
demandez French . Cliquez sur OK, quittez
puis relancez l’application afin que les modifi-
cations opérées soient prises en compte…
Comme vous pourrez le constater, la prise en
main d’Artisteer est très rationnelle. Tout ce

dont vous avez besoin se trouve consigné dans
la barre d’outils de l’unique fenêtre de travail.
Chaque bouton vous permet d’agir sur un
aspect du design. Bien que la plupart ne né-
cessitent pas d’explications particulières tant
leur intitulé est limpide (Couleurs police, Menu,
Barre latérale), le bouton Idéesest une trouvaille
qui porte bien son nom.
Vous pouvez laisser le hasard décider de l’aspect
graphique de votre site! Il y a deux méthodes.
La première consiste à appuyer autant de fois
que désiré sur le bouton Suggérer la conception
(placé à gauche de la barre d’outils). Dans ce
cas de figure, les changements affectent l’en-
semble du blog. La seconde méthode limite
la modification à un aspect particulier du design
(choix des couleurs, des polices ou de l’arrière-
plan…). Artisteer vous autorise bien sûr à mé-
moriser vos propres réglages, et à insérer les
images et textures originales que vous aurez
élaborées dans un éditeur bitmap.
Plusieurs méthodes d’exportation sont pro-
posées: sous la forme d’un dossier exploitable
par Wordpress, à placer dans /wp-content/
themes/ sur votre serveur, comme archive Zip
pour distribution et archivage, ou comme
fichiers HTML/CSS modifiables dans n’importe
quel éditeur spécialisé. nDavid A. Mary
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Grâce à Artisteer, jouez avec 
Template Wordpress
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� Jusqu’à présent, il n’existait pas
d’outils convaincants pour faciliter
l’habillage graphique d’un blog
Wordpress. Artisteer relève le défi
avec brio. �

� www.artisteer.com
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Un blog «grunge» avec transparence

�Dans la fenêtre d’accueil d’Artisteer, sélectionnez 
un modèle Wordpress. Dans la barre d’outils, 

cliquez sur Couleurs Polices. Déroulez le menu local
Thèmes de Couleurs pour y choisir Noir et Blanc.

�Dans le menu local Jeux de Polices, demandez
News. Cliquezsur le bouton Mise en forme afin de

déterminer l’aspect global de la maquette. Déroulez le menu
Mise en forme de Page > En-tête. Choisissez une présen-
tation en deux colonnes dans le menu idoine.

�Positionnez le menu local Position du Menu sur
Aucun bloc, puis cliquez sur le bouton Arrière-

plan. Déroulez Image ou Texture > Coloré, puis choisis-
sez le motif en forme de fleur. Optez pour un dégradé
Foncé vers clair, ainsi qu’un filtre Grunge.

�Pour altérer le coloris de l’arrière-plan, déroulez
Couleur de Remplissage > Plus de couleurs. 

Optez pour une teinte bleu foncé comme dans la capture
ci-dessus.

�Cliquez sur le bouton En-tête. Appuyez sur la
flèche qui pointe vers le bas pour dérouler le menu

Photo de Premier plan. Choisissez la photo représentant
un microphone coiffé d’un casque.

�À gauche de la barre d’outils, déroulez Image 
d’Arrière-Plan, puis sélectionnez la photo d’une

ville prise à la tombée de la nuit. Pour modifier le texte de
la bannière, remplissez les champs Gros Titre et Slogan.
Allez dans le menu A pour ajuster la police de caractères.

�Cliquez sur Position : la fenêtre Position du Titre
apparaît. Vous pouvez déplacer le cadre texte à la

souris pour affiner sa position dans la bannière. Si le 
résultat vous convient, demandez File > Exporter >
Theme Wordpress.

�Cliquez sur le bouton Feuille. Choisissez une forme 
à bord arrondi. Demandez un remplissage de 10

pixels dans le menu local. Pour créer un effet de transpa-
rence sur les contours du bloc Article, déroulez le menu 
et demandez 60 %.

�Cliquez sur le bouton Article. Déroulez le menu 
Style > Forme, puis sélectionnez la seconde forme 

du contenu. Toujours depuis le menu Style, demandez
Marge > Aucune marge, puis Rayon > Aucun rayon, 
et enfin Remplir > Couleur de thème > Noir.

Habiller le site d’un animateur de talk-show, ce n’est pas sorcier ! La preuve avec cette réalisation 
qui peut être accomplie en moins de vingt minutes.
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L
e podcasting (ou baladodiffusion) per-
met de transmettre à la demande des
documents numériques (audio, vidéo
et autres PDF). En pratique, la sous-
cription à un podcast peut s’effectuer

depuis le site Internet du diffuseur, via le fil de
syndication RSS, depuis un portail thématique,
voire en recourant à un service spécialisé
comme l’iTunes Store. Comme producteur de
contenus, vous devez vous poser quelques
questions… Quel format d’encodage utiliser?
Comment proposer depuis mon blog un abon-
nement à mon podcast? Comment étendre la
compatibilité du flux RSS à toutes les plate-
formes de baladodiffusion? Réponses!

ENCODAGE OPTIMAL
Côté vidéo, pour maintenir une compatibilité ul-
térieure avec iTunes, je vous conseille, à l’expor-
tation du montage (depuis iMovie, ScreenFlow
ou Camtasia), de choisir un format iPod/iPhone
ou Apple TV. Si la vidéo utilise un codec autre que
le H.264, tentez son transcodage à l’aide du logiciel
MPEG Streamclip: une fois la séquence ouverte,
demandez Fichier > Exporter en MPeg-4. En haut
de la fenêtre, cliquez sur le bouton iTunes, sélec-
tionnez iPhone ou Apple TV (en 4:3 ou 16:9 selon
le format de tournage employé) et cliquez sur
OK. Ajustez la réglette Qualité sur 100% et appuyez

sur le bouton Créer un MP4.
Les documents sonores seront au format MP3
ou MP4 (AAC). Si vous utilisez GarageBand pour
les produire, demandez Partage et une com-
pression Haute Qualité à l’exportation.

UN FLUX RSS DIFFÉRENCIÉ
Le flux RSS est un fichier XML qui regroupe des
métadonnées (titre du flux, présentation, date
de diffusion…) et le contenu de chaque article ou
épisode de podcast (résumé, nom de l’auteur,
lien de téléchargement…). Un blog conçu avec
iWeb ’09 propose par défaut un flux de syndica -
tion RSS unique mêlant les articles parus avec les
épisodes du podcast. Pour vous assurer une com-
patibilité avec les annuaires de podcasts, différen -
ciez les flux RSS! Celui consacré à l’ensemble de
l’activité de votre blog sera généré automatique-
ment par iWeb. Mais pour créer le flux de syndi-
cation dévolu au podcast, utilisez Feeder qui
sait dialoguer directement avec l’iTunes Store.

FIL DE SYNDICATION
Dans l’écran d’accueil de Feeder, sélectionnez
iTunes Podcasting, puis cliquez sur Choose. Dans
le panneau en accordéon, dépliez la rubrique
iTunes Store Listing et remplissez les champs
(nom de votre podcast, adresse de votre site

Web, décrivez succinctement les thèmes abordés
et précisez le nom des auteurs). Pour associer
une illustration à votre podcast (un logo ou une
capture d’écran), créez un fichier JPegdans Pho-
toshop Elements, Live Quartz ou Pixelmator,
d’une taille de 300 pixels de côté, à glisser dans
le cadre prévu à cet effet .
Pour obtenir un classement judicieux dans l’iTunes
Store, dépliez la rubrique Catégories, et dans le
menu local arborant le signe +, choisissez jusqu’à
trois thèmespar ordre d’importance catégorisant
au mieux le contenu éditorial. Dans la rubrique
Owner, tapez vos nom et adresse email.
Enfin, inscrivez le titre de votre flux RSS dans le
champ File Name sans utiliser aucun espace ni
caractère spécial. Et nous y voilà ,reste à cliquer
sur le bouton Create. nDavid A. Mary
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Feeder, un logiciel sympa pour
publier des podcasts
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� J’ai déjà expliqué comment
enregistrer et structurer un podcast.
Je vous propose de nous intéresser
ici à sa diffusion auprès 
des auditeurs. �

� FEEDER DE REINVENTED SOFTWARE,39$ (http://reinventedsoftware.com/feeder)

3
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Faites votre entrée dans l’iTunes Store!

� Au centre de la fenêtre, positionnez le menu local Folder
sur Web Sites si vous utilisez MobileMe. Avec un héber-

gement FTP, remplissez les champs comme il se doit (login, mot
de passe, adresse FTP). Refermez la fenêtre et cliquez sur Save.

� Cliquez sur le bouton Continuer, puis suivez pas à pas
l’assistant iTunes. Notez bien que l’étape 6 ne se produit

que lors de la première mise en ligne. Par la suite, à chaque mise
à jour du podcast, Feeder ne propose plus d’en passer par là.

� De retour dans Feeder, cliquez sur le bouton Share situé
dans la barre d’outils. Sélectionnez Web Page Links dans

la colonne latérale. Cliquez sur le bouton Copy situé en bas de la
fenêtre, puis sur Close.

	 Pour insérer le lien de syndication RSS dans un blog réa -
lisé avec iWeb ’09, placez le widget Fragment HTML où

bon vous semble sur la page d’accueil. Cliquez à l’intérieur de la
palette flottante idoine, puis demandez Édition > Coller. Voilà,
le tour est joué!

� Passons à la mise en ligne de l’épisode. Pour cela, cliquez
sur Publish dans la barre d’outils. Puis, successivement,

sur les boutons Continue et Publish. Patientez le temps que le
téléversement arrive à son terme.

� Un dialogue vous propose ensuite d’ajouter votre balado-
diffusion à l’iTunes Store. Cliquez sur les boutons Sub -

mit to iTunes, puis sur Submit. Le logiciel iTunes se lance alors.
Placez votre curseur dans le champ URL du flux du podcast, puis
demandez Édition > Coller.

Être présent sur la plus importante plateforme en ligne est le défi le plus difficile à relever, 
pensez-vous? Grâce à Feeder, ce n’est qu’une formalité !
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� Pour ajouter le premier épisode à votre flux de balado-
diffusion, glissez-déposez le document audio, vidéo ou

PDF en haut de l’interface de Feeder.

� Dans la nouvelle fenêtre, donnez un titre à l’épisode que
vous mettez en ligne, puis indiquez si nécessaire votre

nom et ajoutez un court résumé dessous. À la section Enclosure,
déroulez le menu local Server, puis demandez Edit Servers.

� Dans la fenêtre Servers, en bas de la colonne de gauche,
appuyez sur le bouton + pour révéler un menu local. Si

votre blog est hébergé par Apple, demandez New MobileMe
Server, sinon choisissez New FTP Server pour un hébergement
standard (Free ou autres).
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L
es retrouvailles avec PulpMotion Ad-
vanced se font sans grand étonne-
ment, ni déception particulière. Le lo-
giciel évoluant à un
rythme régulier,

cette troisième mouture of-
fre quelques pépites comme
l’effet Ken Burns, de nou-
veaux filtres d’image, l’ani-
mation des blocs texte, une
personnalisation des thèmes
plus poussée, la possibilité
de mémoriser les paramè-
tres d’exportation sous la
forme d’un préréglage…
En outre, un nombre consé-
quent de thèmes de présen-
tation est fourni d’emblée,
ce qui explique le poids im-
posant de l’image disque
(près de 116 Mo).
Si, de prime abord, peu de changements sont
visibles, le fait est que l’éditeur Aquafadas a
truffé les moindres recoins du logiciel d’amé-
liorations bienvenues. Mais pour en profiter
sans pour autant affronter quelques bogues
incompréhensibles, il est malheureusement
nécessaire de désactiver Perian – ce qui est
tout à fait désagréable car celui-ci est indis-
pensable sur Mac OS X pour le décodage vidéo.
Aquafadas doit vite corriger ce point !

DE LA CRÉATION À L’ANIMATION
La réalisation d’un magazine de mode animé
constitue une très bonne introduction à Pulp-
Motion 3. Cet exemple pourrait même à moin-
dres frais constituer un générique pour une
émission télévisée ou un podcast. Passons
sans plus tarder à la mise en œuvre…
Dans la fenêtre d’accueil du logiciel, cliquez
sur Nouveau. Dans la fenêtre des thèmes, optez
pour le modèle Mode Magazine, puis cliquez

sur Choisiren bas à droite. Notez
que vos photos ou vidéos et au-
tres fichiers musicaux sont à vo-
tre disposition dans le désormais
traditionnel Gestionnaire de mé-
dias. Outre les documents listés
dans les dossiers Musique, Photo
et Vidéo de votre compte utili-
sateur, PulpMotion 3 accède di-
rectement au contenu des bi-

bliothèques Aperture et Lightroom, en plus
des applications iLife.
Commencez par déterminer la taille du diapo-
rama en cliquant sur le bouton idoine . Dans
la fenêtre surgissante, sélectionnez dans le
menu déroulant HDTV ou Full HD TVpour toute
exploitation en très haute résolution, TVpour
un visionnage sur une AppleTV, un iPad, un té-
léviseur ou un iPhone. Cliquez sur Appliquer.
Dans la palette Gestionnaire de médias, visez
le bouton Modèle (le premier en partant de la
droite), puis cliquez sur le triangle en regard
deMediaTemplate.
Cliquez sur Layout : apparaissent alors les
différentes maquettes applicables. Glissez-
déposez dans le banc de montage les pages
du livre . Si vous recherchez uniquement des
mises en page sans colonage ni texte, préférez
les modèles de page libellés Mag 08à Mag 10.
Dans la palette Gestionnaire de médias > Images,
choisissez les clichés qui vous seront utiles.

Glissez-les ensuite un à un sur chacune des
pages placées dans le banc de montage.
Notez que lorsqu’on glisse une image ou une
vidéo dans le cadre réservé du banc de montage,
deux boutons apparaissent en surimpression.
Sélectionnez systématiquement Ajout et Format

. Le logiciel génère automatiquement une
maquette de page et intègre le média dans la
foulée. A contrario, en choisissant Ajouter
média, l’image se présente alors tout simple-
ment au sein d’une page vierge (sur fond blanc).

OPTIONS D’EXPORTATION
Avant d’aborder les options de personnalisation
avancées dans la page de droite de ce Pratique
Express, il faut préciser les conditions d’une
animation finale de qualité, compatible avec
n’importe quel logiciel de montage.
Rendez-vous dans les préférences de PulpMo-
tion 3, panneau Avancé, demandez un niveau
d’anti-aliasing de 16x et cochez la case anti-
scintillement. Basculez la régletteQualité Op-
timale sur la droite (4096 pixels).
Demandez ensuite Fichier > Exporter > Quick-
Timeet optez pour une compression de type
Animationdans le menu local. Cliquez ensuite
sur le bouton Personnaliser, puis décochez la
case Image clé. Validez… Créez dans la foulée
un préréglage personnel en appuyant sur le
bouton Sauver réglage. Enfin, cliquez sur le
bouton Exporter. nDavid A. Mary
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PulpMotion pour publier un
magazine virtuel

2

3

1 5

4

� Star incontestée du diaporama
scénarisé, PulpMotion Advanced
revient sur le devant de la scène
avec quelques trouvailles 
intéressantes. �

�www.aquafadas.com/fr/pulpmotion (89€)
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Mise en page avancée

�Pour personnaliser la couverture, cliquez 
sur la vignette Intro, à gauche du banc de montage. 

Demandez Vue > Réglage thème simple. Dans la barre 
latérale droite, double-cliquez sur la vignette qui fait face
à Couverture avant.

�Sélectionnez l’image destinée à la couverture 
dans la palette Gestionnaire de médias, déposez-la 

à l’intérieur de la page et cliquez sur le bouton Mise 
en page placé en dessous.

�Avec les poignées, redimensionnez la photo. 
En double-cliquant sur chaque bloc texte, vous

changerez leur contenu respectif. Pour faire courir le titre
du magazine sur la largeur de la page, effacez le bloc
texte en haut à droite.

�Appuyez sur le bouton i pour faire surgir la palette
Inspecteur, entrez la valeur 1600 pour la Largeur.

Tapez le titre du magazine. Pour modifier la taille des 
caractères, cliquez sur le bouton A dans la palette Texte.

�Ajoutez une nouvelle zone à l’aide du bouton idoine.
Un cadre apparaît sur la page… Redimensionnez-le 

à la taille de votre choix, puis disposez-le à un endroit 
de l’image. Recommencez à l’identique cette étape 
autant de fois que nécessaire.

�Pour passer à la personnalisation de la page 
suivante du magazine, double-cliquez simplement 

sur sa vignette dans le banc de montage. Une fois 
les modifications achevées, cliquez sur le bouton Fermer.

	Ajoutez une musique d’illustration à l’intérieur 
de la piste placée au bas du banc de montage. 

Demandez Vue > Réglage thème complet. Dans 
la barre latérale, ajustez la durée d’affichage de la page à
la rubrique Réglages temporels.

�Appuyez sur le bouton Fermer au-dessus du banc
de montage. Vous pouvez maintenant personnaliser

chaque page de la revue virtuelle. Faites un clic-droit sur 
la première vignette et demandez Ouvrir dans l’éditeur.

�Pour dévoiler progressivement le contenu 
d’une page, recourez aux zones d’intérêt. Cliquez

sur le bouton du même nom puis, dans la barre latérale
droite, appuyez sur le triangle face à Zones d’intérêt.

Explorons maintenant les possibilités offertes par PulpMotion Advanced, de la personnalisation 
des cadres texte au zoom sur une portion précise de la page.
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L
a concurrence risque de
faire grise mine car ce nou-
veau logiciel de création
de didacticiels vidéo réus-
sit un pari difficile : offrir,

dans une parfaite fluidité, la capture
simultanée de plusieurs flux audio
et vidéo. Camtasia (prix de lance-
ment 70 €, sinon 105 €), édité par
TechSmith (www.techsmith.com/cam
tasiamac), enregistre simultanément
l’écran du Mac, l’image provenant
de la webcam ainsi qu’une source
sonore interne (microphone) ou ex -
terne (carte son équipée d’un micro
chant). Il offre en plus un banc de
montage complet, avec effets vi-
déo, transitions et fonctions d’an-
notations à l’écran (saisie de texte,
titrage et affichage d’objets vec-
toriels comme des flèches ou dif-
férents phylactères…).

SOURIEZ, VOUS ÊTES FILMÉ!
Au lancement de l’application, une
palette flottante propose de sé-
lectionner les sources à capturer.
Différents boutons servent à choisir
le périphérique audio , à activer
la webcam , ainsi qu’à enregis-
trer des sources sonores en pro -
venance d’autres logiciels (une
fonction idéale pour produire un
podcast dédié à iTunes, Garage-
Band ou tout logiciel musical).
Pour parvenir à détourner les sour -
ces sonores, Camtasia installe le
gratuiciel SoundFlower et s’occupe
d’effectuer les réglages sans in-
tervention de l’utilisateur !
Une fois le bouton REC enfon -
cé, un décompte vous avertit de
l’imminence de la session d’enre-
gistrement. Pour interrompre cette
dernière, rendez-vous dans la barre

des menus, appuyez sur l’icône
Camtasia (en forme de pellicule)
et demandez Stop recording. Ou
bien utilisez le raccourci clavier

[Cmd Maj 2]. Cette action fait qu’un
nouveau projet de montage se
crée automatiquement.

LA GESTION DU PROJET
Les rushes, les transitions et effets
sont disposés dans la barre latérale
gauche. Le passage d’un panneau
à l’autre est assuré par un jeu de
différents boutons frappés d’icônes
explicites. Quant aux paramètres
de réglages d’effets, ils s’affichent
dans une seconde colonne posi-
tionnée, cette fois, à droite. Pour
faire apparaître cette colonne, il
vous faut appuyer sur le bouton
de la roue crantée, situé dans la
barre d’outils.
Sachez qu’à tout moment vous
pouvez ajouter de nouvelles cap-
tures vidéo en appuyant sur le bou-
ton New Recordingplacé dans le
coin supérieur gauche; vous n’êtes
donc pas obligé de tourner votre

podcast en une seule fois. Si vous
comptez archiver ultérieurement
sur un disque dur externe les rushes
du tournage, décochez, dans le
menu Préférences > Recording, la
case Delete after 14 days (effacer
après 14 jours) .
Enfin, concernant la cadence d’en-
registrement (pour mémoire, ce
paramètre conditionne la fluidité
des démonstrations vidéo), si votre
ordinateur est un Core 2 Duo 2 GHz
ou plus, vous pouvez aisément
conserver le réglage par défaut,
Full Motion (30 fps) , dans la fe-
nêtre des préférences.

PRODUCTION HOLLYWOODIENNE
Les médias que vous pouvez ma-
nipuler ne sont pas les seules vidéos
capturées par l’application. Vous
pouvez en effet joindre d’autres
séquences QuickTime tournées
avec votre caméscope, des images
bitmap, ou même des fichiers au-
dio. Pour ce faire, il faudra appuyer
sur le bouton Import en haut
de la barre latérale gauche. Cela
dit, Camtasia Mac vous autorise

également à déposer directement
tout élément multimédia du Finder
vers l’écran de prévisualisation du
logiciel. Concernant le montage
proprement dit, un séquenceur
multipiste est à disposition en bas
de l’interface.
Comme vous le constaterez, les
pistes audio et vidéo peuvent être
cumulées dans n’importe quel or-
dre, ce qui change des logiciels de
montage classiques. Cette manière
de procéder s’avère sans doute
plus intuitive pour un utilisateur
néophyte. De même, la création
des pistes s’effectue de façon dy-
namique, vous n’avez donc pas à
vous soucier de leur nombre.
Pour en créer de nouvelles, il suffit
de déplacer une région audio
ou vidéo dans la partie supérieure

ou inférieure du séquenceur. Enfin,
pour ajouter un effet, déposez-le
simplement sur le segment vidéo
concerné. À présent que vous avez
une vue d’ensemble de l’applica-
tion, passons à la pratique…
nDavid A. Mary
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� De tous les outils de création de screencasts présents sur le marché, le tout 
récent Camtasia Mac en constitue le meilleur représentant. Il est facile 
à prendre en main tout en offrant des fonctions avancées. � 
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Avec Camtasia Mac, réalisez des
podcasts «pros»
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Mettez en valeur votre didacticiel vidéo!

�Commencez par rédiger le fil conducteur de votre 
didacticiel. Prêt ? Lancez Camtasia Mac et 

choisissez le périphérique audio de votre choix (par 
défaut, Built-in Microphone), puis appuyez sur REC.

�Pour stopper l’enregistrement, tapez le raccourci
clavier [Cmd Maj 2]. L’interface de Camtasia 

apparaît alors. Déplacez la tête de lecture située 
dans le séquenceur en bas de l’interface.

�Découpez la séquence vidéo en plusieurs morceaux
de façon à supprimer les longueurs ou les parties 

inutiles. Pour scinder les pistes au point de montage, 
demandez Edit > Split All At Playhead.

�Pour supprimer une région vidéo ou audio, faites 
un clic-droit sur cette dernière. Demandez de 

préférence Ripple Delete car cette fonction a le mérite 
de consolider le montage en forçant tous les segments 
vidéo et audio à se juxtaposer les uns aux autres.

�Les filtres d’action (Smart Focus, Zoom In) vous 
autorisent à agrandir un endroit particulier de

l’image. Avec les poignées, vous définissez la durée de 
l’effet. Pour revenir à l’état d’origine, utilisez l’action
Zoom Out.

�N’oubliez pas d’ajouter un titre en début de 
séquence, voire un rappel à l’écran des raccourcis 

clavier qu’il vous arrive d’employer durant le didacticiel.
Demandez Text > New Text Object.

�Enfin, en vous rendant dans le menu Share, vous
pourrez exporter votre travail vers iTunes ou You-

Tube, ou sous la forme d’une page Web (Export) incluant 
une visionneuse au format Flash Vidéo, s’il vous plaît !

�Appuyez sur le bouton Video Effects pour procéder 
à la mise en valeur du podcast. Pour ajouter 

une transition, déplacez son intitulé de la colonne de
gauche vers le séquenceur et déposez-la sur le segment
vidéo de votre choix.

�L’ajout d’un filtre s’effectue de la même manière. 
Pour affiner ensuite les réglages de l’effet vidéo, 

appuyez sur le bouton idoine situé dans la barre d’outils.

Pour réaliser avec Camtasia un screencast de bonne facture, voici en images quelques-unes 
des fonctions clés qui vous serviront sans cesse.
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E
n production radio, il arrive que l’ani-
mateur use de bruitages et jingles en
direct. C’ets ce que vous propose aussi
le logiciel Soundboard (29$). Vous
trouverez une version d’évaluation

sur le site de l’éditeur Ambrosia Software
(www.ambrosiasw.com).

TOUR DU PROPRIÉTAIRE
L’interface de Soundboard est minimale. Une
palette flottan te de couleur anthracite sert
au contrôle général du son. Une seconde, plus
large, liste les différentes boucles sonores, cha-
cune affectée à une touche particulière du clavier
de votre Mac. Pour découvrir sans plus attendre
les possibili tés de Soundboard, demandez File
> Import Soundboard. Depuis le dossier Sound-
board/Sample Sounds, chargez ensuite le fichier
Podcast Starter Pack.soundboard.
Pour déclencher les sons, frappez tout simple-
ment les touches de votre clavier ou cliquez di-
rectement sur l’un des boutons colorés de la
palette . Si vous souhaitez écourter l’exécution
d’une boucle trop longue, appuyez une seconde
fois sur la touche correspondante du clavier.

CONFIGUREZ LA PALETTE SONORE
Pour ajouter de nouvelles sonorités, déposez
un ou plusieurs fichiers audio dans la palette
Soundboard. Les boucles peuvent être permutées
par un simple glisser-déposer d’une case
à une autre. Pour supprimer un son, ti-
rez-le hors de la palette. Un module
d’édition des échantillons audionumé-
riquescomplète l’éventail des fonctions.
Pour le faire apparaître, faites un clic-
droit sur l’une des cases de la palette.

MODIFIEZ LES BOUCLES
Dans la partie supérieure de la fenêtre,
dispo sées sur l’axe horizontal, deux ti-
rettes exterieures permettent de
fixer le début (le point d’entrée) et la fin
(le point de sortie) de la boucle audio.
Les deux tirettes intérieures ajustent
la durée du fondu en entrée ou en sortie.
Les deux tirettes de l’axe vertical
agissent sur l’amplitude du signal audio, lui per-
mettant d’atteindre son seuil maximal avant
saturation (la traditionnelle fonction de norma-
lisation). Le déplacement de la tête de lecture

à un endroit précis du fichier audio entraîne
l’écou te de la boucle sonore.
Au-dessous, vous pouvez modifier la restitution
du son à trois moments clés : lorsque la
boucle a fini d’être jouée (when the sound is fi-
nished playing), lorsque la touche est relâchée
(when the trigger is released), ou bien lorsqu’elle
est pressée de nouveau (when the trigger is
pressed again). Pour chacune de ces propositions,

diverses options vous sont offertes : arrêter
l’exécution du son (stop playing), jouer perpé-
tuellement l’ensemble de la boucle (loop sound),
laisser se dérouler la boucle jusqu’à échéance

(keep playing) ou bien reprendre la lecture
depuis le début (restart sound).

ASSERVISSEMENT À UN CLAVIER MIDI
Si vous êtes musicien, le clavier MIDI branché à
votre Mac pourra être employé avec Soundboard.
L’assignation d’un son est très simple: cliquez
sur le bouton Learn MIDI , puis appuyez sur
l’une des touches du clavier MIDI. Une fois l’opé-
ration mémorisée, l’application affiche le numéro
du bouton concerné . Ici, button #48 désigne
en réalité la note Do (située à la deuxième octave
d’un piano). nDavid A. Mary
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SoundBoard pour un peu
de magie sonore
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MUSIQUE084

�Jouer de bruitages ou de courtes phrases musicales les doigts sur votre clavier, c’est ce que 
propose le nouveau logiciel Soundboard d’Ambrosia Software.�
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Des effets sonores amusants pour vos vidéos
Complément idéal de GarageBand et d’iMovie ’09, Soundboard peut être utilisé comme 
un instrument à part entière ! Voici le détail du mode opératoire…

         Vous et Votre Mac • Hors-série n°3 • Février 2011

�Dans la palette Master Output, ajoutez 
des effets (AUVarispeed, AUMatrixReverb…) 

via le menu Add Effect > Apple. Sélectionnez 
Soundflower (2ch) comme périphérique de sortie.

�Pour lancer l’enregistrement dans 
GarageBand, appuyez sur le bouton rouge dans

la barre d’outils du logiciel (en bas de la fenêtre).

	Pour iMovie, placez la souris dans la fenêtre 
de montage (au début de la séquence, par exem-

ple), puis cliquez-gauche. Revenez à Soundboard
pour jouer les boucles audio… en direct !

�Ajoutez ensuite à votre projet GarageBand 
une nouvelle piste audio (menu Piste > 

Nouvelle piste > Piste d’instrument réel).

�Avec iMovie ’09, cliquez sur le bouton Voix
hors-champ (dans la barre d’outils), optez

pour Soundflower comme entrée audio et cochez
Lire l’audio du projet pendant l’enregistrement.

�À présent, lancez le logiciel Soundboard. 
Glissez dans la palette principale les fichiers

audio dont vous aurez besoin.

�Pour profiter des jingles et autres bruitages 
livrés avec iLife, utilisez les boucles contenues

dans le dossier /Bibliothèque/Audio/Apple Loops/
Apple/iLife Sound Effects.

�Installez le gratuiciel Soundflower 
(www.cycling74.com/products/soundflower). 

Dans le dossier Soundflower, double-cliquez sur
Soundflowerbed.

�Pour travailler avec GarageBand, dans 
les préférences Audio/MIDI de ce dernier, 

choisissez Soundflower (2ch) comme entrée audio.
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J
usqu’au début de la dé-
cennie, lorsqu’il s’agis-
sait de placer une mu-
sique originale sur un
film d’entreprise ou un

spot de publicité, vous aviez trois
solutions : faire appel à un musi-
cien spécialisé ; réutiliser une
chanson provenant du catalogue
d’une maison de disque (coûteux,
mais efficace) ; recourir à des
compositions libres de droits (édi-

tées par Koka Media notamment)
que l’on retrouve dans un grand
nombre de studios de postpro-
duction. Depuis quelques années,
GarageBand remporte dans ce
domaine tous les suffrages, car il
dispose d’une pléthore de com-
positions prêtes à l’emploi. Non
seulement elles sont de qualité,
mais en plus elles sont gratuites et
dispensent son utilisateur de
toute déclaration préalable à la
Sacem. Parmi les chaînes de télé-
vision qui recourent aux mor-
ceaux réalisés avec GarageBand,

je retiendrai BFM TV, LCP/Public
Senat ou encore Game One… No-
tez que pour employer toutes ces
musiques dans votre projet de
montage iMovie ou Final Cut Ex-
press, vous n’êtes pas obligé d’ou-
vrir GarageBand! Vous pouvez en
effet vous rendre directement
dans le dossier /Bibliothèque/Au-
dio/ Apple Loops/iLife Sound Ef-
fects/Jingles pour en extraire
les fichiers audio de votre choix.

PLUS ORIGINAL QU’IL N’Y PARAÎT
Seulement voilà, l’engouement
pour ces musiques d’illustration est
tel qu’il est difficile d’être original
– tout le monde utilise les mêmes
boucles. Dans ce Pratique express,
je vais donc vous dévoiler une astuce

que j’emploie pour
mes productions vi-
déo – et qui n’est,
expérience à l’ap-
pui, que rarement
utilisée, en tout cas,
jusqu’à aujour  -
d’hui ! Car, après

cet article, gageons que vous ne
pourrez plus vous en passer… La
méthode consiste à élaborer des
morceaux originaux à partir de ceux
proposés par Magic GarageBand.
Dans la fenêtre d’accueil de l’appli-
cation GarageBand, rendez-vous
dans la section Magic GarageBand

. En survolant chacune des neuf
vignettes, vous avez la possibilité
d’écouter un aperçu des diffé-
rents morceaux.
Admettons que vous soyez un grand
fan de jazz manouche… Voici com-
ment façonner en deux temps trois
mouvements, une pièce musicale
dans le style de Django Reinhardt.
Cliquez tout d’abord sur Jazzdans
la fenêtre d’accueil, puis sur le bou-
ton Sélectionner. La scène de Magic
GarageBand apparaît à l’écran… Six
instruments vous font face. Chacun
d’eux peut être facilement remplacé
par ceux situés en bas de la fenêtre.
Notez que le premier emplacement
vous est normalement destiné afin
que vous puissiez jouer en direct
avec l’orchestre. Mais ceci est fa-

cultatif pour mener à
bien votre première com-
position.
Sélectionnez le piano situé

au premier plan , puis cli-
quez sur le boutonNo instrument
pour le faire disparaître de la

scène. Remplacez la batterie par
défaut par une autre jouée avec
des «balais»: cliquez sur l’instru-
ment idoine, puis sélectionnez
Brushes en dessous.
À gauche de la scène, substituez la
guitare d’origine par la guitare Ny-
lon. Et à droite, en lieu et place de
la section de cuivres, optez pour la
guitare Gypsy Solo.
Congédiez le claviériste, situé au
fond à droite de la scène, en cliquant
sur No Instrument. Cliquez enfin
sur le bouton Lecture afin
d’écouter le résultat.

DU MIXAGE À L’EXPORTATION
Si le résultat vous plaît, cliquez sur
Ouvrir dans GarageBandpuis, dans
la fenêtre classique de GarageBand,
affinez le volume sonore de chacun
des instruments en utilisant la ré-
glette sise dans l’en-tête de piste.
Plus impressionnant encore, vous
pouvez ajuster le tempo pour ra-
lentir ou légèrement accélérer le
morceau. Idéal pour «coller» la
musique à votre film ou votre dia-
porama, sans (trop) sacrifier sa ca-
dence de montage. Pour ce faire,
demandez Contrôle > Afficher le
tempo sur l’écran LCD. En bas de
l’interface, cliquez sur l’indicateur
de tempo afin de faire surgir la ré-
glette d’ajustement.
Pour exporter votre composition à
destination de votre projet de mon-
tage vidéo, demandez dans la barre
des menus Partage > Exporter le
morceau vers le disque. Décochez
la case Compresser, puis cliquez sur
Exportation. nDavid A. Mary
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� Vous n’êtes pas compositeur, et pourtant vous aimeriez créer 
des musiques originales pour accompagner vos productions 
vidéo? Magic GarageBand est fait pour vous! � 

Découvrez les richesses de 
Magic GarageBand

MUSIQUE086
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Composez à la manière de Chris Isaak

�Dans la fenêtre d’accueil de GarageBand > Magic 
GarageBand, choisissez le style Blues. Sélection-

nez le piano situé à l’avant-plan de la scène, puis cliquez
sur le bouton No Instrument.

�À gauche de la scène, sélectionnez la guitare, 
puis en dessous, l’instrument Plucky. Vous pouvez

tout aussi bien utiliser la guitare nommée Strumming
pour donner un aspect plus « folk » à la composition.

�Passons au deuxième instrument situé derrière 
la guitare d’accompagnement : la contrebasse qui 

constitue les fondations harmoniques de votre morceau. 
Sélectionnez Jumping en bas.

�Pour ce qui est de la batterie (au fond de la scène),
optez pour l’instrument Sidestick en 

remplacement. À droite de la batterie, nous n’avons pas
besoin de claviériste (sélectionnez et appuyez sur 
No Instrument).

�Ajustez le niveau sonore à l’aide de la réglette. 
Vous pouvez écouter le jeu de l’instrument 

seul en appuyant sur le bouton en forme de casque.

�Pour le mixage express de ce morceau, seules 
les guitares d’accompagnement (à gauche) et solo

voient leur niveau sonore respectif diminuer quelque peu
(placez la réglette à mi-course pour les deux).

	Autre astuce : chaque partie de la composition peut
être jouée en boucle afin de tester les orchestra-

tions. Pour cela, cliquez sur leur intitulé (Intro, Verse 1…).
Pour revenir à la lecture complète du morceau, 
sélectionnez Morceau entier.

�L’instrument soliste (à droite de la scène) sera 
la guitare Biting Slide. Si vous destinez ce 

morceau à un montage vidéo avec de nombreuses scènes
parlées, la guitare solo peut être alors supprimée, elle
aussi.

�Sans faire appel à l’interface traditionnelle 
de GarageBand, vous pouvez procéder à un mixage 

sommaire. Sélectionnez l’instrument dont 
vous voulez modifier le volume sonore, puis cliquez 
sur le triangle situé dans le phylactère noir.

Loin des ballades qui ont fait son succès, Chris Isaak possède un vaste répertoire blues/rock, 
à l’instar de sa chanson Beautiful Home. Voici comment imiter son style…
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L
es formats audio MP3 (MPeg-1/2 Audio
Layer 3) et AAC (Audio Advanced Co-
ding), désormais traditionnels sur la
plate-forme Mac, se déclinent sous la
forme de podcasts, de livres audio ou

encore d’albums musicaux.
Comme vous l’aurez sans doute remarqué au
détour d’un téléchargement sur l’iTunes Store,
certains sont parfois chapitrés, ce qui permet
d’accéder à un endroit précis de l’enregistre-
ment, sans avoir à appuyer de façon continue
sur le bouton Avance rapide du lecteur. Et si
vous souhaitiez à votre tour chapitrer des
fichiers audio en votre possession?

LA PROBLÉMATIQUE DU CONTENEUR
Pour rappel, le conteneur est une coquille vide
dans laquelle on stocke des flux multimédia,
des données de chapitrages et autres sous-
titres. Dans le domaine de la vidéo, vous connais-
sez les traditionnels MOV (QuickTime), AVI,
MPeg, FLV (Flash Video) et MKV (Matroska Vi-
deo). Les conteneurs audio les plus populaires
sur Mac, eux, se nomment AIFF, WAV, MP4,
CAF (Core Audio File), et même OGG (format
libre de la fondation Xiph.org).

AVANTAGE AU MPEG-4
Pour véhiculer des données annexes, telles
que les marqueurs de chapitres, en sus du flux
audio, le conteneur joue un rôle déterminant!
Seulement voilà, si pour l’AAC tout a été prévu
(son conteneur étant représenté par l’une des
nombreuses extensions de fichier mp4, m4a,
m4p ou m4b), le MP3 n’a pas cette chance.
Ses spécifications autorisent tout au plus l’in-
tégration de métadonnées (nom de l’artiste,
pochette et autre mention de copyright).
Malgré tout, il est possible d’établir une liste
de chapitres, mais celle-ci devra être déportée
dans un fichier annexe (nommé Cue). Cette
situation pose évidemment quelques problè -
mes à l’usage, car aucun baladeur à ma connais-
sance n’est capable de lire ou d’interpréter ce
type de fichier. Aussi, pour contourner ce fâ-

cheux contretemps, une solution consiste à
scinder le fichier principal en autant de sous-
fichiers qu’il existe de chapitres.

LE CHAPITRAGE AVEC GARAGEBAND
Mac OS X offre divers outils pour effectuer le
chapitrage de fichiers encodés en MP4 (AAC),
à commencer par QuickTime Pro… Las, peu
conviviale, voire harassante, je vous déconseille
particulièrement cette approche. Préférez le
logiciel GarageBand. Ayant déjà détaillé le
mode opératoire dans le numéro précédent,
je vous rappelle rapidement les étapes obliga-
toires. Créez tout d’abord un projet de podcast
dans la fenêtre d’accueil. Importez au sein

d’une piste vierge le document sonore. Pour
placer un marqueur de chapitre à l’endroit de
la tête de lecture, sélectionnez la piste de pod-
cast, puis appuyez sur le bouton Ajouter un
marqueur en bas de l’interface. L’exportation
du fichier final (menu Partage > Exporter le
podcast vers le disque)doit être obligatoire -

ment réalisée avec l’encodeur AAC – en aucun
cas en MP3 afin de ne pas perdre le bénéfice
du chapitrage.

FISSION SONORE
Le découpage d’un MP3 requiert un logiciel
payant comme Fission de Rogue Amoeba (32$,
www.rogueamoeba.com/fission). Ouvrez le fichier
.mp3 en le glissant sur l’icône de Fission. Cliquez
sur Inspecteur. Dans l’onglet Tags , remplissez
les champs Titre (Title)et artiste (Artist). Cochez

la case Part of a compilation. Placez la tête de
lecture à l’endroit où débute un nouveau cha-
pitre , puis cliquez sur le bouton Split at
Playheaddans la barre d’outils. Recommencez
autant de fois que nécessaire et rendez-vous
directement à l’étape 4 du pas à pas proposé
en regard. nD.A. Mary
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Le chapitrage audio 
en question
� Accéder à n’importe quel endroit d’un enregistrement sonore 
est un des avantages des nouvelles technologies, mais tous les formats
de diffusion n’offrent pas le même confort d’usage. � 
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Découpage automatique d’un MP3

�Une fois le fichier ouvert dans Fission, demandez
Tools > Smart Split. Le découpage s’effectuera 

selon la fréquence des pauses et silences présents dans
l’enregistrement.

�Smart Split s’appuie sur deux paramètres : 
la longueur des pauses (réglette Length) et le niveau

sonore minimal (réglette Sensitivity). À titre d’exemple,
pour un document d’archives, j’ajuste Length à 0,2 
seconde et Sensitivity à -28 dB.

�Tout en procédant aux réglages depuis la fenêtre
Smart Split, continuez à surveiller la fenêtre 

principale. Celle-ci indique par un trait vertical vert le 
placement des futurs points de coupe. Les ajustements 
effectués, cliquez sur Split.

�Demandez Edit > Select All, puis Clip > Fade 
Around Removed Audio. Faites File > Save Audio. 

En haut du dialogue, donnez un nom à votre projet, puis
cliquez sur Save.

�Dans iTunes, créez une liste de lecture. Demandez
Présentation > Options de présentation. Cochez 

la case Date de l’ajout et cliquez sur OK. Retournez 
dans le Finder et sélectionnez tous les fichiers MP3 
qui composent votre document.

�Glissez les MP3 dans la fenêtre d’iTunes. Cliquez 
sur l’en-tête de colonne Date de l’ajout afin que le 

classement des fichiers s’opère par ordre chronologique
(la flèche doit être pointée vers le bas). Procédez 
à la synchronisation de la liste de lecture sur votre iPod.

	En revanche, si vous souhaitez graver un CD-audio,
appuyez sur le bouton Graver le disque en bas de

l’interface. Notez simplement que le nombre de pistes 
autorisé par CD est de 99, chacune d’elles devant avoir
une durée minimum de 4 secondes.

�Si vous retournez dans le Finder quelques instants,
vous constaterez qu’un nouveau dossier a été créé, 

dans lequel chaque chapitre du document original 
a donné naissance à un fichier audio MP3 indépendant 
et parfaitement numéroté.

�Ce dossier complet peut d’ores et déjà être trans-
féré pour écoute sur n’importe quel baladeur MP3. 

Les pistes vont s’enchaîner sans temps mort, comme 
s’il s’agissait d’un unique document. Pour toute autre utili-
sation, lancez l’application iTunes.

Pour chapitrer des archives sonores, inutile d’y passer des heures ! Tirez simplement parti 
de la fonction de découpage automatique de Fission.
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G
arageBand ’09 d’Apple
est un magnétophone
numérique polyvalent.
Il est généralement dé-
volu à des tâches musi-

cales, mais rien ne vous empêche
de l’utiliser comme un simple dic-
taphone. Couplé à iTunes, vous
pouvez même archiver automati-
quement vos mémos vocaux dans
une liste de lecture dédiée.

RÉGLAGES PRÉLIMINAIRES
Au lancement de GarageBand,
allez dans les Préférences, panneau
Audio/MIDI. Positionnez le menu
local Entrée audio sur Microphone
intégré: un message d’alerte surgit
alors. Cliquez sur le bouton Oui pour
forcer GarageBand à utiliser le mi-
crophone interne du Mac à chaque
lancement de l’application. Je rap-
pelle toutefois que si votre ordina -
teur ne possède pas de micropho -
ne, vous pouvez toujours acquérir

un modèle USB reconnu d’emblée
par le système Mac OS X (à l’instar
du MXL 006). Une fois celui-ci bran-
ché, vous choisirez son nom dans
le menu Entrée audio.
Dans le panneau Avancées, choi-
sissez Résolution audio > Bonne.
Veillez également à ce que soit co-
chée la case Exporter les projets à
plein volume. Ces deux réglages
ont pour effet de limiter la taille
des fichiers audio sur le disque dur
d’une part, et de maximiser le volu -
me sonore au moment de l’expor-
tation de vos mémos vocaux.
À présent, dans le panneau Mes
infos, tapez Mémos vocauxdans le
champ Liste de lecture iTunes .
À Nom de l’artiste, entrez votre
prénom ainsi que votre nom. Lais-
sez le champ Nom du compositeur
vierge. Enfin, vous pouvez utiliser
le champ Nom de l’albumà des fins
de classement pour définir, par
exemple, le type de projet relatif à

votre mémo (des recettes de cui-
sine, la préparation d’un entretien,
une réflexion sur la pratique de
l’image, etc.). Refermez la fenêtre
des préférences.

LA CRÉATION
D’UN NOUVEAU PROJET
Si un projet GarageBand était déjà
en cours, enregistrez tout d’abord
votre travail, puis refermez la fe-
nêtre (Fichier > Fermer).
Dans la fenêtre d’accueil de Garage -
Band ’09, cliquez sur Nouveau pro-
jetdans la colonne latérale. Choi-
sissez ensuite Voicecomme modèle
de projet. Appuyez sur le bouton
Sélectionner. Dans le dialogue, in-

titulez le nouveau projet comme
bon vous semble. Cliquez enfin sur
le bouton Créer.
Dans la colonne latérale gauche,
deux pistes sont déjà présentes.
Ne gardez que celle en rapport
avec votre voix (Male Basicpour
un homme, Female Basicpour une
femme). Pour supprimer la piste
inutile, sélectionnez-la et faites
Piste > Supprimer la piste.
Au bas de la colonne latérale droite
Infos de piste, bouton Instrument
réel, onglet Parcourir, cochez la
case Contrôle de niveau automati -
que . Demandez le menuCon -
trôle > Afficher le temps sur l’écran
LCD. Ainsi, le découpage temporel
ne s’effectuera plus sous la forme

de temps et mesures, mais en mi-
nutes et secondes. Comme l’inter-
face de GarageBand est d’une taille
importante, et ne peut être que
peu redimensionnée, je vous con -
seille de placer la fenêtre de l’ap-
plication en bas de l’écran. Vous
ne laisserez apparaître que la piste
d’enregistrement courante .
L’espace ainsi dégagé permet de
travailler sans difficulté avec plu-
sieurs autres logiciels.

ENREGISTREZ
VOS MÉMOS VOCAUX
Dès que vous souhaitez enregistrer
votre mémo, cliquez sur l’interface
de GarageBand. Appuyez sur la
touche [R] pour lancer l’enregis-
trement et frappez la barre d’es-
pace pour l’arrêter. La touche En-
trée permet de revenir au tout dé-

but de l’enregistrement. Avance
et retour rapides s’effectuent res-
pectivement par [Alt +Flèche droi -
te] et [Alt Flèche gauche]. Si vous
souhaitez réécouter (ou interrom-
pre) votre mémo, il vous faut frap-
per la barre d’espace.
Lorsque votre session de travail
est terminée, faites Partage > En-
voyer le morceau vers iTunes, puis
cliquez sur Exportation. Le mémo
vocal ira se classer automatique-
ment dans la liste de lecture idoine.
S’il vous arrive d’utiliser aussi l’ap-
plication Dictaphone de l’iPhone,
après synchronisation iTunes il est
à noter que les enregistrements
se rangeront dans la même liste
de lecture! nD.A. Mary
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Utilisez GarageBand comme 
un dictaphone
� Pour enregistrer et archiver vos mémos vocaux, pourquoi ne feriez-vous pas 
appel à votre ordinateur favori?�
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Un projet de dictaphone dans l’accueil

�Procédez aux différents réglages indiqués dans 
la page de gauche. Demandez ensuite Fichier > 

Enregistrer sous… dans le dossier /Bibliothèque/Application
Support/GarageBand/Templates/Projects/.

�Donnez un nom explicite à votre projet 
(« Dictaphone »), puis cliquez sur le bouton 

Enregistrer. Fermez le projet en cours depuis le menu
Fichier.

�Dans la fenêtre d’accueil, votre modèle de projet 
figure bien à la section Nouveau projet. Las, il n’a

pas d’icône personnalisée et son nom n’apparaît pas 
correctement. Pour y remédier, quittez GarageBand.

�Dans le Finder, ouvrez le dossier /Bibliothèque/Applica-
tion Support/GarageBand/Templates/Projects/. Pour que le

nom apparaisse correctement dans la fenêtre d’accueil, 
il est impératif d’ajouter un préfixe numérique suivi
d’une espace.

�L’icône que j’utilise dans mon exemple est 
à dénicher à cette adresse :

http://www.iconspedia.com/icon/microphone-13460.html. 
Cliquez sur le lien 128x128 px pour lancer le 
téléchargement.

�Ouvrez le fichier Microphone-128.png dans Aperçu.
Demandez Fichier > Enregistrer sous, format TIFF. 

Cochez la case Alpha, nommez le fichier « ProjectIcon » et
sauvegardez sur le Bureau.

	De retour au Finder, fenêtre Projects, faites un clic-
droit sur le document « 00.Dictaphone.band ». 

Demandez dans le menu local Afficher le contenu du 
paquet pour glisser dans le dossier Contents le fichier 
ProjectIcon précédemment créé. Le tour est joué !

�Le préfixe aidera le classement dans la fenêtre 
d’accueil. « 00. » placera le projet Dictaphone en

tête et « 10. » en dernière position. Laissez la fenêtre 
ouverte. Pour ajouter à présent l’icône personnalisée, 
plusieurs impératifs sont à respecter.

�Comme le montre la capture ci-dessus, l’image 
bitmap de l’icône doit être de 128 pixels de

côté, au format TIFF, et porter le nom « ProjectIcon ».
Pour trouver des icônes originales, rendez-vous sur 
le site InterfaceLift.com ou Iconspedia.com.

Plutôt que de recommencer les réglages de base pour chaque enregistrement, il est plus pratique 
de disposer d’un modèle prêt à l’emploi.
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L
e module ROC est un sé-
quenceur matriciel, dérivé
des appareils que l’on utilise
depuis la fin des années 1970.
Rien de neuf, en somme…

Mais l’aspect boîte à rythmes de type
Roland 808 et consorts donne un
petit côté sympa à une application
en ligne vraiment aboutie.

COMMENT ÇA MARCHE?
Le module ROC Music Creator lancé
depuis la page d’accueil Web d’Aviary
(www.aviary.com, gratuit), choisissez
dans la fenêtre d’accueil l’instrument
à programmer . L’application est
en anglais ; certains termes seront
facilement compréhensibles (guitar,
bass, piano, percussions), d’autres
moins comme Drums (batterie) ou
12 strings (guitare folk à 12 cordes
façon The Byrds pour les nostalgiques
des années 1960).
Quand vous cliquez sur le bouton
Open, l’interface du module s’affiche.
La colonne de gauche liste tous

les sons d’un même instrument. Pour
une batterie, toutes les percussions
qui la composent sont détaillées une
à une. Vous pouvez utiliser telle cym-
bale ou tel tambour (caisse claire,
grosse caisse ou toms).
Pour les instruments mélodiques,
chaque élément contient soit une
note seule, soit un accord (ensemble
de notes). De leur combinaison naîtra
une mélodie ou une partie d’accom-
pagnement.
À droite de chaque élément, la mo-
lette bicolore verte et grise sert
à changer le volume sonore d’un élé-
ment musical ou son placement dans
l’espace stéréo (comme la molette
Balance de votre chaîne stéréo). En
haut de l’écran, on trouve le bouton
de lecture, l’indicateur de mesure
et de tempo, et le bouton de volume
général. Enfin, la colonne latérale
droite liste les banques de sons
(dénommées Instruments)ainsi que
les échantillons qu’ils contiennent
(Sounds). Vous pouvez changer l’en-

semble des éléments musicaux à vo-
tre disposition en une seule fois, ou
bien les remplacer individuellement.

CLIQUEZ, C’EST PROGRAMMÉ!
C’est au centre de l’écran que vous
programmez votre musique. Chaque
ligne verticale symbolise 1 temps
(chaque fois que vous tapez du pied
en écoutant votre morceau favori,
cela équivaut à 1 temps ou à une
pulsation). Ici, chaque temps se dé-
compose en 4 sous-parties matéria-
lisées par 4 points. Pour produire un
son qui tombera sur le temps, il suffit
d’illuminer le premier des quatre.

Si la création musicale n’est pas votre
loisir favori, mais que vous souhaitez
obtenir un résultat tout de suite pour
votre podcast, cliquez sur le bouton
Randomize All Beats jusqu’au mo-
ment où le résultat vous satisfait!

QUE PEUT-ON FAIRE AVEC?
ROC Music Creator est dévolu à la
composition de musiques pop/rock,
voire électroniques, sous un jour un
peu différent de GarageBand, Cubase
ou Digital Performer. Ici, vous ne tra-
vaillez jamais sur l’ensemble du mor-
ceau, mais plutôt instrument par ins -
trument. Une fois les boucles consti-
tuées, vous les assemblez au sein de
votre projet final.
Comme le but de cet article n’est
pas de vous transformer en un mu-
sicien rompu à toutes les techniques
de composition assistée par ordina-
teur, je vais vous montrer plutôt
comment transformer une chanson
de votre bibliothèque iTunes en une
version dance remix pour vos soirées
disco. J’utilise ici le titre Pokerface
de Lady Gaga, mais n’importe quelle
autre chanson fera l’affaire.
Une petite astuce pour finir : pour
obtenir instantanément une copie
d’une chanson iTunes sur le Bureau,
sélectionnez-la dans le logiciel, puis
glissez son intitulé vers l’extérieur
de l’interface.
nDavid A. Mary
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Aviary Music Creator:
en avant la musique!

1

� En plus de ses outils de création graphique,
Aviary propose un éditeur audio proche de 
GarageBand, ainsi qu’un tout nouveau module
de composition musicale dénommé ROC. �
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Remixez Lady Gaga en un clin d’œil!

�Pour les instruments 06-TechnoKit-03 et 06-Techno-
Kit-04, placez un point lumineux après la première

barre verticale. Sautez sept points, puis illuminez le suivant, et
ainsi de suite. La cellule rythmique de base étant créée, il est
temps de sauvegarder (Save As).

�En bas d’écran, réglez le tempo sur 119 en double 
cliquant dessus. Dans la colonne latérale droite, glissez

le morceau à remixer (Pokerface) dans la piste Track 1. Pour
avoir accès à la boucle Batterie 1, cliquez sur Roc Beats.

�Glissez la boucle Batterie 1 sur la piste Track 2 autant
de fois que nécessaire de manière à accompagner le

morceau jusqu’à la fin. Pour bien entendre l’effet Dance
produit, n’hésitez pas à diminuer le volume sonore de la piste
Track 1.

	Pour donner plus d’épaisseur à la boucle de la piste
Track 2, faites un clic-droit sur l’une d’elles, puis 

demandez Effects. Dans la colonne de droite, sélectionnez les
effets StereoDelay et Sweep Peak. Reproduisez ensuite les
réglages de la capture d’écran ci-dessus.

�Dans le champ Creation title, intitulez la boucle Batterie
1, puis cliquez sur le bouton Save as new creation. Ceci

fait, cliquez sur Continue working on your creation. Vous 
pouvez alors créer des variantes de la boucle de départ.

�Retournez sur la page principale d’Aviary, puis lancez
cette fois Audio Editor. Importez la chanson à remixer

(File > Import Audio). Cliquez sur Browse et sélectionnez le
fichier audio sur votre disque dur. Cliquez sur Next par deux
fois, puis sur Upload.

Ajouter une batterie électronique par-dessus un morceau existant constitue une technique simple pour
obtenir un son dance !
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�Pour retrouver le tempo de la chanson de Lady Gaga,
rendez-vous à la page Web bpm4djs.com, puis entrez

le nom de l’artiste ou le titre de la chanson dans le champ 
situé en haut à droite. Notez soigneusement la valeur du BPM
récupérée.

�Connectez-vous à votre compte Aviary. Lancez le 
module Music Creator. Dans le coin supérieur gauche,

cliquez sur l’indicateur de tempo puis, tout en maintenant 
le clic sur le bouton gauche de la souris, déplacez cette 
dernière vers le bas jusqu’à obtenir la valeur 119.

�Passons à la programmation de la batterie électro-
nique. Dans le séquenceur, en face de l’instrument 06-

TechnoKit-01 (en bas d’écran), placez un point lumineux tous
les 4 points comme dans la capture ci-dessus. Appuyez sur le
bouton de lecture pour entendre le résultat.
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L
’interface de Djay se divise
en trois zones distinctes.
Tout d’abord, deux plati -
nes vinyles dotées des
mêmes fonctions: volume

général, égalisation, lecture/arrêt
de la platine… La colonne latérale

présente le contenu de votre
bibliothèque iTunes. Enfin, en bas,
un ensemble d’outils que l’on active
à l’aide d’une série de boutons
vous autorise à lire en boucle un
fragment de chanson (d’une lon-
gueur maximale de 8 mesures à 4
temps), placer des points de repère
pour revenir instantanément à un
endroit précis de la chanson (Cue
Points), effectuer des transitions
de type fondu enchaîné automa-
tique (Transition), ou encore na-
viguer d’un endroit à un autre sans
aucune rupture de rythme (fonc-
tion Skipping). La section Effets
(bouton FX) propose les tradition-
nelles chambres d’écho (assigna-
bles au tempo) et de réverbération
(de quatre tailles distinctes: room,
club, hall, arena). La fonction Pitch
s’apparente davantage à une fonc-
tion de doublage sonore qu’à un
unique changement de hauteur
de la piste audio. On pourra l’utiliser
pour créer des chœurs sur le refrain
des chansons. Attention, tout de
même: l’effet (d’une amplitude

maximale d’une octave) est quel -
que peu caricatural et donne aux
chanteurs la voix de Mickey Mouse.
Un artifice sonore que l’on entend
sur les titres électro-pop ou rap de
ces dernières années – et notam-
ment sur le dernier album des Black
Eyed Peas.

NOMBREUSES POSSIBILITÉS
Djay (www.djay-software.com) pro-
pose tout un arsenal pour réaliser
un mix de soirée original. Vous
pourrez aussi pratiquer le Beat jug-
gling qui consiste à créer une com-
position originale à partir de frag-
ments issus de différentes chan-

sons, et même d’échan-
tillons GarageBand,
pour peu que vous les
ayez référencés dans
la bibliothèque iTunes.
Bien sûr, les effets liés
à la platine (scratch,
backspinet autres) peu-
vent être restitués à
l’aide de la souris ou
d’un trackpad, mais

aussi directement depuis une in-
terface matérielle USB reprodui-
sant à l’identique l’instrument de
base du disc jockey. C’est le cas du
Spin de Vertax, pour le moment
commercialisé aux États-Unis et
au Canada sur l’Apple Store; on la
trouve en France chez CentralSono
ou Musicmove-store.

RÉALISEZ UN MIX
EN UN CLIN D’ŒIL
Sans y connaître grand-chose dans
les techniques de djaying, vous
pouvez tirer parti sans effort du
potentiel de l’application. Dans le
cadre en haut à droite de l’interface,
choisissez Musiqueou une liste de
lecture iTunes. Dans la barre laté-
rale, cliquez sur Automix. Votre mix
de soirée est prêt enun clin d’œil,
transitions audio comprises! Pour
interrompre un titre en cours
d’écoute et passer à la chanson
suivante, appuyez sur le troisième
bouton en bas d’interface (Tran-
sition), puis cliquez sur la flèche
correspondant à la platine dont

vous souhaitez enten-
dre la musique. Vous
pouvez imposer un
mode de transition
(écho, backspin, stan-
dard) ou bien laisser le
logiciel choisir (ran-
dom), et bien sûr spé-
cifier sa durée (en se-
condes).

LES RÉGLAGES DE BASE
Pour exploiter au mieux Djay 3,
quelques conseils… Si l’application
est capable d’exploiter les mu-
siques anciennement achetées
sur iTunes (avec DRM) pour une
animation «live», vous ne pourrez
en aucun cas enregistrer vos per-
formances avec. Ensuite, à chaque
changement de titre sur les pla-
tines, tous les paramètres d’éga-
lisation et de gain se réinitialisent
automatiquement. Pour éviter
cela, décochez la case Réinitialiser
les réglages d’effets dans les
préférences Généralesde l’appli-
cation. Enfin, comme avec tout lo-
giciel de djaying qui se respecte,
vous pouvez séparer l’écou te prin-
cipale (destinée au dance floor)
de l’écoute secondaire pour «caler»
le son de la seconde platine à l’aide
d’un casque. Vous devrez être tou-
tefois équipé d’un boîtier audio
externe, même premier prix. Les
options de sortie audio se règlent
dans les préférences, panneau Pé-
riphériques. nDavid A. Mary
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Avec Djay, devenez un «pro» 
des platines
� Si la platine de DJ vous apparaît comme un objet ésotérique, Djay 3 va 
vous faire changer d’avis! L’application s’adapte à tous les usages, 
que vous soyez un virtuose de la platine ou simple novice. �
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Le MixTape à la portée de tous

�Avant d’entamer la réalisation de la compilation, 
histoire d’associer le bon tempo à chaque morceau

de votre bibliothèque iTunes, demandez Bibliothèque >
Analyser la bibliothèque, puis cliquez sur Début.

�Si vous disposez d’un boîtier audio externe, 
branchez-le à votre Mac. Cliquez sur le bouton 

de pré-écoute en bas de colonne latérale et cochez 
la case Auto-select. Ajustez le retour casque si besoin.

�Affichez la fenêtre Automix. Pour un meilleur 
enchaînement des titres, sélectionnez-les en 

fonction de leur tempo respectif (nombre de Battements 
par minute), puis glissez-les dans la fenêtre Automix.

�Pour chacune des deux platines, réglez la section
d’égalisation comme il vous plaît. Pour un rendu 

typé FM, augmentez les basses fréquences (Low) 
à un maximum de +4 dB et les aigus (High) à +1,78 dB.

�Lancez l’enregistrement en appuyant sur le bouton
rouge REC situé en haut de l’interface. Pendant 

la diffusion du premier titre, pensez à caler le départ 
de la seconde platine à l’aide du casque.

�Pour produire un effet de scratch à partir 
de la platine vinyle opposée, placez votre curseur 

sur cette dernière puis, tout en maintenant la touche [Maj]
enfoncée, bougez la souris en rythme.

	Pour créer des chœurs à un moment précis de la
chanson, dans la section FX, activez le bouton

Pitch. Choisissez la valeur d’une octave (12) ou d’une
quinte (7), puis faites glisser la réglette par intermittence,
de gauche à droite, pour accentuer l’effet.

�Dans la section FX, réglez la réverbération sur Hall,
puis cliquez sur son intitulé pour l’activer. À l’aide 

de la réglette Style, dosez la puissance de l’effet. N’allez
pas au-delà du dixième de sa course.

�Appuyez sur le bouton Automix pour lancer les
deux premiers titres de votre compilation. Pour 

effectuer du scratch avec la platine en cours d’écoute,
désactivez momentanément l’Automix le temps de 
réaliser l’effet.

Comment compiler vos morceaux favoris pour une écoute en balade, c’est ce que je vous propose 
de découvrir… avec effets sonores et doublage chœurs, s’il vous plaît !
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E
n partant du postulat
qu’une majorité de ly-
céens possèdent un ba-
ladeur numérique ainsi
qu’un accès à un ordina-

teur personnel, il est tentant pour
un professeur de proposer des
exercices de langues vivantes par
ce biais. Le document multimédia
final se présentera sous la forme
d’un fichier MP3 ou MP4 lisible sur
Mac et PC, distribuable par le biais
d’un site Internet ou d’une plate-
forme de partage.

QUEL MICROPHONE
POUR L’ENREGISTREMENT?
Procéder à l’enregistrement du
document pédagogique peut pa-
raître un brin compliqué de prime
abord, mais la résolution du pro-
blème est relativement simple. La
prise de son d’un texte littéraire
destiné à une écoute au casque
par vos étudiants ne demande pas
le même investissement technique
et financier que pour un projet ar-
tistique. Plusieurs possibilités s’of-
frent à vous pour un budget infé-
rieur à 100€. Notez que l’on peut

même atteindre la gratuité totale
si vous recourez au microphone
interne de votre Mac. Dans ce der-
nier cas uniquement, commencez
par vous rendre dans les Préféren--

ces-système->-Son, cliquez sur En-
trée , puis veillez à ce que le pé-
riphérique Microphone-internesoit
sélectionné .
Alternativement, vous pouvez em-
ployer le kit Bluetooth de votre té-
léphone mobile. Pour ce faire, met-
tez tout d’abord l’oreillette en
mode Association puis, dans le Fin-
der, activez le Bluetooth à l’aide
de l’icône de la barre des menus.
Pour configurer l’appareil, suivez
simplement les instructions don-
nées à l’écran. Le couplage désor-
mais actif, choisissez comme péri -
phérique audio votre casque Blue-
tooth dans les Préférences-sys-
tème->-Son->-Entrée.
Si vous possédez un Mac récent
doté d’une prise jack «combo»
(lire Ports et prises, la connectique
des Mac expliquésdans VVMac
n°53), le kit filaire livré avec votre
iPhone peut être utilisé comme
accessoire de prise de son. Une
fois le casque branché sur la prise
de sortie audio, rendez-vous
dans les Préférences-système->
Son->-Entrée.Choisissez ensuite
l’option Microphone-externe
dans la liste des périphériques.
Plus cher, mais d’une qualité su-

périeure, vous
pouvez envisager
l’acquisition d’un micro -
phone USB. Je n’irai pas par quatre
chemins: la plupart des modèles

commercialisés au-dessous de
170€sont relativement médiocres,
à tel point qu’il vaut mieux recourir
à un microphone «standard» d’en-
trée de gamme couplé à un boîtier
audio externe ou à un préamplifi-
cateur USB (le très peu coûteux
MXL Mic Mate, par exemple).
Ceci étant dit, chaque règle a son
exception. Et dans le cadre d’un
laboratoire de langues, ou même
d’un podcast, le microphone MXL
USB.006 (99€) constitue plutôt
une bonne surprise, d’autant qu’il
est livré avec ses accessoires (pied
de table inclus) et qu’il ne nécessite
pas de pilote, Mac OS X le recon-
naissant de façon native.

Une fois connecté à
votre Mac, rendez-vous

dans les Préférences-sys-
tème->-Son->-Entrée, puis
choisissez sans plus tarder

le-microphone-USB-dans la
liste des périphériques.

MÉTHODE DE TRAVAIL
Imprimez le texte à enregistrer,
scannez les photos et brochures
qui seront jointes à votre enregis-
trement. Lancez GarageBand ’09
puis, dans le menu d’accueil, cliquez
sur Nouveau-projetdans la barre
latérale gauche. Ensuite, sélection-
nez Podcast- . Dans le dialogue,

donnez un titre à votre projet, puis
cliquez sur le bouton Créer. Dans
les préférences de GarageBand,
panneau Audio/MIDI, veillez à ce
que la Sortie-audioet l’Entrée-audio
affichent Réglage-du-système.
Dans le panneau Avancé,  choisissez
l’option Bonne en guise de réso-
lution audio. La prise de son s’ef-
fectuera à un taux d’échantillon-
nage de 44,1 kHz sur une profon-
deur de 16 bits – ce qui est suffisant
dans le contexte d’un atelier de
langues. Refermez maintenant la
fenêtre. Nous pouvons passer à
présent à l’enregistrement des
exercices, à lire en page ci-contre.
nDavid A. Mary
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Avec GarageBand, montez votre 
labo de langue
� L’enseignement et l’apprentissage des langues à l’aide d’un 
support multimédia mêlant son, images et liens hypertextes, c’est
ce que je vous propose de réaliser ce mois-ci. �
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L’élaboration du document multimédia

�Avant d’effectuer la prise de son, demandez Piste >
Afficher les infos de piste. Sélectionnez la piste

Male Voice ou Female Voice selon votre timbre de voix.
La piste est automatiquement prête pour l’enregistrement.

�En bas de la colonne latérale droite, sélectionnez 
votre microphone dans le menu local Source 

d’entrée. CochezContrôle de niveau automatique. Dés-
activez le retour son pour éviter tout effet Larsen.

�Pour lancer l’enregistrement ou le stopper, cliquez
sur le bouton idoine en bas de l’interface ou 

frappez la touche [R] du clavier. Pour aller d’un point à un
autre de l’enregistrement, déplacez la tête de lecture.

�Pour effectuer toutes modifications de la piste son
(effacement, découpage au point de lecture, fusion

des régions audio), recourez aux fonctions contenues dans
le menu Édition.

�Pour insérer une URL cliquable, tapez l’adresse 
complète dans le champ. Si vous souhaitez rempla-

cer à l’écran le lien hypertexte par un texte de votre choix,
utilisez le champ Titre d’URL. Prévisualisez le résultat en
cliquant sur le cadre de la piste de podcast.

�Exportez à présent la version complète 
destinée aux iPod, iPhone et ordinateurs Mac/PC

par le biais du menu Partage > Exporter le podcast 
vers le disque. Cliquez successivement sur les boutons
Exportation, puis Enregistrer.

	Pour une version audio seule, compatible avec n’im-
porte quel baladeur numérique, demandez Partage

> Exporter le podcast vers le disque, avec choix de l’en-
codeur MP3. Enfin, cliquez successivement sur les boutons
Exportation, puis Enregistrer.

�La mise en forme de la piste audio achevée, 
sélectionnez la piste de podcast. Pour intégrer 

des images ou des liens hypertextes, positionnez la tête
de lecture à l’endroit voulu, puis cliquez sur le bouton
Ajouter un marqueur.

�Demandez Piste > Masquer les infos de piste.
En bas de l’interface, glissez l’image 

d’illustration dans le cadre réservé. Ajoutez un titre 
pour chaque marqueur.

Que ce soit pour une diffusion sur baladeur ou sur ordinateur, GarageBand est capable de décliner 
un support pédagogique s’adaptant à toutes les demandes.

         Vous et Votre Mac • Hors-série n°3 • Février 2011
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Retrouvez facilement 
un article dans 
votre collection de
Vous et Votre Mac !

� Tous les numéros accessibles sur votre Mac
� La recherche multi-documents avec Adobe Reader ou Aperçu Snow Leopard
� Tous les liens Internet actifs
� Le copier-coller et l’impression d’un article en haute définition

Nouveaux 

CD et DVD

Tous les numéros

disponibles

jusqu’au 60!

BULLETIN DE COMMANDE - À remplir LE PLUS LISIBLEMENT POSSIBLE et à retourner à l’adresse suivante :

Howtodo Publishing -Vous et Votre Mac - 282, rue des Pyrénées - 75020 Paris

r M. r Mme
r Mlle

Prénom :

Nom :

Adresse :

C.P. :                       Ville :

E-mail :

E-mail obligatoire pour recevoir une confirmation 
d’abonnement et, si nécessaire, une facture.* Conformément à l’article 27 de la loi Informatique et Libertés du 6 janvier 1978, vous disposez d’un

droit d’accès et de rectification aux informations vous concernant. Les informations ci-dessus, 
étant traitées informatiquement, sont indispensables à la gestion de votre demande d’abonnement. 
Vous pouvez vous opposer à leur cession ultérieure en nous le précisant par écrit.

Je règle aujourd’hui par Chèque bancaire ou postal
à l’ordre de Howtodo Publishing.
(uniquement les chèques euros sur une banque française)

r Je suis déjà abonné, ou je joins mon bulletin d’abonnement.

VVMac en PDF sur CD-Rom

(les prix incluent les frais de port pour la
France et l’étranger)

Tarif 
normal

Tarif abonnés ou 
nouvel abonnement

DVD VVMac N° 1 à 54 r 38 € r 15 €
CD VVMac N° 55 à 60 Nouveau ! r 20 € r 7,50 €
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